
Federal Democratic Republic of Ethiopia Ministry of Education

INFORMATION
   TECHNOLOGY

STUDENT’S TEXTBOOK

Grade 9

Federal Democratic Republic of Ethiopia Ministry of Education



Take Good Care of This Textbook

 

 

 

 

 

 

 

 

 

 

 

This textbook is the property of your school. Take good care not to 
it. Here are 10 ideas to help take care of the book:

1. Cover the book with protective materials, such as plastic ,old newspapers or 
magazines.

2. Always keep the book in a clean dry place.

3. Be sure your hands are clean when you use the book.

4. Do not write on the cover or inside pages. 

5. Use a piece of paper or cardboard as a bookmark.

6. Never tear or cut out any pictures or pages.

7. Repair any torn pages with paste or tape.

8. Pack the book carefully when you place it in your school bag.

9. Handle the book with care when passing it to another person.

10.  When using a new book for the first time, lay it on its back. Open only a few 
pages at a time. Press lightly along the bound edge as you turn the pages. 
This will keep the cover in good condition.

 damage or lose





   

FEDERAL DEMOCRATIC REPUBLIC OF ETHIOPIA

MINISTRY OF EDUCATION

INFORMATION 

TECHNOLOGY

Grade 9 

Writers

Content Editor
Instructional Design Editor

Language Editor
Illustrator

Book Designer

  Tesfaye Bayu (PhD)
  Werkneh Eshete (MSc)
  Wogene Alemayehu (MSc)
  Jerusalem Yibeltal (PhD)
  Tagesse Daniel (PhD)
  Kibrebeal Getinet (MSc)
  Efrem Yohannes (PhD)

Student’s Textbook

HAWASSA UNIVERSITY



First Published 202  by the Federal Democratic Republic of Ethiopia,  
of Education, under the General Education Quality Improvement 
for Equity (GEQIP-E) supported by the World Bank, UK’s Department  

International Development/DFID-now  merged with the Foreign, Common 
wealth and Development Office/FCDO, Finland Ministry for Foreign Affairs, 
the Royal Norwegian Embassy, United Nations Children’s Fund/UNICEF), the 
Global Partnership for Education (GPE), and Danish Ministry of Foreign Affairs, 
through a Multi Donor Trust Fund.   

© 202  by the Federal Democratic Republic of Ethiopia, Ministry of Education. 
All rights reserved. The moral rights of the author have been asserted. No part 
of this textbook reproduced, copied in a retrieval system or transmitted in any 
form or by any means including electronic, mechanical, magnetic, photocopying, 
recording or otherwise, without the prior written permission of the Ministry of 
Education or licensing in accordance with the Federal Democratic Republic of 
Ethiopia as expressed in the Federal Negarit Gazeta, Proclamation No. 410/2004 - 
Copyright and Neighboring Rights Protection.

The Ministry of Education wishes to thank the many individuals, groups and 
other bodies involved – directly or indirectly – in publishing this Textbook. 
Special thanks are due to Hawassa University for their huge contribution in the 
development of this textbook in collaboration with Addis Ababa University, 
Bahir Dar University and Jimma University.

Copyrighted materials used by permission of their owners. If you are the owner 
of copyrighted material not cited or improperly cited, please contact the Ministry 
of Education, Head Office, Arat Kilo, (P.O.Box 1367), Addis Ababa Ethiopia. 

Printed by:

 

GRAVITY GROUP IND LLC 
 

ISBN: 978-99990-0-040-6 

P.O.Box 13TH Industr ial Area, Shar j ah
UNITED ARAB EMIRATES
Under Ministry of Education 

j

3

3
Ministry

for
Program 

August

 Contract no. MOE/GEQIP-E/LICB/G-01/23



   i

Table of Contents

UNIT 1 : ORGANIZATION OF FILES
1.1 Basics of Files and Folders  1

1.2 Managing Files and Folders 5

1.3 Computer Drives 25

1.4 Unit Summary 29

1.5 Unit Review Exercise 31

UNIT 2 : COMPUTER NETWORK
2.1 Definition of Network 37

2.2 Fundamental Elements of Network 38

2.3 Types of Networks  46

2.4 Advantages and Disadvantages of Network  60

2.5 Unit Summary 63

2.6 Unit Review Exercise 66

UNIT 3 : APPLICATION SOFTWARE
3.1 Using Application Software  72

3.2 Word Processing  72

3.3 Manipulating Data in Spreadsheet  109

3.4 Creating Presentation  121

3.5 Unit Summary  136

3.6 Unit Review Exercise 138

UNIT 4 : IMAGE PROCESSING AND MULTIMEDIA
4.1 Image 145

4.2 Multimedia Production Planning Strategies 147

4.3 Using Image Processing Software 148

4.4 Unit Summary 186

4.5 Unit Review Exercise 187



UNIT 5 : INFORMATION AND COMPUTER SECURITY
5.1 Definition of Security 192

5.2 Principles of Computer Security 194

5.3 Computer Security Threats  197

5.4 Potential Losses Due to Security Attacks 204

5.5 How to Secure yourself and your Computer Systems 206

5.6 Unit Summary  209

5.7 Unit Review Exercise 211

UNIT 6 : FUNDAMENTALS OF PROGRAMMING
6.1 Defining a Problem and Computational Problem   217

6.2 Steps in Problem Solving  219

6.3 Working with Flowcharts and Block Programming 223

6.4 Problem Solving Approaches  236

6.5 Unit Summary  239

6.6 Unit Review Exercise 240

 ii



Grade 9 Information Technology Student’s Textbook 

   1

UNIT OVERVIEW 

This unit introduces you to files and file organization in computer systems. A 
computer file can be both system generated and created or transferred from 
other sources in to a computer. You will learn how to manipulate files (creating, 
copying, renaming, deleting and searching).

A file folder is a mechanism to keep your computer files in an organized 
manner. This unit will deal with folder manipulation mechanisms that operating 
systems provide. 

1.1 Basics of Files and Folders 

At the end of this unit, learners will be able to:

 � Explain file, folder and drive.

 � Manipulate file and folder.

 � Explore drive on computer system.

UNIT 

ORGANIZATION OF FILES

UNIT OUTCOMES

1 

 
 Brainstorming 

1.  Have you ever visited your family’s “edir” or “ekub” association’s 
membership information? Do they use paper to keep membership 
information? 

2. What do you think are the limitations of using the above manual filing 
system (shelf or filing cabinet-based filing system)? Do you think computers 
are used to store such information?
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1.1.1 Files

A file is a collection of data stored in one unit, identified by a filename. It can be 
a Word, Spreadsheet, PowerPoint Presentation document that you had learnt in 
Grade 8. Files are represented by an icon in a computer. Thus, icons are small 
graphical representation of a file. Because there are different file formats, icons 
are usually used to help identify the type of file or program associated with. In 
Figure 1.1 below, you can see different types of files on the desktop.

Figure 1.1 Common File Icons in Window 10

KEY CONCEPTS

 � A file stores a data which can be a document, a picture, text, video, audio, 
etc.

 � A file has different icons in a computer.  

1.1.2 Folders

A folder, also called a directory, is a container which is used to store related files 
together. A folder can also contain another folder inside. A folder contained in 
another folder is called a subfolder. A good analogy is the manila folders (dossier) 
seen in an office to store papers or reports. 
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The difference between a file and a folder is that a file is a collection or group 
of interrelated data and information whereas a folder is a container used to store 
different files and subfolders. We can have different types of Files such as text, 
video, document and image and each has different extensions to identify their 
types but folders do not have extensions.

Figure 1.2 Manila and computer folders

Activity 1.1

This activity is designed to help you discuss the importance and advantages of 
computer folders. Form a group of two to five students in a class and discuss the 
following questions. 

1. Present the way you put things in your home such as your cloths, exercise 
books and text books. Compare and contrast a messy home and a tidy 
home. Which one is easy to locate things?  

2. In analogous to this, compare and contrast cluttered files shown in Figure 
1.3 (a) and organized files in folder shown in Figure 1.3 (b).  

3. How do you organize different files such as document, image, video and 
audio files in your desktop computer?  
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Figure 1.3 (a) Cluttered file                      (b) Organized file by folders

Importance of Folders

Folders help to keep related files organized together as shown in Figure 1.3 b 
above. This helps to locate files easily. If you had no folders on your computer, 
your documents, programs and operating system files would all be located in 
the same place. Folders allow you to have more than one file with the same 
file name. For instance, you can have a file called My-letter.doc in your My 
Documents folder and another file called My-letter.doc in a different folder 
called ’Letter collection’. If all your files were in a single place, every file would 
need a unique file name.
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KEY CONCEPTS

 �  A folder, which is also called a directory, is a container of files. 

 � A folder helps us to organize related files together. 

1.2 Managing Files and Folders

In Windows operating system, the primary way of interacting with files and 
folders is through the File Explorer application. There are also other operating 
systems, but in this textbook we use Windows operating system. 

1.2.1 Using File Explorer

A file explorer (which was called Window explorer in applications before Window 
10 version) has the following main parts (See Figure 1.4 and Table 1.1).

Figure 1.4 File Explorer window

 
 Brainstorming 

1.  How are documents created, named/renamed, copied, moved and deleted 
in paper-based file systems?

2. How is a folder/dossier created, named/renamed, copied, moved and 
deleted in manual filing system? Do you think there is a way to do such 
things in computers’ files and folders? 
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Table 1.1 File Explorer Parts and Their Descriptions
Element 

Numbers
File Explorer 

Elements Description and Usage

      1 Navigation 
pane

Navigation pane allows you to view and access your 
computer’s file and folder structure. On Navigation 
pane, there is a Quick Access area. It allows you to 
navigate quickly and easily to the folders that you 
use regularly or frequently. 

To add or pin a folder to the Quick access area, right-
click on the folder name and then select Pin to Quick 
access from the drop-down menu.

      2 Forward and 
Back buttons

Enables you to go to folders you have previously 
opened. If you go to a different folder, you can 
choose the Back button to return to the last folder 
you accessed.

      3 Ribbon Enables you to perform layout, formatting and 
sharing tasks. It also enables you to change your 
files’ and folders’ displays. Tasks available to you 
might differ depending on what folder you select 
(e.g. Documents versus Pictures).

To display the Ribbon, click on one of the menu 
items at the top of File Explorer or click on Expand 
the Ribbon button (down-pointing arrow) located at 
the top right-hand side of File Explorer.

      4 Address bar Enables you to go to a different folder in the 
same Explorer window. (For more information, 
see Navigating the Address Bar in section 1.2.6.)

      5 Column 
headings

Titles of each of the columns displayed in the 
file and folder list.   You can choose which 
columns you want to display by adding a column 
heading or removing a column heading, as well 
as changing the order in which those columns are 
displayed. Click on a column heading to sort your 
files and folders by that column (e.g. date modified).
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      6 Search box Allows you to search for subfolders, documents, 
images, programs, web pages and bookmarks in the 
current folder.

      7 File and fold-
er listing

Shows you the files and folders in the current folder 
(the folder you selected in the Navigation pane).

      8 Preview/De-
tails pane

Enables you to quickly preview an item, such as a 
photo, without having to open that item. 

To open the Preview pane (which is not open by 
default), click on the View menu at the top of File 
Explorer, then click on the Preview pane button 
located at the left-hand side of the Ribbon in 
the Navigation pane area.

      9 Status bar Displays information about a selected folder and 
its contents such as the total number of items in the 
folder, the number of items selected and the total 
file size. 

Contains buttons that enable you to quickly switch 
between thumbnail and detail views for the items 
displayed in the current folder.

Opening File Explorer 

To open File Explorer, click on the File Explorer icon located in the taskbar.

Figure 1.5 Opening File Explorer from task bar

Alternatively, you can open File Explorer by clicking on the Start button and then 
clicking on File Explorer.
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Figure 1.6 Opening File Explorer from Start menu

You can use Win key (  ) + E keyboard shortcut to open file explorer. 

1.2.2 Creating New File 

A file is created using a computer software program. For example, to create a 
plain text file you can use a text editor such as Notepad or Notepad++. You can 
use word processing software such as WordPad, Microsoft Word and LibreOffice 
Writer to create a text document file. An image file can be created using image 
editing software such as Microsoft Paint, Paint 3D, Gimp and Adobe Photoshop.

Practical Exercise 1.1

Creating a document file

1. Work in a group to create a document file entitled Ethiopian Cultural Foods 
using Word processing software.

Try to remember how to create documents using Microsoft (MS) word or 
any other word processing application software from your previous grade 
(Grade 8). 

2. Open Word processing software on your computer. 
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Figure 1.7 Newly created document

3. Type the passage

To insert text in your document, place the cursor at the position where you want 
to enter the text and start typing a paragraph about the Ethiopian cultural foods 
by exploring different sources. You can see Figure 1.8 as an example document. 

Figure 1.8 Article on Ethiopian Cultural Food  
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4. Saving the document 

Save allows you to update a previously saved file with new content, 
whereas Save As allows you to save a new file or an existing file to a 
new location with the same or different name.

How to create a text file

The easiest way to create a text file in Windows is to open up the Notepad 
application software program on your computer. The Notepad is a text editor 
included with Microsoft Windows.

A text file is considered as a plaintext file and Notepad is capable of 
creating and editing plaintext files. Notepad saves any text file with 
.txt file extension, which means no special formatting or fonts.

The Windows Notepad program can be opened using the methods below.

1. Click Start.

2.  In the Run or Search box, type Notepad and press Enter.

Viewing, editing, and creating images

There are many software programs you can use to display, view, edit and create 
images, logos or arts on your computer. Microsoft Paint is a default image editing 
application software in window Operating system. We can use it to simply edit 
our image file.

Practical Exercise 1.2

Using Microsoft Paint to create an image 
Create an image using Paint application following the steps below.

 � Click on Start  Open Paint Application  Create your own image  
Save your image
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Creating presentation file

Presentation files are created for electronic presentations consisting of a series of 
separate pages or slides. To create presentation files, there are different application 
software such as Microsoft PowerPoint and LibreOffice. 

Practical Exercise 1.3

Preparing a presentation file for a project 
Work in a group to create presentation file using Microsoft PowerPoint (say 
Ethiopian Wild Life) using your previous grade (grade 8) knowledge of using 
Microsoft PowerPoint. Use the following steps to open it.

1. Open Microsoft PowerPoint application.

2. In the left pane, select New.

3. Select a New Blank Presentation.

4. Start adding contents in the slide about Ethiopian wild Life. 

1.2.3 Creating a New Folder

Creating a new folder can help you store related files in an organized manner. 
The following steps can be followed to create a new folder. 

1. Navigate to the location where new folders are created.

2.  In File Explorer, click on the Home menu item.

3.  From the Home tab, click on the New folder button (See Figure 1.9).

Figure 1.9 New folder button on file explorer

4. Enter the name of your new folder.

5. After you enter the folder name, click anywhere outside the text area to com-
plete creation of the folder name.
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1.2.4 Copying a File

Copying a file is used to put the file in a duplicated manner. To copy computer 
documents, pictures or other files from one place to another, follow the following 
instructions.
The following steps show how to copy a file or multiple files in Microsoft Windows 
from one folder to another.

1. Go to the files or folders you want to copy. 

2. Highlight the file or files you want to copy by clicking them once with the 
mouse. If you need to highlight more than one file, you can hold down the 
Ctrl or Shift keys on your keyboard or drag a box around the files you want 
to copy.

3.  Once highlighted, right-click one of the highlighted files and select copy. 
You may also press the Ctrl + C shortcut key or in File Explorer, click Home 
at the top of the window and click Copy.

4.  Open the destination folder, right-click an empty space in the folder, and 
choose paste. Alternatively, in the File Explorer menu bar at the top, click 
Home and then click Paste. (See Figure 1.10).

Figure 1.10 Copying a file using right click option
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When copying files, you are going to get more than one copy of the 
file on your computer. If you want only one copy of the files, move 
them instead. A file name must be unique; otherwise, a number will 
be appended to the end of a file name. It may also have “- Copy” 
appended to the end of the file name, instead of a number. Appending 
a number to the end of the copied file’s name assures the copied file is 
unique. For example, if the original file name is StudentMarkList.pdf 
and a copy is created in the same directory or folder, the copied file 
name could be StudentMarkList (1).pdf or StudentMarkList - Copy.
pdf.

1.2.5 Renaming File and Folder

You must have right or permissions to a file, a folder or a directory to 
rename it. In some cases, you may need administrator privileges in 
the operating system to rename.

In Window, to rename files such as text, photo, document, audio and video files 
and folders, you can use one of the following methods.

Method one

1.  Highlight the file or the folder.

2. Right click the file with your mouse and select Rename from the menu that 
appears.

Method two

1. Highlight the file or the folder.

2.  Press the F2 key on the keyboard.

Method three

1.  Highlight the file or the folder.

2.  Click File at the top of the window and select Rename from the list of available 
options.
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Method four

1. Highlight the file or the folder you want to rename by single-clicking the file.

2.  Once highlighted, wait a few seconds and click the file name again. A box 
should appear surrounding the file or folder name, and you can rename the 
file.

Figure 1.11 Renaming using right click Rename option

If you do not wait long enough and click the file or folder too fast, it 
can open the file or folder rather than allowing you to rename it.

If we want to rename multiple files of folders at once, we should keep the following 
steps. 

1. Open Explorer.

2.  In Explorer, select all the files you want to rename.

3.  Once the files are selected, press F2 to edit the file name and type the new 
name for the files. For example, typing “test” renames the files to test, test 
(1), test (2), test (3), etc. If you have file extensions shown, make sure that you 
also typed the name of the file extension you are renaming.
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Figure 1.12 Renaming multiple files

1.2.6 Accessing Files and Folders

There are a number of ways you can navigate to your files and folders in File 
Explorer. The methods below will help you to do so. 

 � Using the Address bar (located at the top of File Explorer). The Address 
bar shows the full path of your current location.

 � Forward and Backward buttons

 � From the Folders/Navigation pane

 � Using the Search function (which searches file names and file and folder 
contents in the current folder to find items containing your search term)

Using the address bar

The address bar, which is located at the top of File Explorer as shown in Figure 
1.13 below, displays the path of the currently selected folder or active folder. 

File Explorer drop-down menus are available for each subfolder in the address 
bar. Therefore, we can easily go backward or forward in the folder path by clicking 
on the right-pointing arrow next to the folder and selecting a subfolder from the 
drop-down menu.
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Figure 1.13 File Explorer address bar

Viewing previously visited folders in the address bar

To view folders you have seen previously, you can do any of the following.
Option 1: Click on the forward ( ) or back buttons ( ) as shown in Figure 1.14. 

Figure 1.14 Forward and back buttons to view previously visited folders in 
address bar

Option 2: Click on a folder name in the address bar as shown in Figure 1.15 below.

Figure 1.15 Clicking on folder name to view previously visited folders in address 
bar
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Viewing the contents of a folder in the address bar

To view the contents of a folder in the address bar, click on the right-pointing arrow 
( > ) next to the folder whose subfolders you want to view. The arrow changes to 
a downward-pointing arrow ( V ) and a drop-down list of the subfolders will be 
displayed (See Figure 1.16).

 

Figure 1.16 Viewing the contents of a folder in address bar

1.2.7 Displaying Subfolders Using Navigation/Folder Pane

The Folders pane or the Navigation pane is found along the left edge of every 
folder and displays a directory tree of all the folders on your computer (See Fig-
ure 1.4 and Table 1.1). You can select one or more folders in the Folders pane to 
display their contents in the File List pane. The Folder/Navigation pane contains 
several main sections: Quick Access, OneDrive, This PC and Network (See Figure 
1.4).

If you used previous versions of Windows 10, you know that a folder name 
would have a plus sign next to it if that folder contains documents or subfolders.

With Windows 10, if a folder contains subfolders, that folder’s name will have 
a small right-pointing triangle next to it (>).

 � No triangle next to a folder name (   ) means the folder has 
no subfolders.
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 � Right-pointing triangle next to a folder name (   ) means 
the folder has subfolders.

 � Down-pointing triangle next to a folder name (   ) means the 
subfolders are currently displayed for that folder.

To view a folder’s subfolders, click on the right-pointing triangle (>) next to the 
folder. The right-pointing triangle will turn into a down-pointing triangle and the 
subfolders will be displayed as shown in Figure. 1.17 below.
  

Figure 1.17 Displaying subfolders

In the figure above, “This PC” contains subfolders. To display the subfolders, just 
click on the folder name; to hide a folder’s subfolders, click on the down-pointing 
triangle of that folder so that the subfolders will no longer be displayed.

1.2.8 Moving Files and Folders on Computer

There are several methods available to move computer files and folders 
(directories) from one source or level to another.

When moving files or folders, only one copy of the files is moved. If 
more than one copy of the files are needed, copy the files and instead 
of move them. See how to copy files in section 1.2.4 above.

In Windows, you can move files using several methods. These are:

 � Cut and paste
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 � Drag-and-drop 

 � Use the “Move to Folder” command 

Below are the steps used in different methods (options) to move files in Windows. 
Choose the option that works best for you.

You can also select multiple files and move multiple files at once using 
any of the steps below.

Option 1: Cut and paste

To move files using cut and paste method: 

1. Select the file you want to move. 

2.  Right-click the highlighted file 

3.  Then select Cut. 

4.  Browse to the folder you want to move the file to. 

5.  Right-click in the folder, and select Paste.

Figure 1.18 Moving a file in Windows
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Alternatively, you can click Home from file explorer, select Cut to cut the files, 
browse to where you want to move the files, then select Home and Paste in the 
file menu.

You can also use shortcut keys to cut and paste files. Select the files 
you want to cut, then press the shortcut key Ctrl+X to cut the files. 
Cutting the files is like cutting text in a document, i.e. it moves the files 
to a temporary clipboard until you paste them somewhere. Navigate 
to the destination folder and press the shortcut key Ctrl+V to paste the 
files. The files are now in your destination folder.

Option 2: Drag-and-drop

To move the files and folders using drag and drop, follow these steps: 

1. Highlight the files you want to move. 

2.  Press and hold your right mouse button and drag-and-drop the files to where 
you want to move them. 

3.  When you release the mouse button, a menu appears.

4.  Select the Move here option to move the files.

For drag-and-drop to work, you will need to be able to see the window 
of where you are moving the files.

Option 3: Use “Move to Folder”

To move the files and folders using Move to Folder command, follow these steps: 

1. Select the file by clicking the file name. 

2.  Click the Home menu found on the top-left of the window and select the 
Move to Folder option. 

3.  In the new window, browse to the folder you would like to move the file; 
then click the Move button to move the file to that folder.

If you are using Windows 7 and below versions, once the files are selected, the 
Move to option is shown under the File tab.



Grade 9 Information Technology Student’s Textbook 

   21

Figure 1.19 Using Move to Folder command to move files

1.2.9 Deleting File and Folder

Now and then, it is a good idea to clean up your drives and delete duplicated 
files such as photos, documents, temporary files and videos, and other unneeded 
or unwanted files and folders. The steps to delete a computer file, a directory or 
a folder vary based on the method you want to use and your operating system. 
Below are more common methods used for deleting a file or a folder in Microsoft 
Windows.

Users not familiar with Windows should realize that if they delete a 
folder or directory, all files and folders in that folder or directory are 
deleted. Deleted files or folders can be restored from Recycle Bin if not 
permanently deleted using shift + Delete key.   

Use the following Steps to delete file or folders using Delete key method

1. Locate the item you want to delete. 

2.  Highlight the file or the folder by left-clicking with your mouse once. 
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3. Press the Delete key. 

You can delete multiple files or folders by holding down the Ctrl key 
and clicking each file or folder before pressing Delete. You can hold 
down the Shift key while pressing the Delete key (shift + Delete) to 
delete the files permanently. In this case, restoring from Recycle Bin is 
not possible since the file will not go to the Recycle Bin when deleted. 
It will be deleted permanently.

Use the following steps to delete a file or a folder by right-clicking 
method.

1. Open This PC or File Explorer. We recommend you to make sure that the 
directory or folder is empty before proceeding; otherwise, you intend to 
delete everything in it. 

2.  Locate the file or the folder you want to delete and right-click it. 

3.  Choose the Delete option from the pop-up menu.

Figure 1.20 Delete file using right click option

Caution!

The local disk contains files and folders that are important for your computer 
to run correctly. Unless you know what you are deleting, please do not delete 
any file from this section.
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Use the following steps to delete a file or a folder using Delete command 
from the Home menu.

1. Open This PC or File Explorer. 

2. Locate and select the file or folder you want to delete.

3.  Click Home in the top menu bar, and select Delete.

Figure 1.21 Delete from the Home menu

Practical Exercise 1.4

Find an icon of a file that you saved on your desktop before or identify any file 
that is not important anymore to keep and delete it using one of the methods 
that you have learnt. 
Caution: be aware of the danger of deleting system files. 
Note about a special folder called Recycle Bin where deleted files are kept in. 
You need to delete the file from the Recycle Bin for a permanent removal.  

1.2.10  Searching a File on a Computer

All major operating systems running on computers can find files on the hard 
drive or other drives connected to the computer. 
Microsoft Windows has a search feature that helps you find any file such as 
document, spreadsheet, picture or video on your computer. To find a file, it is 
not required to know its full name. Some of the methods used to search files are 
discussed below.

Option 1: Using Start button

1. Press the Windows key; then type part or the entire file name you want to 
find. 
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2. In the search results, click the file name you want to open.

Option 2:  Using File Explorer

1.  Open File Explorer.

2. In the left navigation pane, click Computer or This PC.

3.  Near the top-right of File Explorer, click in the Search field and enter part or 
the entire file name you want to find.

To find a file on a specific drive, click the drive under Computer or 
This PC in the left navigation pane. Then enter the file name you want 
to search for in the Search field.

Figure 1.22 Search for a file in File Explorer

Practical Exercise 1.5

Work in a group of two or three to do the following file and folder management 
activities.

1. Creating a folder 

Create two folders called Test1 and Test2 in Documents folder. 

2. Creating files

Create a text file and write the text “I love Ethiopian cultures” and save it 
as “testfile1.txt” in the Test1 folder created as answer to question number 1 
above. Open the Test 1 and Test2 folders. Which of the two folders created 
above are empty? 
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KEY CONCEPTS

 �  File Explorer enables you to create, view, rename, delete and search files and 
folders in computer. 

 �  File Explorer is also called Window Explorer in earlier versions of Windows 
10.

 � You can use window key + E to open File Explorer.

1.3 Computer Drives

A drive is a computer hardware component used to store and retrieve data, files, 
programs, operating system, etc. All drives store files and programs used by a 
computer. For example, when you write a letter in a word processor, the program 
is loaded from the hard drive. When you save the document, it is saved to the 

Create testfile2.txt in folder Test2 with the name of your school as a text 
following the above procedures.

3. Copying a file

Copy testfile1.txt to Test2 folder using one of the methods you learned in 
section 1.2.8 above.  What do you observe now in the two folders? Which 
folder contains two files?

4. Moving a file 

Move testfile2.txt from Test2 folder to Test1 folder.  Which method do you 
use? Is there any difference between copying and moving files? What are 
the keyboard shortcuts that you use for copying and moving files?

5. Renaming a file 

Rename testfile2.txt file in Test1 folder as testfile3.txt. See section 1.2.5 to 
revise how you can do this.  

6. Deleting duplicated file

Notice that we have a file named testfile1.txt both in Test1 and Test2 folders. 
Thus, the file is a duplicate. What is the problem of keeping duplicate files in 
your computer? Remove testfile1.txt from Test2 folder. Open the Recycle Bin 
and search for the testfile1.txt file. Why is it found in the Recycle Bin?
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hard drive or other disk or drive. In window operating system, a drive is often 
referred to by its letter like C:, D: or F:. However, Linux operating system uses 
tree structure starting from root represented by forward slash (/). For example, /
home in Linux is a directory used to store users files.  A computer drive can be a 
hard disk drive, CD/DVD drive, removable disk (USB) flash drive, etc. These are 
called secondary storage devices which you have learnt in Grade 8.

A hard disk drive (hard disk or fixed disk) is usually designated as the “C: 
drive”. The hard disk drive is the main data and program storage hardware 
device that can provide quick access to large amounts of data and program in a 
computer. A CD/DVD drive, which is also called optical disc drive, allows you to 
use CD and DVD to listen to music, watch movie or store any files. It is usually 
designated as the “D: or G: drive”. A USB drive, which is also referred to as a flash 
drive or memory stick, is a small, portable device that plugs into the USB port 
on your computer. USB drives are commonly used for storage, data backup and 
transferring files between devices.
The following figure shows examples of common computer drives.

Figure 1.23 Computer drives 

Some users may be confused with “drive” and “driver.” These are 
separate terms. The word drive typically refers to a mechanical hard 
drive or solid-state hard drive used to store the operating system, data 
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and programs. A driver is software code that enables one or more 
hardware devices to communicate with the computer’s operating 
system. Without drivers, a computer could not send and receive data 
correctly to hardware devices such as printer and flash drive.

Accessing all drives available on a computer

In Windows 10, it is possible to view all mounted or attached drives in File 
Explorer. To achieve this, follow the following steps carefully.

1. Open File Explorer by pressing Windows key + E.

2.  In the left pane, select This PC.

3.  All drives are shown on the right. Figure 1.24 shows a typical view of This 
PC with three mounted drives.

Figure 1.24 This PC in Windows 10
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Practical Exercise 1.6

Work in a group of two or three to practice accessing removable drive and 
copying files from it following the instructions given below. 
Plug a removable drive and copy any file into a folder created in your Documents 
folder. 
Note for safe removal of a flash drive.
When you have done using a flash drive, do not remove it from the USB port 
just yet! You will need to make sure that it is disconnected properly to avoid 
damaging files on the drive. Follow is the steps below to safely remove your 
flash drive.

1.  Right-click the flash drive; then select Disconnect (or Eject) disconnecting 
the flash drive.

2.  You can now safely remove the flash drive from the USB port.

If you want to rename a flash drive, follow these steps

1. Right-click the flash drive; then select Rename.

In Windows, most of your programs are stored in the Program Files 
folder, and your documents are frequently saved in the My Documents 
folder.

MINI PROJECT: MANAGING FILES, FOLDER AND DRIVES 

Read and understand each of the following cases carefully and answer the 
questions that follow them.
Case 1
Suppose you have just started to work in school as record officer. Your computer 
uses Windows 10. Your first task is to organize the hard drive on your computer. 
Record officer create and save several types of files about the students, including 
words, spreadsheets and pictures. Your supervisor has asked you to present a 
plan for organizing the student files on the computer. Currently, all of the files are 
saved in the root directory or folder of the computer. 

1. Write a plan for naming and organizing the students’ files of the school. 
Include the following in your plan.
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a. Create a visual tool using pen and pencil that explains your plan. 

b.  Create a list of folders and describe how you will identify each folder 
and the files that are to be placed in each folder. For example, you might 
organize files by students’ year or section.

c.  Create your own naming standard for folders and files. For example, 
the name can contain student grade; then underscore the section, i.e. 
Grade_Section.

2.  Create all the necessary folders and then files according to the above plan.

3.  Show the new filing system to your teacher. Describe how you will use 
File Explorer to view the new folder structure and the organized files for 
students’ registration files. 

Case 2
Suppose you use computer to store all information about the subjects you are 
currently learning. For example, you may have notes, reference books, assignments 
and files or folders for each subject. 

1. Write a plan for naming and organizing the subjects you have been learning 
in grade 9. Include the points discussed above in case 1 in your plan.

2. Create all the necessary folders and then files according to the above plan.

3.  Show the filing system you have created to your teacher. 

1.4 Unit Summary

Learning files and folders is important. Organizations, small or large, have file 
management systems either in a computerized or manual system.  Organization 

KEY CONCEPTS

 �  Drive is a hardware component of a computer which stores files and folders.

 	 Drive can be fixed and removable.

 
  Fixed drives are found within a computer while removable drives are 
portable and plugged externally. 

 �  This PC section of Window Explorer navigation part contains all drives 
mounted on the computer. 
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maintains different files such as human resource data, day-to-day activity data, 
payroll files, customers’ files, organizational documentation files, plan and 
schedule. Students must know how to manage files and folders in a computer 
system so that they can easily locate it, search it, organize similar file together in 
a folder, delete unwanted file to make a room for important files, and do similar 
activities on files and folders. The following are key points of files and folders 
organizations. 

 � A file is a collection of similar data stored in a computer system. 

 � A file in computer is analogous to real world file which is used to store 
some data, for example, student’s data, teacher’s data, etc.

 � In computer, file can be document, picture, audio, video, application, 
etc.

 � Each file in a computer has unique icons. 

 � A folder is like manila folder, it is a container of a file and other folder. 

 � Folder helps you organize similar files together so that you can locate 
files in a computer easily. 

 � File explorer is the best application in order to manage files and folders 
in window. Managing files and folders includes creating, deleting, 
renaming, sorting, viewing and similar activities on files and folders.

 � Navigation Pane is part of the File Explorer which is used to view your 
computer files and folders in tree structure hierarchically. It consists of 
quick access sections: OneDrive, This PC and Network. 

 � Quick access section is used to navigate to folders quickly. It consists 
of Desktop, Download, Documents, Pictures and frequently accessed 
folders.  If you click Desktop, you will get all files found in your desktop. 
Browsers such as Internet Explorer, Microsoft Edge and Chrome will 
put all files downloaded from internet by default in Download folder. 
So, you can access your Download file from Quick access section in 
navigation pane. Documents contains word documents, letters, memos, 
etc. and Picture contains photos you have shot or saved from the Internet.

 � To open File Explorer application, you can use: 

 � The shortcut on task bar or on the desktop.
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 � Start typing ‘File explorer’ after clicking Start button. 

 � Window key + E keyboard shortcut.

 � To navigate to your files and folders using File Explorer in a computer 
system, you can use either of the following methods. 

 � Using the Address bar (located at the top of File Explorer) 

 � Forward and Backward buttons of File Explorer

 � From the Folders/Navigation pane

 � Using the Search function which is located at the right side of File 
Explorer 

 � Clicking the right-pointing triangle next to the file on navigation 
pane, to view the subfolders and/or content of each folder

 � To move files, you can use either of the following methods.

 � Cut and paste

 � Drag-and-drop 

 � Use the “Move to Folder” command

 � You can use F2 shortcut key to rename file or folder after selecting it. 

 � A drive is a computer component used to store the data and it can be: 

 � Static (built in) drive: including internal hard disk, SSD and the like. 

 � Removable drive: including Flash Disk, Removable Hard Disk, CD, 
etc.

 � To view all mounted or attached drives in window, File Explorer 
application is used. 

1.5 Unit Review Exercise

Part I: Write whether the following statements are true or false.

1. ‘Copy and paste’ can also be referred to as moving a file.

2.  A file is an entity in a computer system that contains other files inside.

3.  Renaming a file removes its content.
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4.  Dragging a file creates multiple copies of files. 

5.  Deleting a file will completely remove files from the disk.

6.  We cannot access or open files and folders using address (path) because files 
and folders do not have address in computer.

7.  Windows does not allow handling multiple files.

Part II: Choose the correct answer among the alternatives provided.

1. To expand a branch of the folder tree, you would _____. 

A. click on the folder name in the folder tree

B.  click on the icon Arrow right (>) of the branch 

C.  click on the icon Arrow – down (V) of the branch

D.  None of the above.

2. To remove a file or a folder, you would _____

A. drag it out of the window

B.  select it and press the Delete key

C.  select it and press Ctrl + Delete keys

D.  right click on the file or the folder and select Cut

3. What do you do to select an of icon a file?

A.  Left click

B.  Right click

C.  Double click

D.  Scroll

4. Which one of the following is true about file explorer?

A. It was called window explorer previously.

B.  It is used to view files and folders.

C.  It is used to view available drives. 

D.  All of the above. 
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5. What do you do to get a menu when clicking on a folder or file icon?

A. Left click

B.  Right click

C. Double click

D.  Scroll

6. Which type of icon can take you to another place quickly?

A.  File

B.  Folder

C.  Application

D.  Shortcut

7. What do you do to open a folder?

A.  Left click

B.  Right click

C.  Double click

D.  Scroll

8. What do you do to rename a folder?

A. Left click

B.  Right click

C.  Press F2 key

D.  Scroll

9. What is drive used for?

A. To open files from your teacher

B.  To use applications not on your computer

C.  To save things on the computer

D.  To save their work for students

10. What would you do to see the content of the file using Navigation pane? 

A. Right click

B.  Left click

C. Double click

D.  Drag
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11.  _______is used to open a file or a folder.

A. Right click

B.  Left click

C.  Double click

D.  Drag 

12. Which one of the following short cut keys is used to save any file?

A. Ctrl + N

B.  Ctrl + S

C.  Alt + Z

D.  Ctrl + A

 Part III: Fill in the blanks.

1. Information is stored in a storage device with a specific name called __________.

2. Duplication of files from one drive to other is called _______________________.

3.  The cut and paste option is also called _______________________. 

4.  ______________________ means locating a file among a set of files.

5. To delete a file, you have to click the right button of the mouse on the file name 
and select the _________________ option.

6.  __________________ is used to manage files and folders in window.
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Part IV: Match the following items in column A with column B.
  A                           B

1. Collection of data     A. File Explorer

2. Used to organize similar files    B. Used to draw pictures

3. Used to manage files and folders   C. Navigation panes

4. View your computer’s file and folder structure      D.Used to process text files

5. Formerly called favorites    E. File

6. Allows you to see all networked PCs   F. Quick Access

7. Paint Application     G. Network

8. Moving files      H. Folder

9. Fixed drive      I. CD

        J. Internal hard disk

        K. This PC

        L. Copy and Paste

        M. Cut and Paste

        N. Internet Explorer 

 Part IV: Provide clear and precise responses to the following questions. 

1. What is the difference between a file and a folder?

2.  Where are files stored?

3.  Write the steps to create a folder?

4.  Why do files need to be kept in the proper place in a computer?

5.  Write the major steps to rename a folder?

6.  Write the major steps to delete a folder?
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UNIT OVERVIEW 
This unit focuses on computer network, mainly on Internet and Internet services 
emergence. You learned about Internet and its services in grades 7 and 8. Do 
you remember the different services that you can get from the Internet such as 
web surfing for searching information, file sharing, chatting, messaging, and 
social media networks? There are also serious risks associated with unsafe and 
improper utilization of Internet.

This unit discusses fundamental concepts of computer network. The unit 
is divided into four sections. The first section defines what a network is and is 
followed by listing and describing different components of a computer network, 
both the software and hardware parts. The last two sections present types of 
network and advantages and potential threats of connecting computers or other 
electronic devices into a network.   

At the end of this unit, learners will be able to:

 � Define what a computer network is.

 � Identify the building blocks of a computer network. 

 � Compare and contrast the basic types of networks (LAN, MAN, WAN) 
and client server vs. peer to peer. 

 � Describe the topologies of network.

 � Discuss the advantages and disadvantages of network.

 � Draw simple network diagrams using network device symbols.  

UNIT 

COMPUTER NETWORK

UNIT OUTCOMES

2 
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2.1 Definition of Network

     
 Brainstorming 

1. Have you shared a file or received a message using mobile phone? How do 
you think that your file or message move around to reach its destination?

2. Identify different organizations in your local areas that utilize computer 
networks for their service provisions.

A netwok is a connection of two or more computers that are linked together 
in order to share resources(such as printers, files and disks) or allow electronic 
communications. Using Bluetooth application in your mobile phone to share files 
is an example of a network.Sometimes, the Internet is called the largest global 
network. Figure 2.1 shows an example of a network with multiple computers 
and other network devices, which are all, connected. The figure shows that the 
laptop, the tablet, the mobile phone and the television are connected to the central 
network device. The central network device is, in turn, connected with a global 
network through an internet service provider (ISP) company such as Ethio-
telecom. You will learn more about these in the next sections. 

Figure 2.1 Home network
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2.2 Fundamental Elements of Network

Networks are comprised of four basic elements: hardware, network software, 
protocols and connection medium. All data networks are comprised of these four 
elements, and cannot function without them. The backbone of any network is the 
hardware that runs it. As you can see from the top two rows in Figure 2.2 below, 
network hardware includes end devices and intermediary devices.  

Network software is also a foundational element for any network. This type 
of software helps to manage connected end devices and services the network 
provides. Protocols are set of rules to facilitate electronic communication across 
connected device. You will learn more about protocols in Grade 10. Transmission 
medium which can be wired or wireless, caries message between end devices. 

Each element of networks is described one by one in section 2.2.1 to 2.2.4 below. 
Figure 2.2 shown in the next page presents examples of the hardware elements in 
the three categories. 

2.2.1 End Devices 

Activity 2.1

Form a group of three to five students and discuss the following questions. 

1. What is a computer network?

2. What are the applications of network in our day-to-day lives? 

 
 Brainstorming 
Consider different electronic devices at home, e.g. digital camera, laptop, 
mobile, television, etc. Which of the devices do you see connected with cable or 
other formats? 
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End devices, which are also called hosts, are devices used to send or receive data 
over the network. The sending device is called a sender and the receiving one is a 
receiver.  Some examples of end devices are:

 � Computers(such as desktops, laptops, file servers and web servers etc.)

 � Network printers

 � Security cameras

 � Mobile handheld devices.

Figure 2.2 End devices, intermediary devices and media

2.2.2 Intermediary devices 

Intermediary devices interconnect end devices. These devices interconnect and 
work behind the scenes to ensure data flow across the network and the devices. 
Intermediary devices connect the individual hosts to the network and also can 
connect multiple individual networks to form an internetwork. Intermediary 
device includes network cards, routers or network switches, wireless access 
point (WAP) and repeaters. Without these hardware devices, end devices have 
no means of accessing a network. 

a. Network Interface Card (NIC)
Network Interface Card (NIC) is a computer hardware component that connects a 
computer to a computer network. As it is shown in Figure 2.3, Network Interface 
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Card (NIC) comes in a card form to be plugged into the computer system or can 
be an integrated one as part of the systems board that you often see in laptops. 
NIC has a slot to plug-in a cable connection with a network. 

Figure 2.3: a) Network interface card    b) Cable to be plugged in to a desktop 
computer NIC

b. Repeater 
Communication media or cables that you are going to learn in section 2.2.4 
have limitation. This includes the electronic signal they carry will become weak 
after traveling a long distance. Repeater enables a network segment to extend 
the coverage to reach beyond its inherent distance limitation by refreshing or 
generating the weak network signal. Figure 2.4 depicts that a weak signal (depicted 
on top of the Figure) is regenerated by a repeater in the middle to restore the 
signal to its original signal (bottom).

Figure 2.4 Repeater
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c. Switch 
A switch, as shown in Figure 2.5 (a), is a device that interconnects various devices 
such as computers, printers and servers in a small business network, as shown in 
Figure 2.5 b below. Switch is more intelligent device than hub as it can segment 
a computer network into smaller parts. In addition, switch forwards packets to 
specific destination after learning the network topology. To perform this, switch 
uses a table which contains computer physical address and switch port number on 
which a computer connected on. A hub is unintelligent device which broadcasts 
all received packets to all computers connected to it except the sender.

Figure 2.5 a) 24 port switch                                       b) Switch on a network

d. Router
Consider yourself as a taxi driver in a given town which has a lot or streets (roads) 
interconnected. Think about the driver when he or she selects a particular street 
from many different options available to reach to his or her destination. What 
factors does he or she consider? The distance? The traffic jam or number of cars in 
a certain road segment? Which road segment would take him or her where? What 
else, he or she might think of? 

A router is such an intelligent device which operates in determination of 
pathways for electronic messages in networks. A router, as its name suggests, 
works with routing or finding a route through a network. That is, it is a router 
of a network. The main objective of router is to connect dissimilar and different 
networks simultaneously as shown in below Figure 2.6. As shown in the figure, 
there are two network segments, each connected to a switch. The two switches 
are connected to each other through the router. Assume two different cases.
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Case 1: A computer sends a message for another computer within one network; 
that is, both the sending and the receiving computers are connected to the same 
switch. 
Case 2: A computer in one network segment sending a message to another 
network connected to a different switch.  

The router usually works for case 2 type scenario and it selects best route to 
reach to the destination network. To do this, a router uses a mechanism called 
routing table, which contains destination network field and interface number of 
routers.

  

Figure 2.6 Router connecting two networks

e. Wireless Access Points

 
 Brainstorming 
Discuss in a group of three to five students about different methods that you 
could use to connect handheld mobile phones to the Internet. 
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A wireless access point (WAP) is an intermediary device in a network that connects 
various types of wireless communication devices with wireless networks. The 
connectivity is made possible through Bluetooth and Wi-Fi technologies. It acts 
as an intermediary between wireless and wired devices that are part of a network 
(See Figure 2.10 in Section 2.3).

2.2.3 Communication Protocol

In networking, a protocol is a set of rules that governs data communications. In 
order for different network hardware to interact with the network, they should 
follow the same rules called protocols. It is software that instructs network devices 
on how to connect to the network and how to interact with one another. Internet 
Protocol (IP) is one of the important communication protocols and used for 
addressing network devices and forwarding data from one network to another. 
You will learn IP and its classes in detail in grade 10.

2.2.4 Connection Media

Without physical connections(wired or wireless), a network cannot function. The 
connection media are the media which are used to carry the message from sender 
to receiver. We have two types of communication medium: wired and wireless. 

 
 Brainstorming 

1. Do people have a convention, protocol or set of rules when they communicate, 
for example when they talk on phone or write a letter, email, etc.? Have you 
learned about formal and informal letter writing in your English or local 
language subjects? How do you write sender’s and receiver’s addresses in 
the letter? Are these not protocols? What others common protocol do you 
remember?

2. What will happen if an individual does not follow a protocol?

 
 Brainstorming 
Why are the telecommunication cables stretched across the streets and roads? 
What about the big mobile antenna towers that stood on the hills and in the 
towns?
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i. Wired medium: It is also called guided medium. It is a cable that connects 
end devices. Copper and fiber optic cables are examples of wired medium. 
The most common copper cable used in networks today is unshielded 
twisted-pair cable (UTP), which uses electric signal to transmit message 
for a maximum distance of 100 meters.  Fiber optic cable uses light to 
transmit signal at faster speed and longer distance than copper cable. 

ii. Wireless Medium: It is also referred to as unguided media or unbounded 
transmission media. It is used to communicate information through the 
air, water or vacuum, e.g. radio Waves, micro waves, infrared waves and 
satellite communications. 

Figure 2.7 below presents some examples of wired and wireless communication 
media along with their connectors. You will cover the communication media in 
detail in grade 10. 

Figure 2.7 Types of communication medium
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Practical Exercise 2.1

Form a group of two to three students and work on the following activities.

1. Search the internet for Cisco and Huawei network device symbols that are 
covered in the classroom.

2.  Use these symbols and draw simple network diagram that consists of the 
fundamental elements of network 

3.  Draw a network diagram specified in Figure 2.6 using a Cisco packet tracer, 
Graphical Network Simulator 3 (GNS3) or on paper using the right symbols.

KEY CONCEPTS

 �  Network is connection of two or more devices for sharing resource which 
can be data, hardware, software, etc.

   A given network comprised of the following four basic components.

Activity 2.2

Form a group of three to five students and work on the following activities.

1. Visit your school network or computer laboratory and identify fundamental 
elements of network available. 

2.  Ask the network administrator or the laboratory manager about some 
network protocols used/implemented in the design of the school network?

3.  Find an unshielded twisted-pair (UTP) cable analyse its connectors, the 
number of wires inside the plastic shield, colour of each wire and order of 
the colours.

4.  Ask the responsible person about which interconnecting devices are used to 
set-up the network at your school and roles or functionalities of the devices 
in the school’s network.

5.  Compile an activity report and reflect it in your class.
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 �  End devices are senders and receivers and able to send and receive 
messages. 

 �  Intermediary devices are used to interconnect end devices together in 
the same and different networks.

 �  Protocols are common rules followed by communicating parties to 
govern communication in a network. 

 �  Transmission medium is a physical path between sender and receiver, 
used to carry message.

 � There are two types of transmission medium: wired and wireless medium.

 � Switch is used to create a local area network whereas Router is used to 
interconnect different local area networks.

2.3 Types of Networks 

There are different types of network classified based on the following four cate-
gories: 

 � Network media 

 � Size of the network or geographical coverage of the network 

 � Topology 

 � Resource security and access  

The type of network based on this categorization is depicted in Figure 2.8 below. 
Each type of the network depicted in Figure 2.8 is discussed in subsection 2.3.1 
to 2.3.4.  

 
 Brainstorming 
Consider networks at your home, if any, or at your school. Consider also the 
network that belongs to such a big company, like Ethiopian Airlines, that has 
branch offices throughout Ethiopia and abroad. Are the network technologies 
and number of end devices connected the same among these networks? Discuss 
how they are the same or different. 
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Figure 2.8 Types of networks based on different perspectives

2.3.1 Types of Network Based on Connection Medium 

Based on connection medium, computer networks are classified into wired and 
wireless networks. 

Wired Network

Wired networks, also called Ethernet networks, are the most common type of 
local area network (LAN) technology. A wired network is simply a collection of 
two or more computers, printers, and other devices linked by Ethernet cables. 
This is shown in Figure 2.9, as an example, where each line connects the end 
devices and servers to the global network (the globe) cables. 

Figure 2.9 Wired network
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Wireless Network

If you compare Figure 2.10 below, which is a wireless network, with Figure 2.9 
above, you will see a wireless access point connecting with a wireless or a wired 
computer and a model, which connects the network with the Internet (or cloud). 
Wireless networks have no physical connection with the wired network; instead 
they get connected through the wireless access point (WAP). A wireless network, 
which uses high-frequency radio waves rather than wires to communicate 
between nodes, is another option for home or business networking.  

Individuals and organizations can use this option to expand their existing 
wired network or to go completely wireless. Wireless network allows for devices 
to be shared without networking cable which increases mobility.  

Figure 2.10  Wireless network
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The backbone of wireless network is always a wired network.            

2.3.2 Types of Networks Based on Size 

Computer networks can be characterized by their sizes. The size of a network 
can be expressed in terms of the geographic area the network occupies and the 
number of computers connected to the network. Networks can cover anything 
from a handful of devices within a single room to millions of devices spread 
across the entire globe.

In Figure. 2.11 and Table 2.1, we classify networks by their rough physical size. 
The smallest in size is the personal area networks (PAN), networks that are meant 
for one person. Beyond PAN, with varying coverage range are categorized into 
local, metropolitan and wide area networks, each with increasing scale.
Some of the network types based on size are:

 � Personal area network or PAN

 � Local area network or LAN

 � Metropolitan area network or MAN

 � Wide area network or WAN

Activity 2.3

Ask your parents or adults you have close contacts with about the following 
and discuss them in your classroom.

1. Ask your parent or any person about different networks which exist in 
your city, town or village. 

2.  Based on the description you got from your activities in question number 1 
above, discuss the types of the network that at least one of the organizations 
has in terms of connection medium, wired, wireless or a mixed one?

3.  Discuss also what types of end and intermediary devices the network could 
potentially have in the organization, with a reason for your device type 
selections. 
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Figure 2.11 PAN, LAN, MAN and WAN

Table 2.1 PAN, LAN, MAN and WAN Descriptions

Network Distance

1 m Square Mater

10 m Room

100 m Building

1 km Campus

10 km City

100 km Country

1000 km Continent

10,000 km Planet

Personal Area Network (PAN)

A personal area network (PAN) is a computer network organized around an 
individual person within a single building. A common example is a wireless 
network that connects a computer with its peripherals. Almost every computer 
has an attached monitor, keyboard, mouse and printer. If there is no wireless 
network, this connection must be done with cables. 

 

Personal Area Network
 

 

 

Local Area Network

Metropolitan Area Network

Wide Area Network
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A network created by Bluetooth is PAN. Bluetooth is a short-range wireless 
network used to connect computer’s peripheral components without wires as 
shown in Figure 2.12. In the figure, a laptop, a mobile phone and a television 
or tables are connected to one another without a cable.   The idea is that if your 
devices have Bluetooth, then you need no cables. You just put them down, turn 
them on and they work together. 

Figure 2.12 Bluetooth PAN configuration

This type of network provides a great flexibility. For example, it allows you to:

 � Send a document to the printer in the office while you are sitting on the 
couch with your laptop.

 � Upload a photo from your cell phone to your desktop computer.

 � Watch movies from an online streaming service to your TV.

Local Area Network

Local Area Network (LAN) is generally an organizational or a privately owned 
network within a single office, building or campus covering a distance of a few 
kilometers. The main reason for designing a LAN is to share resources such 
as storage spaces, printers, programs and data. It also enables the exchange of 
information.

The smallest LAN may use only two computers while larger LANs can 
accommodate thousands of computers. A LAN typically relies mostly on wired 
connections for increased speed and security, but wireless connections can also 
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be part of a LAN. If a LAN is entirely wireless, it is referred to as a wireless 
local area network (WLAN). Figure 2.3 depicts a LAN that combines cabled and 
wireless networks into a single network. 

Figure 2.13 Wired and wireless and local area networks

Metropolitan Area Network

A Metropolitan Area Network (MAN) is a network that is designed to cover an 
entire city. Suppose a bank wants to connect three of its branches in a given city. 
In such a case, the bank will utilize the service of existing telephone network 
of the city (for example the Ethio-telecom network) to interconnect its offices, 
through which MAN is created.  Figure 2.14 shows a MAN that interconnects a 
hospital, a school/collage and a factory local area networks. 
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Figure 2.14 Metropolitan area network 

Wide Area Network

A wide area network (WAN) occupies a very large area such as an entire country 
or the entire world. A WAN can contain multiple smaller networks such as LANs 
or MANs. The Internet is the best-known example of a public WAN. A diagram 
depicting MAN is shown in Figure 2.15 below. It indicates that computers residing 
in different parts of the world are connected to each through a MAN.  

Figure 2.15 Wide area network
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Activity 2.4

Do the following as an extension to Activity 2.3 above.
Based on the description you got from your activities in question number 1 of 
Activity 2.3, discuss the type of the network that at least one of the organizations 
has in terms of connection medium as well as size of the network.

2.3.3 Types of Network Based on Topologies 

Network topology defines how various computers or electronic devices 
represented as nodes are connected to one another in the network. It refers to the 
physical arrangement of devices in a network. Typical network configurations 
include bus topology, mesh topology, star topology, and ring topology (See 
Figure 2.16).

Figure 2.16 Network topologies

a. Bus Topology
In bus topology, there is a long cable called bus which acts as a backbone for 
all the nodes as shown in Figure 2.17. A bus topology network connects each 
computer or electronic devised to a backbone cable (or bus) just like a water pipe 
interconnections. 

Figure 2.17 Bus topology
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A bus is easy to install and uses less cables than other topologies. However, fault 
isolation becomes very difficult in bus topology. It is also relatively difficult to 
add new nodes to a bus, thus making it more inflexible. This is because addition 
of a node changes the number of taps and the average distance between them, 
which are generally optimized for a bus length. Another demerit is that, even if a 
portion of the bus breaks down, the whole bus cannot function.

b. Mesh Topology
In mesh topology (also called complete topology), each node is connected to every 
other node by direct links. Figure 2.18 illustrates this.

Mesh topology does not have traffic congestion problems due to dedicated 
links. This topology has the advantage in terms of data security. It is also robust; 
that means, if one link is down, the rest of the network can still continue. Fault 
identification is also easy in this case. The main demerit of this network scheme 
is cable length and consequent cost and complexity. This is clearly impractical for 
medium to large networks. 

Figure 2.18 Mesh topology
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c. Star Topology
In a star topology, each device has a dedicated point-to-point link only to a 
central controller, usually called a switch. The devices are not directly linked to 
one another. Unlike a mesh topology, a star topology does not allow direct traffic 
between devices. If a node wants to send some data to another node, it sends it 
to this switch. The switch, in turn, sends it to the appropriate node as Figure 2.19 
depicts.

Star topology is cheaper than mesh topology. It is also relatively easier to 
install, maintain and reconfigure. It is also robust. However, if the switch goes 
down, the entire network becomes defunct. This is a major demerit of this scheme.

Figure 2.19 Star topology 

d. Ring Topology
In ring topology, each node is directly connected to only its two adjacent neighbors. 
If a node wants to send something to a distant node on a ring, it has to go through 
many intermediate nodes, which act like repeaters, reproducing the incoming bit 
stream with full signals on the outgoing line. Figure 2.20 depicts this topology.



Grade 9 Information Technology Student’s Textbook 

   57

Figure 2.20 Ring topology

A ring is easy to reconfigure and install. In a ring, a signal normally circulates 
all the time. A node not receiving any signal for a long time indicates a fault. 
Therefore, fault isolation is relatively easy in a ring. However, if a node in a 
simple ring fails, the whole ring cannot function. Another demerit is that traffic 
flows only in one direction. This topology is not used if the number of nodes to be 
connected is very high. Advantages and disadvantages of all network topologies 
are summarized in below Table 2.2.

Table 2.2 Advantages and disadvantages of all network topologies

Topology Advantages Disadvantages

Bus - Cheap
- Easy to install

- Difficult to reconfigure
- Break in bus disables entire net    
work

Star

- Cheap
- Easy to install
- Easy to reconfigure
- Fault tolerant

- More expensive than bus

Ring - Efficient
- Easy to install

- Reconfiguration is difficult
- Very expensive

Mesh - Simplest 
- Most fault tolerant

- Extremely difficult for reconfigu-
ration
- Extremely expensive
- Very complex
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Activity 2.5

Do the following as an extension to Activities 2.3 and Activity 2.4.
Based on the description you got in Activity 2.3 question number 1, discuss 
the type of the network that at least one of the organizations has in terms of 
connection medium, size and network topology.

2.3.4 Types of Network Based on Resource Security and Access 

Peer-to-Peer Network 

In a Peer-to-Peer network, each machine (computer) is known as peer and can 
participate in the sharing of files or resources. No server is required in this 
network, so there is no additional cost for a dedicated machine, but there is also 
no a real security.

A peer-to-peer network is also called workgroup and there is no hierarchy 
among the computers. This mean that all computers are peers (equals) and the 
connection is created for resource sharing and communication purposes only. 
The number of computers in peer-to-peer network usually does not exceed 10; if 
the number is beyond this, the network becomes very difficult for administration. 

Advantages of peer-to-peer network

 � Server is not required.

 � All computers are equal in the network.

 � No additional cost is needed for dedicated-machine.

Disadvantages of peer-to-peer network

 � Provides share level security, i.e. it applies a trust-based security. 

 � Can work in small environments only.

Client-server Network 

A client-server network involves multiple clients or workstations, connecting 
to at least one central server. Most resources are installed on the server. When 
clients need access to these resources, they access them from the server. Servers 
often have private user directories as well as multiple public directories.
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 In client-server networks the clients are allowed to function as workstations 
without sharing any resources. It is easier to upgrade software applications and 
files because they are held on one single computer. System-wide services can be 
provided through the server software. Security is enhanced on a client server 
network because the security is handled by the server. The following table sum-
marizes the difference between peer-to-peer and client network. 

Table 2.3 Comparison of client-server and peer-to-Peer networks

S.No Client-server Network Peer-to-peer Network

1
Clients and server are differentiated; 
specific server and clients are present.

Clients and server are not dif-
ferentiated.

2 Focuses on information sharing. Focuses on connectivity.

3
Centralized server is used to store the 
data.

Each peer has its own data.

4
Server responds the service which is             
requested by client.

Each and every node can do 
both request and respond for 
the services.

5 Costlier than peer-to-peer network.
Less costly than client-server 
network.

6
More stable than peer-to-peer net-
work.

Less stable if number of peer is               
increased.

A client is a computer which requests resources and services while a 
server is a computer which provides services and resources according 
to client requests. Informally, clients often tend to be desktop PC’s or 
workstations, while servers are more powerful machines.

KEY CONCEPTS

 �  There are different types of network based on type of medium, topology and 
size of the network, and resource security and access. 

 � Wired network uses cable while wireless uses radio waves to form a network. 
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 �  The number of devices connected in the network and the geographical 
coverage of the network is called the size of the network.

 �  Based on size of the network, network can be categorized as personal area 
network (PAN), local area network (LAN), metropolitan area network 
(MAN) and wide area network (WAN).

 �  Network topology is the physical arrangement of devices on a network and 
can be bus, star, ring and mesh topologies.

 �  Based on security and access, network can be either client-server or peer-to-
peer network.

Activity 2.6

Ask your parents or adults you have close contact about the following and 
discuss them in classroom.

1.  Discuss whether peer-to-peer or client-server network is more appropriate 
for:  

a.  A small home network.

b.  A school laboratory network.

2. Discuss advantages and disadvantages you considered for the selection of 
the network type in question 1 above. 

2.4 Advantages and Disadvantages of Network 

 
 Brainstorming 
Consider networks at your home, if any, or at your school. Discuss the potential 
benefits as well are risks that emerge from connecting to a network. 
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2.4.1 Advantages of network

There are more advantages to a network than disadvantages. In fact, many 
companies today would not exist without accessing some form of network. Below 
are the advantages of a network.

 � Sharing data and information - One of the biggest advantages of a 
network is sharing data and information between each of the devices 
on the network. In addition, networks allow accessing the data which is 
stored on central computer called database server. For example, we use 
network for sharing documents, images, photos, songs and videos.

 � Communication - A network gives all users the ability to quickly 
communicate with each other either using chatting or instant messaging 
services such as Skype, WhatsApp and Viber to send files and messages 
among the users, video conferencing, e-mail, TV and radio.

Communication at a distant is called telecommunication; ‘tele’ in 
Greece is to mean remote. 

 � Sharing hardware – Expensive hardware devices connected to a network 
can be shared among all users. 

 � Storage devices such as Hard Disk that are shared on a storage 
server, which is also called NAS (Network attached storage), can 
store and access vast amounts of information.

 � A printer which is attached and shared on a server (printer server) 
allows all network users to print from one printer according to their 
privilege configured on the server by a network administrator.

 � Fax machines, Scanners, more powerful computers, such as super 
computers that can perform complex tasks within short period of 
time than a single computer will take to complete. 

 � Share software – Different application software and Internet-based 
services can be shared over the network for all licensed users for the 
software. For instance, we can share software such as computer games 
and work Internet-based services such as e-learning. E-learning or 
learning management system in its broadest sense is designed to support 
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teaching and learning as well as student-to-student and student-to-
teacher instructions.

 � Transferring money - Being connected to a secure network allows a 
person or business to digitally transfer money between banks and users. 
For example, a network could allow a company not only to manage 
employees’ payroll but also to transfer their pay to the employee’s bank 
account.

2.4.2 Disadvantages of network

Although there are many advantages to a network (mentioned above), there are 
some disadvantages. Below are some disadvantages of a network.

 � Virus and malware - Networks make sharing information between 
network users easy. Unfortunately, this also means that viruses and 
other malwares have an easier time spreading between computers on a 
network.

 � Vulnerabilities - When computer are connected on the network, it will 
be accessible remotely, with these potential new methods of accessing 
the computer; it can introduce new security issues or vulnerabilities 
to the computer, users and the data on the network which affect the 
organization and the country at large. 

 � Complex - Networks are complex, and setting up and managing a 
network for a business or corporation requires someone with a lot of 
experience or certification.

 � Cost - Setting up, managing and administering a network hardware and 
software incurs cost to the organization building a network. 

 � Social media effect on youth and adults - particularly youths, 
including students, waste their time on use of social media and unsafe 
Internet resources. There are also many cyber security threats such as 
cyberbullying, disinformation/misinformation and identity theft that 
you should be aware of and learn to develop safe use of the Internet. 
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Practical Exercise 2.2

Make a group of three to five students and do the following.

1. From Ethio-telecom website (https://www.ethiotelecom.et/), assess the 
common network services it provides as an internet service providers (ISP).

2.  Search for reliable information such as the one from Ethiopian Information 
Network Security Agency (INSA) https://www.insa.gov.et) about different 
cyber security attacks that you may encounter as a student – such as  
misinformation/disinformation, cyberbullying, sex trafficking, hate crime 
and financial scams. Discuss in group how you can protect yourselves from 
such attacks. 

3.  Explore the functionalities and symbols used for representing network 
devices, preferably in an open source network mapping tools such as Dia 
(http://dia-installer.de/). 

KEY CONCEPTS

 �  Computer network can be used to exchange data and information, and to 
share resources such as hardware (e.g. storage spaces) and software.

 �  A virus can travel over the network and can affect our file on the computer. 

2.5 Unit Summary

In this unit, the students are supposed to learn the basic concepts, types, 
advantages and disadvantages of network. You shall develop essential skills 
through the classroom learning, participation in activities and laboratory-based 
work in the unit. 

Computer networks help us have such services as emails, online newspapers, 
blogs, chats and other network services offered on the Internet. Therefore, 
understanding network will help students to become actors and beneficiaries of 
the networked society and share resources and have a faster communication. 
The following are the main points covered in the unit.  

 � A computer network is interconnection of two or more computers or 
any devices that able to connect over the network. 
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 � To make a communication and interconnection between devices on 
a computer network, networking hardware, also known as network 
equipment or computer networking devices, which are electronic 
devices, are required. These are end devices, intermediate devices, 
connection medium and protocol.

 � End devices are the sender and the receiver which can be any devices 
capable of composing, sending and receiving a message. 

 � Intermediate devices are interconnecting devices that found between end 
devices, as their name indicates. Intermediary device includes network 
cards, routers or network switches, modems and Ethernet repeaters.

 � Network interface card (NIC) is used to plug a UTP cable to the 
computer. It has wireless variety which allows a computer to connect to 
the network wirelessly.

 � Repeaters, as the name indicates, repeat and boost the signal. It accepts 
weak signal on one port, illuminates the noise that makes signal week, 
regenerates signals and resends the boosted, cleared signal over the 
other port.  It has an analog version, which is also called Amplifier. 
Amplifier amplifies not only the signal but also the noise and sends it 
again.   

 � Switch is more intelligent device than repeater because after learning the 
network, it forwards packet to the destined port or a device connected 
to the port only.  

 � A router is a device that connects different types of network and more 
intelligence than switch.

 � Router uses routing tables.

 � Router selects best path through networks.

 � Protocol is a common set of rules to manage communication (packet 
transmission) through a network. 

 � Connection media used in networks are wired (guided) and wireless 
(unguided) media. 

 � UTP is the most common wired medium used in local area networks. 
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 � Wireless media can be radio waves, microwaves and infra-red waves.

 � Based on size, network can be classified as personalized area network 
(PAN), local area network (LAN), metropolitan area network (MAN) 
and wide area network (WAN).

 � PAN is the smallest area network which can be made using Bluetooth 
network. 

 � LAN is larger than PAN and smaller than MAN in number of computers 
and geographical coverage. LAN can be a small office, one campus or 
school, network. 

 � MAN convers area of a city and can contain multiple LANs.

 � WAN covers very large area such as the globe. 

 � Network topologies include bus, star, ring and mesh topologies. 

 � A bus topology is a cheap network where computers are connected to a 
common backbone cable. 

 � In a mesh topology, every computer in a network is connected to each 
other independently. Mesh topology needs more cable and more ports 
on the computer. 

 � In star topology, all computers are connected separately to a central 
device, which can be a switch. A failure of the central device results in a 
failure of the entire network. 

 � Ring topology looks like finger ring that connects devices in such a way 
that each device is connected to other two adjacent devices.  Failure of 
one node in ring topology network will affect the whole network. 

 � Peer-to-peer and client-server networks are based on resource access 
and sharing.

 � In peer-to-peer network, resources are distributed among peers and 
each peer can be a server and client at the same time. 

 � In client server, resources to be shared over the network are adminis-
tered centrally and there is a dedicated server which provides resources 
called servers and there is also a dedicated client which requests a re-
source from the server. 
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 � Network is advantageous in increasing communication speed, sharing 
data, sharing hardware, sharing software and getting entertainment.

 � Network also disadvantageous in security concerns and incurring cost 
for setting up and administration of network, hardware, software and 
the like. 

2.6 Unit Review Exercise

Part I: Write whether the following statements are true or false.

1. Each individual client computer is responsible for the security of the resource 
in the client and server networks.  

2. Software cannot be shared over the network. 

3. A MAN is usually within the boundary of a private building.

4. In ring topology, each node is directly connected to many other adjacent 
neighbors.

5. WAN has fewer nodes than LAN.

Part II: Choose the correct answer among the alternatives provided.

1. Which one of the following is different from others?

A. Star

B. Ring

C. Bus

D. Peer-to-peer

2. The term WAN stands for ____________.

A. Wide Area Net

B. Wide Access Network

C. Wide Area Network

D. Wide Access Net

3. If a given two networks use separate and different protocols, which one of the 
following devices can be used to link them?

A. Repeater

B. Router
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C. Switch

D. None of the above.

4. Bluetooth is an example of _______________.

A. Personal area network

B. Local area network

C. Metropolitan area network   

D. Wide area network

5. A ____ typically connects personal computers within a very limited 
geographical area, usually within a single building.

A. LAN

B. WAN

C. MAN

D. TAN

6. Physical or logical arrangement of network is called __________.

A. topology

B. routing

C. networking

D. None of the above.

7. Which of the following topologies requires a central controller such as switch?

A. Star

B. Mesh

C. Ring

D. Bus

8. ____________ topology requires more cables than others?

A. Star

B. Mesh

C. Ring

D. Bus
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9. The network system that spans states, countries or the whole world is ________.

A. LAN

B. WAN

C. MAN

D. None of the above.

10. Network system within a building or campus is________

A. LAN

B. WAN

C. MAN

D. None of the above.

11. A network that spans across a glob is _____________.

A. World area network

B. Local area network 

C. Personalized area network 

D. None of the above.

12. In ___________ topology, if a node fails, the whole network cannot function 
entirely.

A. ring 

B. bus 

C. mesh 

D. star 

13. Which one of the following interconnecting devices accepts a weak signal, 
boosts it to its original strength and forwards to the next segment of a network?

A. Switch

B. Router

C. Repeater

D. Client 
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14. __________is used to connect one or more LANs together. 

A. Server 

B. Router

C. Repeater

D. Client

15. _____________type of network is created when two or more mobile devices 
are connected by a Bluetooth.

A. LAN

B. MAN

C. Internet 

D. PAN
[

Part III: Fill in the in the blanks.

1. Network is a group of two or more computer systems sharing _________.

2. In client-server model users are called _______________.

3. Based on size of the network, network is classified into __________,_________, 
_________ and __________.

4. ____________ is a common rule between communicating parties. 

5. The best example of wide area network is _________.

Part IV: Match the following items in column A with column B. 
   A                          B

1. Interconnection of two or more computers            A. Fiber Optic Cable

or other devices               B. Used to draw pictures

2. Set of rules to guide communications            C. Client 

3. E-Learning                D. Originator of messages

4. Sender computer               E. Server  

5. A dedicated link that every computer has to           F.Disadvantage of network

the rest of the nodes              G. Network

6. Uses switch as central device                        H. Mesh topology 
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7. Increased vulnerability     I. Application of  a network

8. Hosts and gives networked resources J. UTP cable

9. Microwave     K. Protocols

10. Uses light system to transmit signal  L. Star topology

       M. Wireless medium   

   

Part V: Provide clear and precise responses to the following questions.

1. What is a network?

2. State the criteria used to categorize networks.

3. What are wired and wireless media?

4. What is a network topology?

5. List at least three applications of a network. 
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UNIT OVERVIEW 

From your earlier grades (grade 7 and 8) lessons of computer system unit, you know 
that computer is a system that comprises hardware and software components. 
You also discussed input devices, output devices, computer memory and central 
processing units under hardware components of a computer. In addition to this, 
you also covered how to use application and system software such as operating 
system, utility software and driver software. 

In this unit, you will enhance your skills of using application software such 
as word processor, spreadsheet and presentation software. You will also practice 
different Microsoft Office Suite applications or any other free application soft-
ware such as LibreOffice.

At the end of this unit, learners will be able to:

 � Indent a paragraph.

 � Align text by using icons on the menu bar and selecting paragraph from 
formatting menu.

 � Apply bullets and numbers in text.

 � Insert and delete page break and page number in a document.

 � Add and delete headers and footers in a document

 � Manipulate data in spread sheet.

 � Create a presentation in PowerPoint

UNIT 

APPLICATION SOFTWARE

UNIT OUTCOMES

3
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3.1 Using Application Software 

 
 Brainstorming 

1. What makes application software different from system software?

2. Which application software had you used in your grade 8 ICT subject?

3. Do you get word editors, spreadsheet and presentation application on 
smartphones or tablets?

The software used by general public users in their daily tasks most often is 
application software. Some examples of application software are:

 � Word processing software

 � Presentation software

 � Spreadsheet software

Application software may consist of a single program, such as Microsoft Notepad, 
for writing and editing simple text. It may also consist of a collection of programs 
called a software package, which work together to accomplish a task. Application 
software may also include a larger collection of programs (a software suite), 
related but independent programs, which have a common user interface such as 
Microsoft Office Suite.

3.2 Word Processing 

Word Processing refers to the act of using a computer to create, edit, save and 
print documents including, but not limited to, textual reports, letters, memos, 
newsletters and brochures. In order to perform word processing, specialized   

 
 Brainstorming 

1. What word processing application software had you used in your grade 8 
IT subject?

2. What different mobile apps have you used recently? 
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software (known as a Word Processor) is needed. One example of a Word 
Processor is Microsoft Word; other word processing applications are also widely 
used. Other examples of word processing applications include Microsoft Word 
Processor, WordPerfect and other free and open-source word processers such as 
OpenOffice Writer, LibreOffice and Google Drive Document. 
 

                  Figure 3.1 Word processing   

         

Some of the functions of word processing software include:

 � Creating, editing, saving and printing documents.

 � Copying, pasting, moving and deleting text within a document.

 � Formatting text such as font type, bolding, underlining or italicizing.

 � Creating and editing tables.

 � Inserting elements such as illustrations and photographs from other 
software.
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 � Correcting spelling and grammar.

 � Providing different templates for repetitive tasks. 

Tip
Text editors such as Notepad, which only work on plain text with no formatting, 
should not be confused with word processing software. Text editors are used to 
work with files in plain text format such as source code of computer programs 
and configuration files of an operating system.

3.2.1 Starting Microsoft Office Word Program in Windows

To start Microsoft Office 2016 or later program in Windows 10 or later, you can 
follow either of the following methods. 
Method 1 

Figure 3.2  Click on Blank document

Click the Start button on the Windows taskbar  A pop-up menu appears  
Click the tile that represents Microsoft Word 2016 or later version  Click on a 
Blank document and blank document will appear (See Figure 3.2).
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Method 2
Click the start button on the window taskbar  Type Word (See Figure 3.3  
Click to Word icon to open new blank document.

                                

Figure 3.3 Open Word 2016 by searching

3.2.2 A tour of the Word user interface

Figure 3.4 New word document and its interface element

The following table describes the common interface elements of Microsoft Word 
2016. 
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Table 3.1 Word 2016 interface elements descriptions

No Interface Part Name Description

1 Title Bar

Displays the file name of the document that is 
being edited and the name of the software you are 
using. It also includes the standard   Minimize, 
Restore and Close buttons.

2 Quick Access Toolbar

Commands that are frequently used such 
as Save, Undo and Redo are located here at the 
end of the Quick Access. Toolbar is a pull-down 
menu where you can add other commonly used 
or commonly needed commands.

3 File Tab

Click this button to find commands that act on 
the document itself rather than the content of 
the document such as New, Open, Save as, Print 
and Close.

4 Ribbon

Commands needed for your work are located 
here. The appearance of the Ribbon will change 
depending on the size of your monitor. Word 
will compress the ribbon by changing the 
arrangement of the controls to accommodate 
smaller monitors.

5 Edit Window Shows the contents of the document you are 
editing. 

6 Scroll Bar Lets you change the display position of the 
document you are editing.

7 Status Bar Displays information about the document you 
are editing.

8 Zoom Slide Control Lets you change the zoom settings of the 
document you are editing.

9 Insertion Point/Cursor It is the blinking line in your document that 
indicates where text is inserted when you type. 
There are several ways to move an insertion 
point. 

10 I-beam Pointer The I-beam [I] shows where your mouse pointer 
is. 
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3.2.3 Paragraph Formatting 

 
 Brainstorming
When we write a letter or a passage in our English or local language, how do 
we organize our ideas?  Discuss the relationships between words, phrases, 
sentences, paragraphs and passages.

A paragraph is a collection of words, numbers or any combination of them. It is 
organized in a section that describes a particular idea or point. 
Formatting a paragraph can be a little combination of different commands. These 
include:

 � Indention 

 � Alignments

 � Bulleting and Numbering 

 � Line and Paragraph Spacing. 

To format a paragraph, you can use different commands such as different text 
alignments, bullets, numbering, multi-level list, paragraph indents, sorting text, 
line spacing, shading and different borders. To format a paragraph, follow the 
steps shown in Figure 3.5 below. 

  

Figure 3.5 Paragraph formatting commands 

Commands of paragraph formatting group in MS-Word are explained in detail 
in Table 3.2 below.
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Table 3.2 Paragraph formatting group commands and their descriptions

Letter   Button  Functions 
Keyboard 
shortcut 

key
 A Bullets To start text/Line/

Paragraph with a bulleted 
list, you can choose 
different bullet styles by 
clicking the drop-down 
arrow of the Bulleted List. 

 B Numbering 
 

To start text/line/Paragraph 
with a   Numbered list, 
you can choose diffeent 
Number styles by clicking 
the drop down-arrow of 
the Numbered List. 

 

 C Multilevel List 
 

To start text/line/Paragraph 
with amultilevel list, you 
can choose multi- level list 
styles by clicking the drop-
down arrow. 

 

 D Left Align-
ment  

Aligns text to the Left of 
the page to  format a para-
graph. 

 Ctrl + L

 E Center Align-
ment   

Aligns text to the center of 
the page(for paragraph for-
matting). 

 Ctrl + E

 F Right Align-
ment  

Aligns text to the right of 
the page. 

 Ctrl + R

 G Justification 
 

Aligns text to both the 
right and the left margins 
of the page by adding the 
extra space between words 
for the clean look in a word 
document. 

 Ctrl + J

 H Decrease       
Indent  

Decrease indent means 
decreasing the gap between 
the left margin and left 
of the paragraph in the 
document (for paragraph 
formatting).  
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 I Increase In-
dent  

Increase indent means 
increasing the gap between 
the left margin and left 
of the paragraph in the 
document (for formatting 
the paragraph). 

 

 J Sort 
 

In this, you can arrange the 
selected text in ascending 
or descending order.

 

 K Show or Hide 
Paragraph 
Marks 

 
Paragraph Marks are 
useful and show the marks 
when you apply section or 
page breaks. 

 Ctrl + *

 L Line and para-
graph Spacing  

Increases or decreases 
the space between the 
lines or paragraphs in the 
document. 

 

 M Shading 
 

Coloring the background 
of a line from the left 
margin to the right margin.

 

 N Border 
 

You can apply different 
borders to the selected text 
in the word document. 

 

a. Setting Indents
Indentation means how far you want to move the paragraph away from the left 
or the right margin. Look through your grade textbooks to see different types of 
indentation used. In Microsoft Word, there are four methods to do paragraph 
indentation:

 � The Tab Key method

 � The Ruler method

 � The Indent Command method

 � The Paragraph Dialog Box method 
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The Tab Key Method

If you want to indent existing paragraphs, the quickest method is the Tab key. To 
indent a single paragraph using Tab key method, follow the steps below. 

1. Open Microsoft Word application and write two paragraphs which describe 
Grand Ethiopians Renaissance Dam, as shown below.

     The Grand Ethiopian Renaissance Dam (GERD)

The Grand Ethiopian Renaissance Dam (GERD), formerly 
known as the Millennium Dam, is under construction on Blue 
Nile River in the Benishangul-Gumuz region of Ethiopia, which 
is located about 40km east of Sudan. The project is owned by 
Ethiopian Electric Power Corporation (EEPC).
The dam will be capable of handling a flood of 19,370 cubic 
meters per second, reducing alluvium in Sudan by 100 million 
cubic meters and facilitating irrigation of around 500,000ha of 
new agricultural lands. It will also reduce approximately 40km 
of flooding in Sudan, upon its completion.

2. Insert your cursor at the start of the paragraph.

3. Press the Tab key on your keyboard.

What changes have you observed in the first paragraph? Is it indented?

The Ruler Method

If you want to indent all existing paragraphs, the quickest method is the ruler 
method. Follow the steps below to use it.  

1. If your ruler is already visible, skip to step 4.

2. Select the View tab in the ribbon.

Figure 3.6 Word view tab

3. Select Ruler in the Show group.
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  Figure 3.7  Ruler option

Word provides indent markers that allow you to indent paragraphs to the location 
you want. The indent markers are located to the left of the horizontal ruler, and 
they provide several indenting options shown and described in Figure 3.8 and 
Table 3.3 below.

            Figure 3.8  Ruler indenting options

Table 3.3 Ruler indenting markers and their descriptions

Ruler Indenting Option Picture Usage

First-line indent marker Adjusts the first-line indent

Hanging indent marker   Adjusts the hanging indent

Left indent marker   Moves both the first-line indent 
and hanging indent markers at the 
same time (this will indent all lines 
in a paragraph)
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4. Select All Paragraph you want to indent. In our example, select both 
paragraphs.

Tip:
To select all paragraphs in a word document, you can use Ctrl + A key board 
short cut keys.

5. Click and drag the desired indent marker. In the example below (See Figure 
3.9), first-line indent marker or top ruler marker is moved to the right. 

6. Release the mouse. The paragraphs will be indented.

               Figure 3.9 Using first line indent

The Indent Commands Method

If you want to indent multiple lines of a text or all lines of a paragraph, you can 
use the Indent commands. The Indent commands will adjust the indent by ½ 
inch increment. To indent a paragraph or a text using indent commands method, 
follow the steps listed hereunder. 

1. Select the text you want to indent.

2. On the Home tab, click the Increase Indent or Decrease Indent command.



Grade 9 Information Technology Student’s Textbook 

   83

            Figure 3.10  Indent command

3. The text will be indented.

To customize the indent amounts, select the Layout tab near the desired values in 
the boxes under Indent (See Figure 3.11).

Figure 3.11 Customize indentation amount

Increase or Decrease the Left Indention in a Word: 
How far you want to move the paragraph away from the left margin 
is called Increase Left indention.
Increase or Decrease the Right Indention in a Word:
How far you want to move the paragraph away from the right margin 
is called Increase Right indention.              

I
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The Paragraph Dialog Box Method

To indent a paragraph or a text using paragraph dialog box method, uses the 
following steps. 

1. Select the Home tab in the ribbon.

2. Select all the paragraphs in the document you want to indent.

3. Select the Paragraph group’s dialog box launcher (See Figure 3.12).

                   Figure 3.12 Paragraph group dialog box launcher

Make any adjustments to alignment or line spacing in Paragraph group dialog 
box (See Figure 3.13).

        Figure 3.13 Paragraph group dialog box

4. Select the OK button to save your selection(s) and close the Paragraph dialog 
box.
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Practical Exercise 3.1

Indenting a Paragraph
Write a paragraph entitled “The effects of trafficking on children” and use one 
of the above methods to indent it. 

b. Text Alignment 
Alignment determines the appearance and orientation of the edges of the 
paragraph (i.e. left-alignment, right-alignment, centered or justified text). 

The paragraph section offers four buttons for controlling the horizontal 
alignment of a paragraph (See Figure 3.5 above). To alter the paragraph alignments, 
simply put the cursor anywhere in the paragraph and click one of these buttons. 

Left-aligned Text

Left-aligned paragraph’s text is aligned evenly along the left margin. Most of 
the time, this alignment of paragraph will create “jagged” space on the right of 
the paragraph (See Figure 3.14). The following steps show you how to create left 
aligned text. 

1. Select the text that you want to align. In our example, select the two 
paragraphs (See Figure 3.14).

2. On the Home tab, in the Paragraph group, click Align Left or press Ctrl + L.

         Figure 3.14 Left-aligned paragraph
[
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Right-aligned Text

Right alignment is exactly the mirror of the left alignment. Word will line up the 
last character of the last word of each line against the right page margin.

Practical Exercise 3.2

Aligning the Text to Left or Right
Use the “Grand Ethiopian Renaissance Dam” document you created above and 
track the following steps to create left-aligned text.

1. Select the text that you want to align. In our example, select the two para-
graphs. 

2. On the Home tab, in the Paragraph group, click Align Right or press            
Ctrl + R.

Center-aligned Text 

Centre alignment aims to make equal spaces between the left and right page 
margins. Therefore, the line of text will be at the relative center of the page. The use 
of center alignment is for titles and headings, not often used for large paragraphs. 

Justified Alignment

Justified alignment creates justified text by adjusting the space between each 
word until all lines within a paragraph are equal in length. Unlike left or right 
alignment, justified alignment removes the jagged appearance. 

Practical Exercise 3.3

Creating Center-aligned and Justified Texts 
Use the “Grand Ethiopian Renaissance Dam” document you created above and 
follow the steps listed below to create centered and justified text.  

1. Click anywhere on the paragraph you want to align and click the Center 
button available on the Home tab or simply press the Ctrl + E keys. In our 
example, we click the title of the document and press Center button from 
paragraph command (See Figure 3.15).

2. On the Home tab, in the Paragraph group, click Justify.
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Figure 3.15 Center-aligned and justified text

c. Manipulating Lists
In Word, there are two types of lists: bulleted and numbered lists. Bulleted and 
numbered lists can be used in your documents to outline, arrange and emphasize 
text. In this section, inserting new bulleted and numbered lists are discussed. To 
insert bulleted and numbered list in a document, follow the steps stated below. 

1. Open Microsoft word and type 12 Principles of Business Ethics as shown 
in Figure 3.16.

2. Select the text you want to format as a list (See Figure 3.16).

            Figure 3.16 Select lists to be bulleted  
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3. On the Home tab, click the drop-down arrow next to the Bullets command. 
A menu of bullet styles will appear.

Figure 3.17  Bullets command

4. Move the mouse over various bullet styles. A live preview of the bullet style 
will appear in the document. Select the bullet style you want to use (See 
Figure 3.18).

          

  Figure 3.18 Select various bullet styles

5. The text will be formatted as a bulleted list (See Figure 3.19).
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                 Figure 3.19 Text formatted with bulleted list

To remove numbers or bullets from a list, select the list and click the 
Bulleted or Numbered list command.
When you are editing a list, you can press Enter to start a new line, 
and the new line will automatically have a bullet or number. When 
you have reached the end of your list, press Enter twice to return to 
normal formatting.
By dragging the indent markers on the Ruler, you can customize the 
indention of your list and the distance between the text and the bullet 
or number (See Figure 3.20).
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Figure 3.20 Adjusting the indentation of bulleted list

Creating a Numbered List

When you need to organize text into a numbered list, Word offers several 
numbering options. You can format your list with numbers, letters or Roman 
numerals, as shown in Figure 3.18 below. To create a numbered list, keep the 
following steps.

1. Select the text you want to format as a list. In our example, select 12 Principles 
of Business Ethics in the above document.

2. Move the mouse over various numbering styles. A live preview of the 
numbering style will appear in the document. Select the numbering style 
you want to use (See Figure 3.21).
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               Figure 3.21 Numbering command options

3. The text will be formatted as a numbered list (See Figure 3.22).

         

                  Figure 3.22 Numbered list
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If you want to restart the numbering of a list, right click on number 
list and choose restart option. It can be applied also to numeric and 
alphabetical lists.

Creating Multilevel Lists

In the above section, we created numbered and bulleted list that have the same 
level. Multilevel lists allow you to create lists or outlines with multiple levels. 
Any bulleted or numbered list can be turned into a multilevel list by using the Tab 
key. Keep the following steps to create a multilevel list. 

1. Open Microsoft Word and type the following list which describes 
classifications of computer system.

                

Figure 3.23 Multilevel list text

2. Select input devices, output devices and central processing unit text from the 
paragraph together and increase the indent by one level by pressing Tab key. 
It will look like the following (See Figure 3.24).
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      Figure 3.24 Indent a selected paragraph by one level pressing Tab key

3. Select Arithmetic Logic unit, control unit and register text and increase 
indent by two levels pressing the Tab key two times. It will look like the 
following (See Figure 3.25).

    

Figure 3.25 Indent a selected paragraph by two levels pressing Tab key twice
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4. Place the insertion point at the beginning of the Memory text line and increase 
the indentation by one level pressing Tab key (See Figure 3.26).

5. Select Internal Memory and External Memory text and increase the 
indentation by two levels pressing Tab key twice (See Figure 326).

6. Select Application Software and System Software text and increase the 
indentation by one level pressing Tab key (See Figure 3.26).

7. Select System Development Software and System Management Software 
text and increase the indentation by two levels pressing Tab key twice (See 
Figure 3.26).

Figure 3.26 Creating multilevel list

Tip
To decrease the indention level, place the insertion point at the beginning of the 
line; then hold the Shift key and press the Tab key.
You can also increase or decrease the levels of text by placing the insertion 
point anywhere in the line and clicking the Increase Indent or Decrease Indent 
command.
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Figure 3.27 Create multilevel text using paragraph commands

When formatting a multilevel list, Word will use the default bullet style. To 
change the style of a multilevel list, select the list, and then click the multilevel list 
command on the Home tab (See Figure 3.28).

                           

                       Figure 3.28 Change multilevel list style

Practical Exercise 3.4

Creating Multilevel Lists  
Form a group of two to three students and open word processor and create the 
following multilevel list as shown below. 
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d. Line and Paragraph Spacing
The space between lines and paragraphs can be increased or decreased in 
Microsoft Word document using line and paragraph Spacing command. In 
Microsoft Word document, the default space between the lines is 1.15”. Similarly, 
the space between the paragraphs is 8 points. To format line and paragraph 
spacing, perform the following steps.

1. Open Microsoft Word and type the following two paragraphs taken from 
the paper “The Potential of Dagu Communication in Northeastern Ethiopia 
by Gulilat Menbere and Terje S. Skjerdal, Research Gate, January 2008” (See 
Figure 3.29).

  Figure 3.29 Line and paragraph formatting

Inventory 

1. Office
a) Desk

i). Top drawer
(1). Pencils 
(2). Stapler
(3). Ruler

ii). Middle drawer
(1). Paper
(2). Tax forms 

b) Filing cabinet 
2. Laboratory equipment
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2. To format line spacing of the above paragraphs, select both paragraphs. 

3. On the Home tab, click the Line and Paragraph Spacing command, and then 
select the desired line spacing, say 2.0 (See Figure 3.30).

     Figure 3.30 Select line spacing

4. The line spacing will change in the document (See Figure 3.30).Just as you 
can format spacing between lines in your document, you can adjust spacing 
before and after paragraphs. This is useful for separating paragraphs, 
headings and subheadings.

5. To format the paragraphs, select both paragraphs. 

6. On the Home tab, click the Line and Paragraph Spacing command. Click Add 
Space Before Paragraph or Remove Space After Paragraph from the drop-
down menu. In our example, we will select Add Space Before Paragraph 
(See Figure 3.31).
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           Figure 3.31 Select Add Space before Paragraph

7. The paragraph spacing will change in the document (See Figure 3.31 above).
From the drop-down menu, you can also select Line Spacing Options to 
open the Paragraph dialog box. From here, you can control how much space 
there should be before and after paragraphs.

Figure 3.32 Paragraph spacing using Paragraph dialog box
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3.2.4 Inserting and Deleting a Page Break in a Document

A page break is the location in a document where one page ends and a new page 
begins. When we are working on multiple pages, word automatically starts a new 
page in long documents when the text reaches the bottom of the page. In some 
cases, for example, some statements which are part of a paragraph can extend to 
the next page which makes it uncomfortable to read. 

You can let Word determine where the break will occur, and you can also 
decide where to insert a manual page break or set specific options for those page 
breaks. Manual page breaks display as a single dotted line when the Word’s Page 
Break appears in the center when you enable the Show/Hide button (as shown in 
Figure 3.35). In Print Layout view, Word displays a document page-by-page, one 
after the other. In this section, you will learn how to insert and remove a manual 
page break. The Breaks menu contains options for inserting three types of breaks:

 � Page Inserts: Inserts a manual page break where one page ends and the 
new page begins.

 � Column: Inserts a manual column break where a text will begin in the 
next column after the column break.

 � Text Wrapping: Separates the text around objects on a web page, such as 
caption text from body text.

To insert and delete a page break in a document, keep the following steps.

1. Write the following document, which has a paragraph description for a 
picture in page 7 and a picture in another page (page 8) of the document, 
due to Word’s automatic break (See Figure 3.33). So, we need to make the 
description paragraph along with the picture in the same page (page 8) 
manually by breaking the page. It is possible to just press Enter until that 
text reaches the top of page eight, but it could easily be shifted around when 
we added or deleted something in another part of the document. Instead, we 
will insert a page break.
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       Figure 3.33 Page break

2. Place the insertion point where you want to create the page break. In our 
example, we will place it at the beginning of the paragraph which describes 
the picture (See Figure 3.35).

3. On the Insert tab, click the Page Break command (See Figure 3.34). 
Alternatively, you can press Ctrl + Enter on your keyboard.

  

        Figure 3.34 Selecting the Page Break command on the Insert tab
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4. The page break will be inserted into the document, and the text will move to 
the next page (See Figure 3.35).

5. By default, breaks are invisible. If you want to see the breaks in your 
document, click the Show/Hide command on the Home tab.

       Figure 3.35 Using the Show/Hide command on the Home tab

To delete a page break, follow the steps stated below.

1. If you want to delete a page break, you will first need to` show the break in 
your document as in in step 4 above (See Figure 3.35).

2. Locate the page break you want to delete, and then place the insertion point 
at the beginning of the break.

3. Press the Delete key. The break will be deleted from the document.

3.2.5 Insert and Delete Page Number in Document

To identify different pages in Word document, page number is used.  Page number 
is used in Word document to automatically number each page. In Microsoft Word, 
there are a wide range of page number formats and they can be customized to 
suit your needs. Page numbers are usually placed in the header, footer or side 
margins. When you need to number some pages differently, Word allows you to 
restart page numbering.
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Adding Page Numbers in Word Document 

To insert a page number in a Word document, follow the following steps.

1. Create a multiple pages document in Word; it can be a blank document. 

2. On the Insert tab, click the Page Number command (See Figure 3.36).

                 Figure 3.36 The Page Number command on the Insert tab

3. Open the Top of Page, Bottom of Page or Page Margins menu, depending 
on where you want the page number to be positioned, and then select the 
desired style of header. In our example, we select Bottom of the Page. (See 
Figure 3.37).

4. Select a header style.

5. Page numbering will appear.
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      Figure 3.37 Page numbering in the Footer

6. Press the Esc key to lock the header and footer.

7. If you need to make any changes to your page numbers, simply double-click 
the header or footer to unlock it. In our example, double click the footer. 

3.2.6 Adding and Deleting Headers and Footers in Document

A header appears at the top of a document page, and the footer appears at the 
bottom. Headers and footers generally contain additional information such as 
page numbers, dates, author’s name and footnotes, which can help you keep 
longer documents organized and make them easier to read. The text entered in 
the header or footer will appear on each page of the document. To add and delete 
headers and footers in a document, use the document created in Figure 3.38 and 
follow the following steps. 
In this example, the title of the paper is required to be displayed at the top of each 
page by placing it on the header. 

1. Double-click anywhere at the top or bottom margin of your document. In 
our example, we will double-click the top margin (See Figure 3.38).



Unit 3 : Application Software

104 

       Figure 3.38 Double-clicking on the header

2. The header or footer will open, and the insertion point will appear in the 
header or footer.

       Figure 3.39 Opening header

3. Type the desired information into the header or the footer. In our example, 
we will type the paper’s title and date.
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           Figure 3.40 Typing text into a header

4. When you have finished, click Close Header and Footer. Alternatively, you 
can press the Esc key.

5. The header or footer of the text will appear (See Figure 3.40).

                

Figure 3.41 The finished header

Notice that the header appears in all pages of the document with all color 
differences from the paragraph.
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a. Inserting Preset Header or Footer
Word has a variety of preset headers and footers you can use to enhance your 
document’s design and layout. In our example, we will add a preset header to 
our document.

1. Select the Insert tab, and then click the Header or Footer command. In our 
example, we will click the Header command.

2. In the menu that appears, select the desired preset header or footer.

     Figure 3.42 Select preset header

3. The header or the footer will appear. Many preset headers and footers 
contain text placeholders called Content Control fields. These fields are good 
for adding information like the document’s title, author’s name, date and 
page number.

4. To edit a Content Control field, click it and type the desired information (See 
Figure 3.42).
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      Figure 3.43 Finished header using preset header            

5. When you have finished, click Close Header and Footer. You can also press 
the Esc key.

b. Editing Headers and Footers
After you close the header or footer, it will still be visible, but it will be locked. 
Simply double-click a header or footer to unlock it, which will allow you to edit it.

c. Removing Header and Footer
If you want to remove all information contained in the header, click the Header 
command and select Remove Header from the menu that appears. Similarly, you 
can remove the footer using the Footer command.
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            Figure 3.44 Removing header      
    

Practical Exercise 3.5

Prepare a document for IT note on Introduction to Computer for grade 7 students 
or use the document created in practical Exercise 3.1 of this textbook about Effects 
of Trafficking on Child document. Then follow the instruction to manipulate the 
paragraph using the techniques you learned in the above sections.

1. Change all titles’ text alignment to centre.

2.  Apply Roman number format for all lists (small).

3.  Make line spacing 1.5”.

4.  Use page break to sort all parts of the paragraph together in one page that 
makes it comfortable to read 

5.  Justify the paragraph.

6.  Change the typeface of the entire document to Arial 12 point.

7.  Add a page number (Arabic number).

8.  Set the header a title of the document, for example Effects of Child Trafficking 
on Children or Introduction to Computer Note for Grade 7 Students.
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9. Set the footer as Prepared by Grade 9 Students for your document. 

10. Create a folder on the Documents called Word Project and save the 
document as Child Trafficking.docx or Introduction to Computer Note.docx in 
the folder you created.

KEY CONCEPTS

 � Paragraph formatting is a modification of the paragraph so that it will appear 
readable for the reader. This includes indention, alignments, bulleting and 
numbering, and line and paragraph spacing.

 � Indentation is how far you want to move the paragraph away from the left 
or the right margin. There are four methods for doing indentations: Tab key 
method, Ruler method, Indent Command method and Paragraph Dialog 
Box method 

 �  Alignment is orientation of a text and a paragraph which is aligned evenly 
along the left and right margins. Alignments can be left, right, center and 
justify. 

 �  Bulleting and numbering is used to outline, arrange and emphasize texts.

 � Line and paragraph spacing options allows you to control how much space 
should be between lines and paragraphs in Word.

 � A page break is the location where a new page begins. It can be either 
automatic or manual.

   

3.3 Manipulating Data in Spreadsheet 

 
 Brainstorming 

1.  Have you ever process tabular data? What do you use to process this kind of data?

2. What is the use of spreadsheet software? Can you mention some of 
proprietary and free spreadsheet software? 

3. What is the difference between word processing and spreadsheet software? 
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Spreadsheet software is application software capable of organizing, storing and 
analyzing data in tabular form. An example of spreadsheet software is Excel. As 
you have learned in grades 7 and 8, Microsoft Office Excel provides powerful 
tools that enable users to organize, analyze, manage and share information easily.

One of the most powerful features of Excel is its ability to calculate numerical 
information using formulas. Excel can add, subtract, multiply and divide. In this 
section, we see how to use cell references to create simple formulas.

3.3.1 Using Mathematical Operators

Excel uses standard operators, such as a plus sign for addition (+), a minus sign 
for subtraction (-), an asterisk for multiplication (*), a forward slash for division 
(/) and a caret (^) for exponents, for formulas.

Table 3.4  Mathematical operators of Excel

Arithmetic Operator Meaning Example

+ (plus sign) Addition =3+3

– (minus sign) Subtraction =3–3

* (asterisk) Multiplication =3*3

/ (forward slash) Division =3/3

% (percent sign) Percent 30%

^ (caret) Exponentiation =3^3

When you enter a formula in a cell, the formula is stored internally and the results 
are displayed in the cell. You can view the underlying formula in the formula bar 
when the cell is active, when you double-click the cell to edit it or when you use 
the Formulas tab.

To allow Excel to distinguish formulas from data, all formulas should begin 
with an equal sign (=). To display formula in Excel, follow the following steps.

1. Launch Microsoft Excel and then open a new blank workbook.

2. Click cell A1.

3. Type =5+3*3/2-4 and press Enter. You just entered a formula.

Take note that formulas should be typed without spaces, but if you type spaces, 
Excel eliminates them when you press Enter.
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Figure 3.45 Viewing formula in the formula bar

4. Click cell A1. Notice that the result of the formula displays in the cell, but the 
formula appears only in the formula bar (See Figure 3.45).

5. Double-click cell A1. The formula appears in both active cell and the formula 
bar. You can edit the formula in this mode.

6. Press Enter.

7. On the Formulas tab, in the Formula Auditing group, click Show Formulas. 
The formula in cell A1 displays.

While you are displaying formulas in the worksheet, you will not see 
the results of those formulas.

8. Click Show Formulas again to turn off formula display.

9. Save the workbook.
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3.3.2 Using Cell References in Formulas

A cell reference identifies a cell’s location in the worksheet, based on its column 
letter and row number. Each cell in an Excel worksheet has a unique identifier 
indicating its column and row, for example A1 (refers to Column A, Row 1) and 
E4 (refers to Column E, Row 4). When you create a formula, you can reference a 
cell’s identifier rather than typing the number that appears in that cell. Using a 
cell reference, rather than the data displayed in a cell, gives you more flexibility in 
your worksheet. Using cell references will ensure that your formulas are always 
accurate because you can change the value of referenced cells without having to 
rewrite the formula. For example, if the cell E1 contains the number 10 and if 10 
is changed to 18 later, any formula that references cell E1 updates automatically. 
The same principle applies to a cell that contains a formula and is referenced in 
another formula.

3.3.3 Using Relative Cell References in Formula

A relative cell reference is the one that adjusts the cell identifier automatically 
when you insert or delete columns or rows or copy the formula to another cell. A 
relative cell reference is, therefore, one whose references change “relative” to the 
location where it is copied or moved.

You can use either uppercase or lowercase when you type a cell refer-
ence in a formula. For example, it does not matter whether you type 
B4 or b4 in the formula you enter. Excel changes the reference to up-
percase when you press Enter.

To use relative cell references in formulas, follow the following steps.

1. Launch Microsoft Excel and type 5 students’ IT subject marks on a new work 
book, as shown in Figure 3.47. 

2. In order to calculate the total marks (out of 100 %) of Individual Assignment, 
Mid Exam, Projects and Final Exam for each student, click on cell that will 
contain formula. In our example, click F2. 

3. Type equal (= ) sign to start the formula; notice how it appears in both the 
cell and the formula bar. 
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4. Instead of typing = 10.5 + 15 + 23.5 to calculate total marks for student 1, type 
the cell address of the cell you want to reference first in the formula, cell B2 
in our example which contains the value 10.5. A blue border will appear 
around the referenced cell.

Tip
An alternate way to use a cell reference is to click the cell being referenced while 
creating or modifying a formula. For example, instead of typing B and 2 from the 
keyboard, you can click on B2 cell, and then B2 cell reference is added into the 
formula. This method is usually quicker and eliminates the possibility of typing 
an incorrect cell identifier, especially if you need to create a formula with many 
cell references.

5. Type the mathematical operator you want to use. In our example, we will 
type the addition sign (+) (See Figure 3.47).

6. Type or select the cell address of the cell you want to reference second in 
the formula, cell C2 in our example. A red border will appear around the 
referenced cell. (See Figure 3.48).

7. Type the mathematical operator you want to use. In our example, we will 
type the addition sign (+) (See Figure 3.47).

8. Type or select the cell address of the cell you want to reference third in the 
formula, cell D2 in our example. 

9. Repeat steps 7 and 8, but for E2 cell reference (See Figure 3.47).

10. Press Enter on your keyboard. The formula calculates and the value will be 
displayed in the cell. If you select the cell again, notice that the cell displays 
the result while the formula bar displays the formula.
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      Figure 3.46  Using cell reference in formula

3.3.4 Copying Formulas with the Fill Handle

Formulas can also be copied to adjacent cells with the fill handle, which can save 
a lot of time and effort if you need to perform the same calculation multiple times 
in a worksheet. The fill handle is the small square at the bottom-right corner of the 
selected cell(s) (See Figure 3.48).
Use the following steps to copy formulas.

1. To do the same for Student 2, select the cell containing the formula you want 
to copy, in our example F2, then click and drag the fill handle over the cells 
you want to fill (See Figure 3.48).
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Figure 3.47 Press enter to complete the formula and display the result

2. After you release the mouse, the formula will be copied to the selected cells 
(See Figure 3.48).

3. Save the workbook in your Excel folder as G9 IT Students’ Mark Sheet.

Tip
Instead of dragging the fill handle over the cells you want to fill, you can double 
click the fill handle and the formula copied over the cell you want to fill.

Figure 3.48 Copying the formula into the selected cells
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To edit the formula, double-click the cell to view and edit the formula directly 
within the cell. Notice that, by default, new formulas in Excel use relative 
references, i.e. in cell F3 it will be =B3 + C3 + D3 + E3 and in F4, the formula 
becomes =B4 + C4 + D4 + E4. It continues like this until F6. You can see the formula 
in formula bar (See Figure 3.49 below).

Figure 3.49 Relative cell reference of copied formula

3.3.5 Using Absolute Cell References in Formula

An absolute cell reference is a cell reference in a spreadsheet application that 
remains constant even if the reference is copied or moved to another cell or sheet.

Sometimes you do not want a cell reference to change when you move or copy 
it. To make an absolute cell reference, use the dollar sign ($) before the column 
and row of the cell you want to reference.
Tip 
Press F4 for making cell reference absolute, after selecting it.

To use absolute cell references in formula, use the above created work book saved 
as G9 IT Students’ Mark Sheet and follow the steps below.
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1. Open G9 IT Students’ Mark Sheet that you created as Figure 3.50 above.

2. Assume we need to add a common bonus mark for all students. In our 
example, we add B9 to the total mark. The formula is updated to =B2 + C2 + 
D2 + E2 + B9 (See Figure 3.51).

3. We need to make B9 absolute reference, since it is the same for all students 
and should not be changed as we copy the formula to the other student. To 
make it absolute, you can press F4 after selecting it or type dollar sign ($) 
before B and 9 (See Figure 3.51).

Figure 3.50 Using absolute reference         

4. Press Enter. The formula in cell F2 now uses an absolute cell reference to cell 
F9.

5. Copy the formula to another cell by selecting the F2 cell containing the 
formula and drag the fill handle over the cells (See Figure 3.52).
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Figure 3.51 Copying absolute formula

6. Make sure that the relative cells are changed on cells F3, F4, F5 and F6 
according to the location while B9 is common for all formulas (See Figure 
3.53).

Figure 3.52 Unchanged cell reference 
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Practical Exercise 3.6

Read the following case carefully and answer the questions that follow it.
Student Ebsa is a grade 9 student. His mother ordered him to buy 1 kilo potato, ½ 
kilo sugar, 1 kilo onion, ½ kilo banana, ¼ kilo coffee bean and ½ kilo salt from a 
small local market, called gulit, found around his village. The price information 
is provided in the following Excel sheet (See Table 3.5 below). We want to create 
a formula that will multiply each item’s price by the quantity. 

1. Create a single formula that calculates the total price for each item in cell 
E3, and then copy it to the other rows. 

2. In response to question number 1 above, we calculated total price in column 
E without tax. Now we will use 15% sales tax rate in cell G1 to calculate the 
sales tax for all items in column F (See Table 3.6). Create a formula that will 
calculate sales tax for all items in column F, and then copy it to the other 
rows.

(Hint: You need to use the absolute cell reference $G$1 in your formula. 
Because each formula is using the same tax rate, we want that reference 
to remain constant when the formula is copied and filled to other cells in 
column F). 

3. Create the formula in G3 to calculate the net price by adding total price and 
sales tax for each item and copy it to the other rows. 

4. Finally, calculate the grand total that sums up all net prices in cell G9 so 
that student Ebsa will pay.

Table 3.5 Using relative cell reference for calculating total price
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Table 3.6 Calculating tax and net price

KEY CONCEPTS

1. Spreadsheet software is application software that is capable of managing 
tabular data.

2. Excel is one of spreadsheet software. 

3. Excel sheet is arranged in rows and columns. 

4. In Excel, all formulas start with equal (=) sign.

5. Cell reference identifies cell’s location and values.

6. Cell references can be absolute and relative.

7. An absolute cell reference remains constant even if the reference is copied 
or moved to another cell or sheet.

8. Relative cell reference is the default behavior of a formula in which the 
reference changes according to the position of the cell when it is copied to 
other cell,
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3.4 Creating Presentation 
 

 Brainstorming 

1.  Have you ever presented your ideas in front of your classmates? What do 
you think a good presentation should have?

2. What is the use of presentation software? Can you mention some of propri-
etary and free presentation software? 

As you learned in Grades 7 and 8, Presentation software is a category of 
application software that is specifically designed to allow you to display slides 
using a computer during a presentation. Some of very popular presentation 
software includes Microsoft PowerPoint, Google slides, and LibreOffice Impress. 
Presentations consist of a number of individual pages or slides.  Each slide may 
contain text, graphics, sound, movies and other objects that can be freely arranged.
In this section, you will learn about the presentation environment using Microsoft 
PowerPoint. 

3.4.1 Opening PowerPoint 

The most common choices for opening a presentation after launching PowerPoint 
application are:

 � New - allows you to open a blank presentation or you may choose from 
options of Templates and Themes.

 � Open - lets you navigate to an existing file to view and/or modify a 
presentation that has already been created.

 � Recent - displays a list of your most recently created presentations and 
their file locations.

To open a PowerPoint 2016 presentation, click on the File tab in the upper left 
corner (See Figure 3.54).

Figure 3.53 Click the file tab
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To create a blank presentation, Select New, choose Blank presentation and click 
on the Create icon.

Figure 3.54 PowerPoint file menu

3.4.2 Adding PowerPoint Slides

When we click a blank presentation, PowerPoint will open a presentation with a 
Title Slide. Once the Title Slide is open, you will see a slide with Click to Add Title 
and Click to Add Subtitle placeholder text for a title and a subtitle. Click inside the 
placeholder box and the box will become empty and then start typing to add the 
title. If you want to add a subtitle, click and type inside the smaller placeholder.  

 

Figure 3.55  Blank presentation
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To add a new slide, make sure that you are on the Home tab. The New Slide 
button of the Home tab will add slides to your presentation.

Figure 3.56 PowerPoint new slide button

The New Slide button has two parts.

 � Clicking on the top part will automatically insert a new slide with default 
layout. 

 � Clicking on the bottom will give you a choice of layouts. You can choose 
which layout you want for your next slide. Select a slide layout by 
clicking on its image in the Office Theme gallery. 

Tip
To insert new slide page, you can use Ctrl + M short cut keys. 

3.4.3 Slide Layouts

The slide layout in PowerPoint is the arrangement of all the items that make up 
your slide, such as title, graphics or text boxes. There are several standard slide 
layouts to choose from when adding new slides. To change slide layout, follow 
the steps listed below. 

1. A unique layout can be chosen by clicking on the bottom half of the New 
Slide button in the Home tab. 

2. When the layout gallery opens, click on the style you want and a new slide 
with that layout will appear in your presentation. Each layout caption 
describes the layout type. Content can be texts, tables, charts, graphics, 
pictures, clip arts or videos. 

3. If you decide later that the layout you chose does not work well for a particular 
slide, select the slide by clicking on it in the Thumbnail pane. Next, click on 
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the Layout button in the Slides group of the home tab. Click on a new layout 
and it will change the layout of the slide.

 a)

 b)

Figure 3.57  a) Slide layouts    b)Slide layouts button
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3.4.4 Applying a Theme

Once a new presentation has been created, a design or a color scheme can be 
added. Remember to use color carefully to enhance your presentation, not to 
detract from it. You need to maintain good contrast between the background 
color and the text color. Consider using a light colored background and dark 
text or vice versa, but avoid busy backgrounds and primary colors. Use sans serif 
fonts like Arial, Calibri and Helvetica for titles and size them between 44 and 60 
points. Sub-headings should be between 32 to 40 points, and body text between 
18 to 32 points. Try not to use more than two fonts.

PowerPoint has many preset designs and themes including complimentary 
colors and fonts. To add a theme to a presentation, follow the steps below.

1. Go to the Design tab in the ribbon. There are several themes immediately 
available. 

2. To use one of the built-in themes, just click on its thumbnail.

a)

b)

Figure 3.58  a) Powerpoint themes   b) More PowerPoint themes
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3. On the right side of the Theme thumbnails, there is a scroll bar and an Arrow 
Down button, which will offer more designs, as seen in Figure 3.57(b) above. 
If you are online, you can get more themes from Microsoft Office Online. 

3.4.5 Changing Slide Backgrounds

If you do not want to use a theme, you can add background styles. From this 
selection, you can add some preset background styles that change according to 
the colors you have chosen.

 
      

  

Figure 3.59 a) PowerPoint background styles b) Format Background dialog box

a)

b)
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Using the Format Background feature, you can choose fill colors, gradients, 
transparencies, textures or pictures for your background. When you have desired 
background fill effect, select Close to apply it to the selected slide or choose Apply 
to All to add the background to all of the slides in the presentation. 

Designs can be added to all of the slides or to selected slides. To select multiple 
slides, click on a slide in the Thumbnail pane of the navigation bar and then hold 
down the control key and click on any other slides you want to apply the design to.

3.4.6 Formatting Bulleted Lists

In PowerPoint, you can easily modify a slide’s default bulleted list. To do this, we 
follow the steps given hereunder.

1. Click inside the text box. 

2. The Format tab will automatically be highlighted. 

3. Click on the drop down triangle next to the Bullets button in the Paragraph 
group.

4. From the Bullets and Numbering menu, you can make various changes to 
your list like:

 � The bullet size relative to the text

 � The color of the bullet

 � The shape of the bullet using either picture or character.

5. If you want to adjust line spacing between paragraphs or lists, you can do 
this through the Paragraph group tools by clicking the Line Spacing button 
and selecting Line Spacing Options.

6. Indents and Spacing controls will open in a separate dialog box.

3.4.7 Adding Content

Text is the default content of the slide below. The format for the default text is a 
bulleted list. To add text, click and begin typing. To add other content, follow the 
steps stated below.

1. Click on the icon within the content group on the new slide. 

2. Each icon will open the appropriate dialog box or task pane in the Drawing 
Tools contextual tab.
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3. Clicking on an icon will open the associated dialog box. 

Note that these icons, as well as several other insertion options, are also 
displayed in the Insert tab on the ribbon.

Figure 3.60: Add contents to blank presentation

The following icons represent the six standard graphical elements that you might 
want to insert in PowerPoint. These are: 

 � Table 

 � Chart 

 � SmartArt

 � Pictures

 � Online Pictures

 � Video 
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a. Inserting Tables in PowerPoint (PPT)

1. Set the number of columns and rows as needed in the Insert Table dialog box 
and click OK. Methods for editing the design and the layout of your table are 
located on the Table Tools contextual tab.

Figure 3.61 Insert table icon

 

Figure 3.62 Table tools

b. Inserting Charts in PPT

1. Select the type of chart you want and click OK. 

2. Once inserted into the slide, you can click on the chart to activate the Chart 
Tools contextual tab, where you will find tools for editing chart data and 
changing layouts and styles.
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Figure 3.63 Charts

c. Inserting SmartArt Graphics in PPT
SmartArt graphics are shapes that are designed to represent the relationship between 
things or people. You might use SmartArt for an organizational chart or a timeline. 
SmartArt styles and layouts can be formatted in the SmartArt Tools contextual tab. 

Figure 3.64 SmartArt graphics

d. Inserting Pictures in PPT
Rather than using too much text on your slides, consider using pictures along 
with text as a more interesting way to communicate your ideas. You can put lots 
of text into the Notes Section and refer to that as you are speaking.
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Figure 3.65 Inserting pictures from this PC                          

e. Inserting Online Pictures in PPT
Online pictures have replaced the old Clip Art. When you click on the Online 
Pictures button, you get a search box. You can type in a word or phrase and press 
enter to search for a specific image or you can click on the Bing Image Search icon 
to browse categories.

Figure 3.66 Inserting onlinie pictures                          
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f. Inserting Videos/Media in PPT
You can embed a video or link to a video from your presentation. If you want to 
limit the size of your file, you can link to a video file on your local drive or to a 
video file that you uploaded to a web site such as YouTube.
All options to insert video or audio are located on the Insert tab, in the Media 
group.

Figure 3.67 Inserting video/media
Practical Exercise 3.7

1. Prepare presentation slides using any available presentation software on 
one of the following topics for a group presentation in class.  

a. Road traffic and safety

b.  Local tourism resource

c.  Child trafficking 

d.  Consumer protection 
(Hint: You can use Internet resource, books from library, your family or any 
available resource as source of information). As a rule of thumb, you have to 
acknowledge or site the source of information in your presentation.)

2. Do the following tasks while you prepare your presentation on one of the 
above titles you selected. 

a. Change the first slide’s layout to “Title Slide Header” and the other 
slide “title and content” layout. 

b.  Insert a title and text in the first slide. 

c.  Your slide 2 should contain your presentation outline.

d.  Change the theme to Damask. 

e.  Change the background color to white (style 1).

f.  Format the bullet list as Arrow Bullets.

g. Download and insert an image that relates to your title. 

h.  Create a folder in the Documents with Presentation Project file name 
and save the presentation in the folder you created.
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3.4.8 Viewing Presentations

There are four different ways to view your presentation in PowerPoint: normal, 
slide sorter, notes page and reading views.  The views can be accessed using the 
buttons in the status bar or the View Tab on the ribbon.

Figure 3.68 View menu

 � Normal View displays a single slide as it appears in the presentation 
as well as thumbnails and an outline tab, where you can organize the 
structure. Speaker notes can be added in the bottom section of this 
window. This view is used to create and edit slides.

 � Slide Sorter View shows thumbnails of your slides. From this view you 
can reorder slides by dragging and dropping them, or you can set the 
timing for the slide show. You can also hide slides in this view. Hiding 
a slide will keep it in the file, but it will not be shown when you display 
the presentation.

 � Notes Page View allows the speaker to create notes to use during a 
presentation. Each page corresponds to one slide. These can be printed 
to assist the presenter during the presentation. Use this view when you 
are composing speaking topics.

 � Reading View/Slide Show View displays the slides as an audience will 
see them. Use the arrows and icons on the lower right side of the Status 
Bar to advance slides or switch views.

                      Use the Esc key to return to normal view.

Slide Show Tab

The Slide Show Tab allows you to review the slide show from the beginning to 
the end or from the current (active) slide. You can also control how the show will 
be presented and rehearse timings in the Set up Slide Show drop down box.
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Figure 3.69  Slide Show menu

3.4.9 Changing Order of Slides in Presentation

In the slide sorter view, click and hold down the left mouse button and drag the 
slide to a new location. You will see a line where the slide will be placed when 
you release the mouse button. This can also be done in the Thumbnail pane area 
of the Navigation bar.

Figure 3.70 Changing slide order
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Mini Project
Prepare a Presentation on Tourism Resources of Ethiopia following the instructions 
given below.

1.  Launch New Microsoft Power Point.

2.  Prepare a presentation on Tourism Resources of Ethiopia and save it in a file 
(See Figure 3.70 below).

The presentation should have the following. 

 � Slide Layout: two Contents - one content text description and the other 
picture

 � Theme: Integral

 � Background Style: Style-2

 � Bulleted List

 � Smart Art Graphics: use covert bulleted list as Vertical Bulleted List

3. Click Slide Show tab.

4. Click the left mouse button or press the spacebar/Enter key to view the next 
slide.

         All the slides in the presentation are shown in Figure 3.70.

5. Press Esc to exit the slide show.
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Figure  3.71 Sample presentation slides

KEY CONCEPTS

 � Presentation software is application software that enables you to organize 
and present information.

 � Microsoft PowerPoint is one of presentation software.

  In Microsoft PowerPoint, you can manage the layout of slide, apply theme, 
change slide background, and add tables, charts, SmartArts, pictures, online 
picturesand video contents.

3.5 Unit Summary 

In this unit, you extended your knowledge of application software usage you 
learned in grades 7 and 8. Application software is a type of software used directly 
by a user. Some of mostly used application software include Word processing, 
presentation software, spreadsheet software, desktop publishing software and 
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database management software. The main points covered under this unit are 
summarized as follows. 

 � Word processing application software is used to process, create, edit, 
format, copy, save and print document including, but not limited to, 
reports, letters, memos, newsletters and brochures. 

 � A file created using Microsoft Office Word is known as a document. 

 � Formatting a paragraph means changing the appearance of the 
paragraph, which includes indenting, setting alignment, making a 
paragraph bulleted, numbered and multilevel lists, and inserting space 
between lines and paragraphs. 

 � To format a paragraph, you can use a command found in paragraph 
section of Home tab. 

 � Page break is a location in a document where one page ends and a new 
page begins and there are two types of page break, namely manual and 
automatic. 

 � Automatic page break is done automatically by the software program 
when it reaches to the end of the page.

 � A manual page break is done when the part of a paragraph extends 
more than a page and, the document editor wants it to be in the same 
page. 

 � Page numbering is used to identify each page in a document, and a 
document can have more than one page numbering styles, especially if 
it has more than one section such as cover page, contents and body of 
the document.

 � Headers and Footers contain additional information about the document 
and they will appear by default in each of the documents at the top and 
the bottom part of a document respectively. 

 � To manipulate tabular data and calculation, the best application software 
to be used is Microsoft Office Excel. 

 � MS Excel file created for managing data in tabular form is called 
worksheet. 
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 � Excel differentiates data and formula by equal sign, i.e. if a data has 
equal sign, then the data is a formula. 

 � Excel formula can contain relative or absolute cell reference which 
identifies a cell’s location absolutely without change and relative change 
according to the locations of the formula respectively.  

 � Presentation software is a tool used to create visual presentation. 

 � A presentation package helps both the speaker and the participant with 
access to his/her ideas and visual information respectively. 

 � After launching the PowerPoint application, we can create a PowerPoint 
using new option of file tab, open option of file tab or using recent that 
displays a list of recently created presentations. 

3.6 Unit Review Exercise

Part I: Write whether the following statements are true or false.

1. Headers and footers in a document contain additional information about the 
document such as title, page number and author. 

2. Absolute cell reference cannot be copied to other cells.

3. Relative cell reference is the same as absolute cell reference when they are 
copied.

4. Slide layout is an arrangement of contents on the slide and it is possible to 
create one’s own layout. 

5. Page break is dividing a single Word document page in to multiple columns. 

6. Pressing the Enter key indents the first line of a paragraph.

7. You can use the ruler to set tabs.

8. Horizontal alignment refers to the position of text with regard to the top and 
bottom margins of a document.

9. Indents can be changed using the markers found on the ruler.

10. To allow Excel to distinguish formulas from data, all formulas begin with an 
equal sign (=).
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Part II: Choose the correct answer among the alternatives provided.

1. Which one of the following activities is formatting a paragraph?

A. Setting indents

B. Aligning texts

C. Creating bulleted lists

D. All of the above.

2. To create a new paragraph in MS Word document, which of the following 
keyboard keys can be used?

A. Tab

B. Enter

C. Alt

D. Alt+@

E. Shift

3. What is the name of the file created on MS Excel to manage data in tabular 
form by managing them into various cells?

A. Document

B. Docsheet

C. Workspace

D. Worksheet

E. Spreadsheet

4. Which keyboard keys can be used to align the text to the left side of the 
document in MS Word?

A. Alt+L

B. Alt+Spacebar

C. Ctrl+L

D. Ctrl+Spacebar

E. Tab+L
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5. Which of the following is not a view format for a PowerPoint presentation?

A. Slide View

B. Outline View

C. Slide Show View

D. Presentation View

E. All of the above.

6. Which of the following is tabular data processing software?

A. Microsoft Word

B. Microsoft Excel

C. Microsoft Internet Explorer

D. Microsoft File Explorer

7. To move the text to the left side of the page, you would use________.

A. Align left

B. Align over one space

C. Align right

D. Align top

8.  ____________ is an area in the bottom margin of each page in a document 
where you can insert text or graphics.

A. Headnote

B. Top margin

C. Footer

D. Header

9. Which of the following is added to define bullets?

A. Symbol

B. Box

C. Picture

D. All of the above.
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10. Which of the following is not an arithmetic operator?

A. +

B. −

C. *

D. ]

11. In Excel formula, what is the symbol / used for?

A. Division

B. Multiplying

C. Adding

D. Subtracting

12. Which of the following is an example of an absolute cell reference?

A. A9

B. A$9

C. $A$9

D. A9:E9

13. If the cell A1 has the formula =2*6, them what is displayed in the cell and 
formula bar respectively?

A. =2*6, 12

B. 8, =2*6

C. 12, =2*6

D. -4, -4

14. Which short cut key is used to change relative cell reference to absolute cell 
reference? 

A. Ctrl + S

B. F4

C. Alt + F3

D. F2
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15. Which short cut is used to play/view your work?

A. F1

B. F2

C. F5

D. F12

Part III: Fill in the blank spaces. 

1. ______________ is a presentation program.

2. ______________is the default PowerPoint standard layout.

3. The basic unit of any PowerPoint presentation is______ .

4. __________and ___________contain additional information about a Word 
document.

5. _____________is used to copy the formula to the other cells. 

6. A PowerPoint presentation consists of  ______________.

Part IV: Match the following items in Column A with Column B.

                              A           B
1. Insert New Slide page A. Page Break

2. Change according to cell location B. Ctrl + M
3. Fill handle C. B9
4. Displays result of a formula D. Header 
5. Appears at the top of a document page E. Line Spacing 

6. A document’s  location where new page 
begins F. Footer 

7. Sets spacing between paragraphs G. Paragraph Spacing 
8. Easy method for creating multilevel list H. Used to copy formula 
9. Indent First line of paragraph(s) I. Formula Bar

10. Paragraph Section J. First Line Indent Marker 
 K. Active cell
 L. Tab Key
 M. Ruler

 N. Contains Paragraph for-
matting commands 

O. $B$9
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Part V: Provide clear and precise responses to the following questions.

1. What are the commonly used MS Office tools?

2. What is Word Processor?

3. What is the insertion point and how is it moved?

4. List the steps required to insert a formula that adds the value of two cells in 
Excel sheet, say the value of A9 and A10 on Cell A11?

5. What is the appropriate paragraph alignment used for documents like your 
grade 9 IT Textbook? Discuss each of the four alignments: right, left, center 
and justify.

6. List the steps required to display a presentation?

7. List all types of contents that can be included in PowerPoint slide (s)?

8. Write the steps to apply themes to a presentation?

9. Explain Slide Layout and write the steps to change a single presentation slide 
layout?

10. Write simple Excel formula that constitutes mathematical operation and mix-
ture of relative and absolute cell reference. 

Part VI: Project Work
Go to your school Finance Office to observe the payroll structure and prepare 
your own payroll for your teachers using Microsoft Excel application. 
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UNIT OVERVIEW

In History, people use various ways to communication and convey ideas. 
Multimedia is a form of communication that combines different content forms such 
as text, audio, image, animation or video into a single interactive presentation. The 
use of multimedia to communicate ideas begins with newspapers, which is the 
first mass communication medium, using text, graphics and images. Following 
this, radio and television become major media for audio and video broadcasting 
respectively. Therefore, multimedia is like a vehicle which can help you transfer 
information from a source area to its destination. 

Image processing is a method to perform some operations on an image in 
order to get an enhanced image or extract some useful information from it. You 
can use different application software such as commercial adobe Photoshop and 
free Gimp to process images.

In this unit, we will discuss the basics of image processing such as image 
capturing, cropping, resizing, correcting and sharpening. We will end the unit 
with a practical section introducing adobe Photoshop facilities for basic image 
processing such as cropping, resizing, correction and sharpening.

At the end of this unit, learners will be able to:

 � Describe image processing 

 � Edit images captured from different sources such as digital camera.

 � Use image software to create, import and save image files.

 � Use image software to resize, cut and edit images.

UNIT 

IMAGE PROCESSING AND MULTIMEDIA

UNIT OUTCOMES

4 



Grade 9 Information Technology Student’s Textbook 

   145

4.1 Image
 

 Brainstorming 

1. How can image be made and used as communication?

2.  Discuss the three basic colours?

3.  Discuss the graphical elements that you see in the logo of Ministry of 
Education (MoE). 

An image is a visual representation of a person, an animal or some thing in the 
form of photograph, paint, sculptured or otherwise made visible.  Examples of 
image are:

 � A painting 

 � A picture taken with a camera

 � A picture that has been created or copied and stored in electronic form

 � A scanned picture through image scanner 

Figure 4.1 Images

4.1.1 Digital Images

As you have learned in grades 7 and 8, a computer is an electronic device which 
accepts input data such as numbers, text, and audio and video images, processes 
the data digitally to produce information, and stores the data digitally for later use. 
You also knows that computers do everything by processing series of zeros and 
ones (0’s and 1’s) called binary digits (bits), and the basic language of computers 
is binary code.

Whether you take a picture with a digital camera or use a scanner to bring a 
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photo or another artwork into Photoshop, you are digitizing the image. Therefore, 
digital image is an image or picture that is represented digitally, i.e. in groups 
of combinations bits (0 or 1) or specifically called pixels. A pixel is the smallest 
element of an image.

4.1.2 Digital Image Processing

Image processing is a computational technique for analyzing, enhancing, 
compressing, reconstructing and generally performing some operations on an 
image. Digital image processing techniques help us in manipulation of the digital 
images through the use of computers to enhance the quality of the image and 
improve pictorial information for human perception, i.e. enhancing the quality of 
the image so that the image will have a better look.

Digital image processing starts with importing, in which an image is captured 
through scanner or digital camera; analysis and manipulation of the image is 
accomplished using various specialized software application and output (e.g. 
printer or monitor).

Figure 4.2 Digital image processing

KEY CONCEPTS
 ! Image is a representation of something.

 " Digital image is an image which is stored in a computer.

 # Digital image processing is a process of enhancing image and extracting use-
ful information from it.

Activity 4.1

Capture images from different sources to highlight the impact of environmental 
damage on Ethiopian society. You have to cite their sources as an acknowledge-
ment if  you take images from Internet or other sources.
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4.2 Multimedia Production Planning Strategies
 

 Brainstorming 
 How do you think is a multimedia produced? 

Multimedia is the field concerned with the use of a computer to present, store, 
transmit and combine text, graphics, audio and video with links and tools that let 
the user navigate, interact, create and communicate. Before producing multimedia 
product, whether it is animation, film, movie or book, we should use a planning 
strategy such as a storyboard, which clearly expresses how the story will flow in 
multimedia product. 

Storyboard is a graphic layout that sequences illustrations and images with the 
purpose of telling a story visually. Film makers and video creators use storyboards 
to transfer ideas from their mind to the screen. Creating an effective storyboard 
requires skill, but you can gain some pro tips from storyboard examples.

To create a storyboard, you can use different software or rough sketch using 
a paper and pencil. 

Developing Storyboard 

Storyboarding refers to the process of creating a sequence of screens to provide 
an overview of the project, demonstrate the arrangement and functionality of 
the program elements. It helps us to delineate the program’s navigation scheme. 
Multimedia storyboard can include elements of video, sketch, text, audio, photos 
and even physical prototypes used for the purpose of pre-visualization. It is a 
visual representation of how a story will play out, scene by scene. See sample 
animated storyboard for children in Figure 4.3.
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Figure 4.3 Sample video story board for kids 

4.3 Using Image Processing Software

Practical Exercise 4.1

Prepare a storyboard for a video that teaches English Alphabet to Ethiopian 
KG students. 
(Hint: Use chart board, PowerPoint or A3 paper to create a storyboard for 
specified video.)  

 
 Brainstorming 
Have you ever used mobile application software for editing photos such as   
cropping, resizing, rotating, adjusting colour, adjusting saturation, adjusting 
light and clarity in your own or parent’s mobile phone? List kinds of software 
that enable you to do this in the mobile and discuss with your classmates.



Grade 9 Information Technology Student’s Textbook 

   149

Image processing software is the software that is designed to organize, retouch 
and edit images that have been saved on CDs and DVDs, and scanned in or 
transferred directly from the camera to PC. This software allows you to edit and 
crop out unwanted “strange” images like the image with red-eye effect and the 
image in which one person’s head is put on the other’s body. Image processing 
software can be commercial and free. Some of the useful image processing 
application software kinds are Photoshop, Ms-paint, Gimp, Paint 3D, Photo 
styler, Photo editor and photo explosion. 

Photoshop is a general-purpose application designed to work on any raster-
based (made up of dots or pixels) image and perform any number of included 
manipulations. It is one of the most popular image processing software 
packages available today. The software provides many image editing features 
for raster (pixel-based) images as well as vector graphics. Photoshop is used by 
photographers, graphic designers, video game artists, advertising and meme 
designers. Adobe Photoshop enables you to create website layouts and attractive 
graphic designs. What is more, using the same software, you can create posters, 
business cards, greeting cards and many others. Adobe Photoshop is essential in 
both image editing and graphic design and that is the reason why you need to 
learn it. In this lesson, you will learn how to crop, resize, correct and sharpen/blur 
your images using Adobe Photoshop CC 2021 or later.

4.3.1 Launching Image Editing Software  

Image editing software mentioned in the above section can be launched by the 
same mechanism you follow to launch other application software. For example, 
when you launch photoshop you will get similar screen shown in Figure 4.4 (a).  
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Figure 4.4  a) Photoshop Home screen    b) Photoshop Workspace

After Launching an image editing application, you can create a new image or 
open an existing one from file menu. For example, to create a new image using 
Photoshop, you can use the following procedure.

1. Click the Create New button on the Home screen to start a new project (See 
Figure 4.4 (a).

2. Then select the template from the alternatives found (See Figure 4.5). 

3. After selecting the template, adjust the properties at the right side by starting 
from any of your choice, the project name, width, height, orientation, 
resolution or color mode. 

4. Click on Create to open a new document and begin your work on it.

a)

b)
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5. The new project work will be opened (See Figure 4.6) on the workspace, 
which is completely black and white. It is called Canvas, which is full of a 
pixel that you can change.

Image resolution is typically described in Pixel per Inch (PPI), which 
refers to how many pixels are displayed per inch of an image. Higher 
resolutions mean that there are more pixels per inch (PPI), resulting in 
more pixel information and creating a high-quality, crisp image.

                 

 

Figure 4.5 Create new document

4.3.2 Anatomy of Image Editing Software Main Interface

Immediately after you have launched image editing software, you will notice the 
menu bar at the top side of the program and you will see a sidebar in which the 
main tools are placed at the left side. At the right side, there are layer and color 
tools you may use to make adjustments. For example, Figure 4.6 and Table 4.1 
describes the main interface elements of Adobe Photoshop.
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Figure 4.6 Adobe main interface

Table 4.1 Description of Adobe main interface components

Indicator
 Letters

Interface Element 
Name Usage and Description

A Menu Bar This is an options menu bar.

B Tool Options Bar

This is the bar that shows the available 
option which is attached to every tool 
selected. For intance, if you pick a 
brush tool, there will be some options 
such as size, softness and a lot more.

C Document Window

Each document you open will have its 
separate bar that shows its identity, 
such as document name, current 
scaling and color space being in use.

D Toolbar or Palette

This is the place to find the main editing 
tools. Once you click on an individual 
tool, it will show separate function you 
can do with it.

E Document Details This shows you the compressed and 
real size of your document.
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F Active Image
This represents the interface of a large 
area to work on your image with a 
darker background color.

G Rulers

This is used to measure the exact 
position of your image and you can 
drag guidelines from here for text and 
layer line up.

H Search and Share
A link to search for any content, amend 
the workspace arrangement and 
sharing your image on social media.

I Palettes
There are various interchangeable 
palettes that you can select from the 
Window menu.

J Layer Palette

This is an area of the current image 
layer you are working on. The layer 
at the top of the stack will be shown 
above those below.

K Layer Option

It gives you the right to add effects, 
adjustments, layers style and other 
options that you can add to your 
currently active layers.

4.3.3 Image Editing Software Toolbox

 
 Brainstorming 

   Can you locate main editing tools you use to edit image?

As shown in Figure 4.6 above, the left side box is the Photoshop toolbox. The 
toolbar appears to be single by default but you can make it double column by 
clicking on the top double arrow, which will make it to be expanded and shorter. 
Click the double arrow again to return it to the single column toolbar again (See 
Figure 4.7).
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Figure 4.7 Single Column and Double Column Tool Box and their parts

To see more option tools for a given tool, click the Small Arrow in the 
bottom right of tool icon; alternatively, right click on the default or the 
current tool in use and you will be able to see full tools available (See 
Figure 4.8 for Photoshop).

Figure 4.8 More Option tool
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Tip
Hovering the mouse over the tool provides short description of the tool and usage 
video of the tool (See Figure 4.9).

Figure 4.9 Hovering over the tool to see description and usage video

The following table (Table 4.2) describes each part of Photoshop toolbox elements.
Table 4.2 Photoshop toolbox elements description 

a. Moving and Selection Tools

Buttons Tools Uses

Move

It is used to moves layers, selections and guides within 
a Photoshop   document by cicking the Small Arrow or 
right clicking on the tool you will be able to see the full 
available tools of move tool such as Artboard, Rectangular, 
Elliptical, Single row and single column Marquee.

Lasso
It allows you to make free hand selections around the 
object. It consists of additional Polygonal, Magnetic lasso 
tools. 

Object 
Selection

It will select an object when you draw a rough selection 
around an object. It consists of additional Quick and Magic 
wand selection tool.

b. Crop and Slice Tools
Buttons Tools Uses

Crop
It is used to crop an image to cut out or remove unwanted 
areas. It   consists of additional Perspective crop, Slice and 
Slice Select crop tools.

Frame It allows you to place an image into rectangular or 
elliptical shapes.
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c. Measurement Tools

Buttons Tools Uses

Eyedropper

It samples the colors of an image. For a better 
representation of the sample area’s color, you have to 
increase “Sample Size”. It also consists of additional 
tools such as  3D Material, Eyedropper, Color, Sample, 
Ruler, Note and Count.

d. Retouching and Painting Tools

Buttons Tools Uses

Spot Healing 
Brush

It removes blemishes and other minor problems 
area in an image quickly. It consists of additional 
tools, namely Healing Brush Tool, Patch, Content-
Aware Move and Red Eye. 

Brush

It is used to paint-brush strokes on a layer or layer 
mask. It is referred to as a primary painting tool. It 
consists of additional tools, namely Pencil, Color 
Replacement and Mixer brush.

Clone Stamp

It is the best basic of Photoshop retouching tools 
and used to   sample pixels from one area of the 
image and paint them over pixels in another area. 
It consists of additional Pattern Stamp tool. 

History Brush It restores part of an image to an earlier state and 
has Art History brush as additional tool. 

Eraser

It is used to erase pixels on a layer permanently. 
It can also paint in an earlier historical state. It has 
Background Eraser and Magic Eraser as additional 
tools. 

Gradient Tool

It is used to draw gradual blends between multiple 
colors with the Gradient Editor with which you can 
create and customize your gradient. It has Paint 
Bucket Tool and 3D Material Drop as additional 
tools. 

Blur
It simply blurs and softens areas you paint over 
with the tool. It has Sharpen Tool and Smudge tool 
as additional tools. 

Dodge It is used to lighten an area of the image you paint 
over. It has Burn and Sponge as optional tools. 
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e. Drawing and Typing Tools

Buttons Tools Uses

Pen

It lets you draw accurate shapes, vector, selection 
and paths. It has Freeform Pen, Curvature Pen, 
Add Anchor Point, Delete     Anchor Point 
optional and Convert Point tools.

Horizontal type
It is used to add standard types to your 
document. It has Vertical type, Vertical type 
Mask and Horizontal Type Mask optional tools.

Path Selection
It is used to select and move an entire path 
at once and represented by black color. It has 
Direct Selection as optional tool. 

Rectangle

It draws rectangular paths, vector shapes 
or pixel shapes. Press and hold Shift, as you 
drag to set the shape to a perfect square. It has 
Rounded Rectangle, Ellipse, Triangle, Polygon, 
Line and Custom Shape as optional tools. 

f. Navigation Tools

Buttons Tools Uses

Hand
It can be used to click and drag an image around 
the screen to view different areas when zoomed 
in. It has Rotate View as  optional tool. 

Zoom
Click on the image to zoom in a specific area. 
Press and hold Alt, and click with the zoom tool 
to zoom out.

4.3.4 Cropping Image

 
 Brainstorming 

   Which tools are used for cropping image? 

Cropping is one of the most basic editing techniques that are used to take a specific 
part of the image. It is the process of removing portions of a photo to create focus 
or strengthen the composition. 



Unit 4 : Image Processing and Multimedia

158 

There are several ways to crop images. For example, in Adobe Photoshop you can 
use one of the following.

a. Cropping with the Crop Tool

b. Cropping to a specific size

c. Cropping with the Marquee Tool

a. Cropping with the Crop Tool 
The Crop Tool allows you to make a precise selection of an image you wish to 
edit. To crop with the Crop Tool, we follow the steps given below.

1. Launch image processing application such as Adobe Photoshop.

2. Open the image you want to crop. 

3. Select the Crop Tool  from the Toolbox. 

4. It will automatically select your entire image. Drag the edges to fit the 
dimensions you desire (For example in Photoshop See Figure 4.10).

            

Figure 4.10 Cropping with crop tool

5. Resize the border by dragging the squares at the sides and corners until you 
are satisfied with the way your image looks.

6. Once you are completely satisfied with your cropped image, press Enter.
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b. Cropping to a specific size
If you wish to print your digital photos or other images on standard size photo 
paper, you will have to crop your images to a specific size, such as 8x10. To crop 
an image to a specific size, do the following.

1. Open the image you want to crop.

2. Select the Crop Tool from the Toolbox.

3. Specify the values for Width and Height (See Figure 4.11).

Figure 4.11 Crop Tool options bar

4. Click in your image and drag the cropping border. Notice that the border is 
constrained. You cannot make it wider or longer than the specified values. 
For example, if you entered 8 for width and 10 for height, whatever size you 
make the border, the area within it will fit on an 8x10 photo.

       

Figure 4.12 Cropping to a specific size

5. Once you are completely satisfied with your cropped image, press Enter or 
press  at the right corner. 
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c. Cropping with the Marquee Tool
If you are in a hurry and need just a simple crop, you can use the Marquee Tool 
and a menu command. To crop with the Marquee Tool, follow the steps below.

1. Open the image you wish to crop.

2. Select the Rectangular Marquee Tool  from the Toolbox (See Figure 
4.4).

3. Click and drag the mouse to draw a marquee around the area you want to 
crop. 

4. In the main menu, go to Image   Crop. The image will be immediately 
cropped.

4.3.5 Resizing or Scaling an Image 

Image resizing or scaling can help you print your images in standard photo sizes, 
resize and preserve the high quality of digital photos and enlarge small images 
to a poster size. For example, to resize your image to a preset size in Photoshop, 
follow the steps mentioned hereunder.

1. Open your image.

2. Go to Image Menu.

3. Select Image Size (See Figure 4.13 for Photoshop software).

Figure 4.13  Selecting Image Size menu



Grade 9 Information Technology Student’s Textbook 

   161

Figure 4.14: Image Size window

4. Choose the size that you want and click OK.

5. Save your file.

Practical Exercise 4.2

Cropping an Image 

1. In Activity 4.1 you accumulated different images from different sources to 
highlight the impact of environmental damage on Ethiopian society. Use 
one of the cropping methodologies you have learnt to crop unnecessary 
parts of the image captured.

2. Discuss which methodologies are easy for cropping images?

4.3.6 Correction of Image Ton and Color 

Images that come straight from a digital camera are not always perfect and 
tend to cause various problems such as red eye or hot spots if you use flash or 
underexposure. In image editing software, you can correct these problems as well 
as adjust the overall color of your digital photo.

Red Eye Removal

The digital camera flash is located right above the lens, which causes the red-eye;        
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however, you can fix your photos easily in image editing software. For example, 
follow the steps below to remove the red eye problem in images using Photoshop.

1. Open a photo you want to correct.

2. Select the Zoom Tool from the Toolbox. Click and drag a rectangle around 
the eye (See Figure 4.15).

                                  

Figure 4.15 Zoomed red eye

3. Make sure that your default Foreground and Background colors are black 
and white.

4. Click and hold on the little black triangle of the Healing Brush Tool button 
and select the Red Eye Tool (Refer to Table 4.2 (d) and Figure 4.16).

                              

Figure 4.16  Red Eye Tool

5. Click on the red part of the eye and paint, holding down the mouse button. 
You will see how the red will disappear (See Figure 4.17).
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In Gimp to remove red eye first your have to select the boundary of 
iris of the eyes having a red pupil. Then you can find the “Red Eye 
Removal” in the Enhance submenu of Filters menu.          

                                

 

Figure 4.17 Red eye corrected

Adding Flash 

If you take pictures indoors without a flash, they will turn out underexposed and 
dark. Follow the steps below to fix underexposed photos.

1. Open a digital photo you want to correct (See Figure 4.18).

                                             

Figure 4.18 Underexposed photo              
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2. In the main menu, go to Layers  Right click the layer Duplicate (or press 
Ctrl + J). In the next window, name the layer as Layer 1.

3. Make sure Layer 1 is selected in the Layers palette. Select Image from the 
menu, select Adjustments and select Exposure (See Figure 4.19). Select the 
amount of exposure. The whole image will be lightened.

Figure 4.19 Duplicate layer and select Image Exposure menu on new layer

4. Keep duplicating Layer 1 until you are satisfied with your image (See Figure 
4.20).

Figure 4.20 Corrected image
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Use Adjust color Levels from Levels submenu of Colors menu in 
Gimp.

Hot Spot Removal

Using a flash can also cause shiny areas on peoples’ faces or the flash to reflect on 
shiny surfaces. Follow the steps below to remove hot spot from images.

1. Open the photo you want to correct. Notice the shiny area on the top of the 
car, which is not the actual part of the car and called a spot. 

                                    

Figure 4,21 A car’s image with hot spot

2. Duplicate the layer and select the copied layer, not the background layer. 

3. Select the Clone Stamp Tool from the Toolbox.

4. In the Options bar, change the Blend Mode from Normal to Darken (See 
Figure 4.22).

The idea behind setting the mode to darken is to adjust the only pixels that 
will change, which are the ones that are lighter than our sample area. The hot 
spots are essentially light-colored pixels.

5. Choose a soft-edged brush, set the diameter to 40 or 50. 
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Figure 4.22 Setup for clone stamp tool

6. On your subject’s face, in our example on the car body, choose an area of 
“clean” or non-hot spot skin. This will be the reference point and Photoshop 
will now only change pixels that are lighter than this. Hold down the Alt key 
and click to set the reference point or sample. The cursor will change to an 
eye-dropper.

7. Paint over the “hot spot”, the light area will gradually darken (See Figure 
4.23).

Practical Exercise 4.3

Adjusting Flash Effect on an Image 

1. Select the images that has flash problem (underexposed and dark, red 
eye, hot spot) among the images you captured during Activity 4.1 above 
or deliberately capture image with or without flash and use any image 
processing software available to you to correct the flash problem in your 
image.

2. Save both original and corrected images in a folder called Image Processing 
Practice under Documents folder.
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Figure 4.23 Hot spot corrected

Color Adjustment

Color corrections involve changing and specifically correcting colors that make 
an image appear unnatural. Some common examples include objects that lost its 
original color or human face with faded skin color or less visible. 

There are different color correction methods that can make your images look 
dramatically better. Some of the corrections methods you can practice in this sub-
unit are the following. 

 � Levels and curves

 � Saturation

 � Auto-adjustment tools

Figure 4.24 below provides examples with images that need to be color corrected, 
which we are going to work on in this section.
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Figure 4.24 Some images that need color adjustment

a. Color Adjustment Using Level and curves 

Levels 

Every image has a mix of shadows, highlights and midtones. Shadows are 
the darkest parts of the image whereas highlights are the brightest parts, and 
midtones are everything in between. When you adjust levels, you are adjusting 
these different tones. While you could use the brightness and contrast tools for a 
similar type of adjustment, they are much less powerful than levels.

There are many reasons to use levels adjustment. For instance, if you have a 
particularly dark or underexposed image, you might want to make the midtones 
and highlights brighter while keeping the shadows relatively dark. You can see 
examples of this in the images below.
We use the following steps to adjust colors using levels.

1. Open a digital photo you want to correct to the Photoshop (See Figure 4.25).

2. In the Layers panel, add a Levels adjustment layer by clicking adjustment 
layer  in Adobe Photoshop

You can do this using the Levels submenu under the Color menu in 
Gimp.
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Figure 4.25 Creating level adjustment layer

Adjustment layer is a type of non-destructive editing because it does 
not actually change anything about the original image. Because you 
can continue to tweak adjustment layers as you work, it is easy to try 
out different effects and get the image to look exactly the way you 
want.

3. Locate the graph in the middle of the Properties panel. This is called a 
histogram, and it shows information about shadows, highlights and midtones 
of the image. In this example, you can see that there is a big gap on the right 
side with no information, which means the image is underexposed. We can 
use a levels adjustment to fix this.

4. Notice the Input Levels sliders just below the histogram. These are the 
controls you will use to adjust the levels.
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Figure 4.26 Histogram and its sliders

5. Because our image is too dark (underexposed), we will click and drag the 
white slider to the left. Notice how we drag the slider to the right-most edge 
of the histogram (See Figure 4.27). Be careful not to drag the slider past 
this point or you will begin to lose detail in your image. This is commonly 
referred to as clipping.

6. If the shadows in the image are too bright, you can click and drag the black 
slider to the right. In this example, we do not need to adjust this because the 
slider is already at the left-most edge of the histogram.

7. Optional: If the image still looks too dark or too bright, you can click and 
drag the middle (grey) slider to adjust the midtones. In this example, we will 
move the slider to the left to make the image brighter.

8. Optional: Try turning the adjustment layer off and compare the new levels 
adjustments with the original image. You can see the difference between 
underexposed and corrected images (See Figure 2.27).
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Figure 4.27 Color corrected image

Curves 

The Curves tool is similar to levels, but it gives you more power to control 
shadows, highlights, and midtones separately. Because it’s a more advanced tool, 
you’ll need to be careful when using it to adjust your images.

Increasing contrast

One of the simplest adjustments you can make with curves is to increase the 
contrast. To do this, drag the curve down in the shadows on the left to make them 
darker and up in the highlights on the right to make them brighter.

Decreasing contrast

In this particular image, it might be better to decrease the contrast. To do this, 
drag the curve up in the shadows on the left to make them brighter and down in 
the highlights. To adjust image’s colors using curves in Adobe Photoshop, follow 
the steps below:

1. Open image to be color corrected

2. Add curve adjustment layer 
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Figure 4.28 Add curve adjustment layer

3. Click anywhere on the line in the Properties panel to create a new point; then 
click and drag the point to adjust the curve. Note: Be careful not to move the 
two points in the lower-left and upper-right corners. It is possible to adjust 
these, but it is recommended to keep them in the corners until you gain more 
experience with curves.

4. Continue to adjust the points until you are satisfied with the result. You can 
also press the Delete key or click and drag a point off the line to remove it.

5. When you finish compare with original image by hiding the adjustment 
layer, and finally save your work. 

Note that, you can get Curves under the Color Menu in Gimp.
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Figure 4.29 Color adjustment using curves

Tip
If you are new to curves, you may want to select one of the Preset options and 
make small adjustments to the curve as needed. If you need to start over, you can 
select Default from the Preset menu.

Figure 4.30 Preset curve color adjustment
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b. Saturation
If the colors in your image are dull or muted, you can increase the saturation 
to make them look brighter or vivid. On the other hand, you can reduce the 
saturation to make the colors less vivid. If you remove the saturation completely, 
it will produce a black-and-white, or gray-scale, image. You can see an example 
of this in the images below. 

To adjust saturation, add the Hue/Saturation adjustment layer. Then click 
and drag the Saturation slider in the Properties panel to increase or decrease the 
saturation. Follow the following steps to correct the image having color problem 
using saturation method.

1. Load/Open a digital photo you want to correct to the Photoshop.

2. In layer panel, add a Hue/Saturation adjustment layer (See Figure 4.31).

Figure 4.31 Add Hue/Saturation Adjustment layer

3. Then click and drag the Saturation slider in the Properties panel to increase 
or decrease the saturation. Figure 4.32 seems more natural than original 
image (See Figure 4.31).

4. Remember to save your work. 
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Figure 4.32 Corrected image with changing saturation level

Saturation Adjustment Tip
Be careful not to increase the saturation too much. This can cause the colors to 
look unnatural, as shown in the example below.

c. Auto-adjustment Tools
Some images may require more specialized corrections. There are several 
automatic adjustment tools you can use to improve your images. You will find a 
few auto-correction tools, including Auto Color, in the Image menu (See Figure 
4.33).
                                                 

Figure 4.33 Auto color adjustment
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Practical Exercise 4.4

Color Adjustment 

1. Select an image(s) with color problems among the images you captured 
during Activity 4.1 above, or download such images from Internet and 
use any image processing software available to you to correct the color 
problems.

2. Save both original and corrected image in a folder called Image Processing 
Practice under Documents folder.

4.3.7 Image Sharpening

Sometimes an image may not be as clear as you would like it to be. Sharpening 
can help you make it look crisp and clear by enhancing the edges of objects in the 
image - increasing the contrast of the edges within your photo, which brings more 
definition to the details in your photo. However, adding too much sharpness can 
actually make an image look worse, or it can lead to a loss in image detail. To 
sharpen image in Adobe Photoshop, we can use either of the following options. 

 � Unsharp Mask

 � Smart Sharpen  

 � High Pass

The Unsharp mask filter is a common way to sharpen images in Photoshop. The 
name ‘Unsharp’ is derives from the fact that the technique uses a negative blurry 
image, which creates a mask for the original photo. This mask is subtracted from 
the original to detect the presence of edges. After all this, contrast is selectively 
increased along those edges using this mask. The final result is a sharper image. 
When you use this tool, you will be able to control several settings like amount, 
radius and threshold.
Amount: The amount determines how much sharpness will be applied. The 
amount you will need depends on several factors including the overall image 
size, so it is good to experiment with this setting.
Radius: The radius controls the size of the details that will be sharpened, so it is 
generally best to use a very low value for this setting. We recommend a radius 
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between 0.3 and 0.5 for most images although you may find it useful to use a 
slightly larger radius (between 1 and 1.5) for higher-resolution images.
Threshold: Sharpening tends to make image noise more visible. Increasing the 
threshold can help you reduce this by telling the unsharp mask to ignore certain 
parts of the image. However, this can also mean that different parts of the image 
are not sharpened consistently. This is why we recommend keeping this setting at 
0 most of the times unless the sharpening is creating a lot of extra noise.

Figure 4.34 Correct sharpening

a. Using Unsharp Mask
It is one of the methods used to sharpen our image. Just look at the following 
steps. 

1. Open the Photo and Duplicate the Background

Open the photo you want to make sharper   Right-click on the background 
layer and select ‘Duplicate Layer…’

A new window will pop up. After you click OK, the new layer will appear at 
top of the Background layer and rename it to Sharpen Layer.
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Figure 4.35 Duplicate background layer

2. With new layer Sharpen layer selected, Zoom in to 100 %.  Go to Filter  
Sharpen and select Unsharp Mask… filter (See Figure  4.36).    

Figure 4.36 Select Unsharp Mask
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3. A dialog box will appear. Set the desired radius size, and then choose the 
amount of sharpness to add. We recommend experimenting with different 
amounts of sharpening to see what looks best. You can look at the preview 
window above the sliders to see how sharpening is affecting the image (See 
Figure  4.33).

Figure 4.37 Unsharp Mask dialog box

4. Click the preview window to toggle the preview off and on. This is an easy 
way to compare the sharpened version with the original. To view the different 
parts of the image, click and drag within the preview window. Note that you 
will also see the preview in the main document window.

5. Continue adjusting the settings until you arre satisfied with result, then click 
OK. The Unsharp mask will be applied.

6. Save your work.
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b. Using the Smart Sharpen
You can access the Smart Sharpen menu from the Filter menu, and you will want 
to start by setting the Amount slider to 150%. The radius will stay around 1 or 
2, and it is a good idea to always try 1 first. Smart Sharpen has noise reduction, 
which lacks the Unsharp Mask, and you can use this to reduce the noise that 
comes along with sharpening (See Figure 4.38).

Figure 4.38: Using Smart Sharpen

c. Sharpening an Image in Photoshop Using High Pass

1. Open an image to be sharpened in Photoshop. 

2. Convert the background layer into a smart object to protect the original 
image (See Figure 4.39).

The Layers panel shows the unsharpened image. To convert the layer to a 
smart object, click the menu icon in the top right corner of the Layers panel and 
choose Convert to Smart Object from the menu.
Any sharpening we add with the High Pass filter will now be applied to the smart 
object itself, leaving the original image unharmed: the smart object icon.



Grade 9 Information Technology Student’s Textbook 

   181

Figure 4.39 Convert background layer to smart object

3. Select the High Pass filter.

Going to Filter  Other  High Pass. As soon as you select High Pass, your 
image will turn gray.

Figure 4.40 Selecting the High Pass filter.
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Figure 4.41 Adjusting Radius to highlight the edges

4. Adjust the radius value to highlight the edges by starting with the lowest 
value first in which the entire image is filled with solid grey and no edges 
are visible (See Figure 4.41). 

5. Close the High Pass filter as the radius setting gets ideally set between 2 
and 5.

6. Sharpen the image by changing the filter’s blend mode.

With the edges highlighted, we can now sharpen the image just by changing the 
High Pass filter’s mode. Double-click on the Blending Options icon to the right 
of the filter’s name opening the smart filter’s Blending Options.
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Figure 4.42 Opening Filter’s Blending options

Then in the Blending Options dialog box, change the Mode (short for Blend Mode) 
to one of Photoshop›s contrast-boosting blend modes. The blend modes you want 
to try are Overlay, Soft Light, Hard Light and Linear Light.

Figure 4.43 Blending Option dialog box
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The two most commonly-used blend modes for sharpening images with High 
Pass are Overlay and Soft Light. Overlay produces a higher contrast effect, 
resulting in a stronger amount of sharpening, while Soft Light gives you lower 
contrast and more subtle sharpening.

On the left is the result using Overlay, and on the right is the sharpening with 
Soft Light. Keep in mind that the differences in sharpness are not as noticeable in 
these smaller screenshots as they will be with your own larger images.

 

Figure 4.44 Sharpening result

7. Fine-tune the sharpening by lowering the filter’s opacity.

Once you have chosen a blend mode, you can then fine-tune the amount of 
sharpening by adjusting the Opacity of the High Pass filter. The more you lower 
the opacity, the more you will reduce the sharpening effect.

Figure 4.45 Adjusting the Opacity of the High Pass filter



Grade 9 Information Technology Student’s Textbook 

   185

8. Close the Blending Options dialog box.

Finally, click OK to close the Blending Options dialog box, 

Practical Exercise 4.5

Image Sharpening 

1. Select the image with clarity problems among the ones you captured during 
Activity 4.1 or download image from Internet and use any image processing 
software available to you to correct clarity problems in the image.

2. Save both original and corrected image in a folder called Image Processing 
Practice under Documents folder.

Mini Project
Develop a business card for yourself using Photoshop application that contains 
your image, your business logo, business name, contact information, etc.

KEY CONCEPTS

 $ Multimedia is derived from the words multi and media. Multi means many, 
multiple, and media is a tool that is used to represent or do certain things, 
delivery medium, a form of mass communication – newspaper, magazine or 
TV which contain text, graphic, voice, images, music and the like.

 % Multimedia production passes through complex stages and it needs 
planning strategies, which include defining the goals and objectives of the 
multimedia, describing the content, developing application script, outline, 
translate outline into logic flow chart and story boarding. 

 & Image is a visual representation of something. 

 ' Since images coming out of a camera are not always best, we need image 
processing. 

 ( Photoshop is one of the best image processing software available today. 
To crop unwanted part of image, you can use three techniques: crop tool, specifying 
size, and marquee tool.

 ) To adjust the colour of an image in Adobe Photoshop, you can use level and 
curves, saturation and auto adjustment.
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 * Image sharpening is the process of making the image clear and look crisp by 
enhancing the edges of objects in the image. 

 + To sharpen the image you can use Unsharp Mask, Smart sharpen or High 
pass methodologies in Photoshop. 

4.4 Unit Summary

In this unit you have learnt image processing and multimedia. Multimedia comes 
from two words, multi, which means multiple, and media, which is a way of 
conveying message. Hence, multimedia means multiple way of representing or 
conveying information. Multimedia can contain text, image, still images (videos) 
and etc. Image processing is a method to perform some operations on an image 
in order to get an enhanced image or extract some useful information from it. The 
unit discussed basic operations on an image such as image capturing, cropping, 
resizing, correction and sharpening with Adobe Photoshop software. The basic 
concepts of this unit are listed below. 

 � One of the components of multimedia that is used to convey information 
is image, which represents something or someone visually. 

 � Every information stored in a computer is processed in 0s and 1s format. 
Therefore, an image is stored in a computer as 0’s and 1’s called digits.

 � A pixel is a single dot on the screen in digital image, and it is picture 
element that collectively makes up a picture as a whole.

 � Story boarding is a multimedia production planning strategy, which is 
used to tell one multimedia sequence of story from the beginning to end 
diagrammatically. 

 � Adobe Photoshop is one of the popular tools that are used to process a 
digital image. 

 � To crop unnecessary part of an image using Adobe Photoshop, you 
can use crop tool, marque tool or you can specify the width and height 
specifically.

 � There is always no perfect camera shooting that produces perfect image, 
so we need to correct the color and the tone of an image. 
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 � When we use flash to capture a photo at dark place, we may get an 
image having red eye, and these has to be corrected.

 � When we do not use flash, every detail of the image will not be visible 
and becomes dark; this also has to be corrected. 

 � Every image has a mix of shadows, highlights and midtones. Shadows 
are the darkest parts of the image, highlights are the brightest parts, and 
midtones are everything in between.

 � Color adjustment can be done using levels, curves, saturation or auto-
adjustment tools. 

 � Image sharpening is the process of making a picture or image crisper 
and clearer to see. For example, the eye of the image may not be visible; 
the detail part of the image may not be visible and etc.

 � To sharpen images, we can use Unsharp Mask, Smart Sharpen or High 
Pass.

4.5 Unit Review Exercise

Part I: Write whether the following statements are true or false.

1. Images coming out of camera are always correct, and there is no need for 
further refinement. 

2. Unsharp mask method is used to sharpen an image.

3. Editing is the process of changing a photo to make it most effective for its 
purpose.

4. Pixels are small dots on the computer screen to reflect the colors red, green 
and blue.

5. Layers are viewed from top to bottom.

6. Digital image is an image combination of 0’s and 1’s.

7. Lasso tool is used to make free hand selection.
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Part II: Choose the correct answer among the alternatives provided.

1. Which of the following options is used to create a new file in Photoshop?

A. File   New

B. File   Open

C. Create   New

D. Start   New File

2. What is the shortcut key used to create a new file in Photoshop?

A. File, new

B. Ctrl + N

C. Ctrl + Shift + N

D. Shift + N

3. Which short cut key is used to duplicate layers?

A. Ctrl + J

B. Ctrl + T

C. Ctrl + N

D. Ctrl + D

4. PPI represents ________. 

A. Point presentation interface

B. Pixel per inch

C. Power point index

D. None of the above.

5. Which one of the following image errors can exist due to not using flash during 
imaging?

A. Hot spot

B. Dark image

C. Red eye

D. A and B are correct.
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6. ______________is the process of removing portions of a photo to create focus 
or strengthen the composition.

A. Image sharpening

B. Image cropping

C. Image editing

D. Image selection 

7. Which one of the following is used to crop an image in Adobe Photoshop?

A. Using Crop tool

B. Specifying size

C. Using Marque tool

D. All of the above.

8. __________is the process of making an image clear and look crisp by enhancing 
the edges of objects in the image.

A. Image cropping 

B. Image resizing

C. Image sharpening

D. All of the above.

9. Which one of the following is used to correct color?

A. Levels

B. Curves

C. Saturation

D. All of the above.

10. Which one of the following is used to sharpen an image in Adobe Photoshop?

A. Unsharp Mask

B. Smart Sharpen 

C. High Pass

D. All of the above.
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Part III: Fill in the blank spaces.

1. ____________ refers to technology that presents information in more than 
one medium— such as text, picture, video, sound and animation in a single 
integrated communication.

2. ______________ is located on the left side of the interface and houses many 
tools. 

3. The right side of the Adobe Photoshop is occupied by _______________.

4. To change the name of the layer, you can ____________on the words on the 
layer.

5. _________ describes the purity of a color. 

6. The common color adjustment methods used in Photoshop are _______, 
_____________, and_________.

Part IV: Provide clear and precise responses to the following questions.

1. What is Adobe Photoshop?

2. How can re-size you the image in Photoshop?

3. Explain the Rectangular Marquee and Red-eye tools.

4. What are Lasso tools and name them?

5. What is healing tool?

Part V: Project Work
Develop a promotional card for your place of birth using Photoshop application 
that contains image of known buildings, common animal or renowned person 
with brief textual information. 
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UNIT OVERVIEW 

As you learned in unit 2, computer network and Internet has transformed our 
life in many good ways. Unfortunately, these vast network and associated 
technologies have also brought increasing number of security threats. This unit 
introduces what computer security attacks you could encounter in your life in the 
connected world, what type of impacts these security attacks  could cause and 
what action you can take to avoid or minimizing the impact of the attacks. 

 
 Brainstorming 

1. What threats and risks do you remember in the area of computer network, 
utilization of smart phones and information and computer misuse from 
grade 8 IT subject?

2. You learned about Internet and Internet services including social media in 
grade 8. Besides their wide benefits, what challenges may you encounter 
through the Internet?

At the end of this unit, learners will be able to:

 � Explain computer and information security.

 � Explain confidentiality, availability and integrity of information system.

 � Discuss computer security threats.

 � Explain basic security threats and prevention strategies.

 � Evaluate confidentiality, availability and integrity of a school-based 
information system.

UNIT 

INFORMATION AND COMPUTER

UNIT OUTCOMES

5 SECURITY
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5.1  Definition of Security

What is the meaning of the term security? Security has diverse definitions, which 
vary significantly depending on what is to keep secured. In general, security is the 
quality or state of being secure. It can be a freedom from danger (which is related 
to safety) or a freedom from fear or anxiety. Security also means protection and 
measures taken to guard against sabotage, crime, attack or escape. This, the latter, 
definition is a more proper one from institutional and business perspectives. Do 
you know that Ethiopia has a federal institution called Information Network 
Security Agency (INSA)? INSA was established for protecting the country’s 
national interest by building a capability to make information and information 
infrastructures in the country safeguarded. Thus, INSA is a national security 
agency with a mission on cyber security, which we shall cover this unit. 

The focus of this unit is on computer security. Computer security is the protection 
of computer systems and information from harm, theft and unauthorized use. 
What is an unauthorized use? For example, you can use this textbook when you 
are learning in a classroom or when you study at school or at home. Can you use 
it during examination? Of course, not! Thus, we may say that it is illegal or you 
are unauthorized to access and use textbook during examinations.  Computer 
security is also the process of preventing and detecting unauthorized use of your 
computer system. There are various types of computer security, which is widely 
used to protect personal and organizational valuable information. Depending on 
what to secure, we can identify the following types of computer security (See 
Figure 5.1).

Figure 5.1 Types of computer security
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 � Information security: is securing information from unauthorized access, 
modification and deletion. For example, do you want your marks 
reduced or changed by someone who has access to your homeroom 
teacher’s laptop?

 � Application security: is securing an application by building security 
features to prevent from cyber threats.  Most people use spreadsheet 
software like Microsoft Excel to store huge data such as payroll or 
students’ marks. What would happen if another person gets access to 
these data through the network? Such access to application software is 
dangerous threat for the information security.

 � Mobile and computer security means securing a handheld devices and 
standalone machine by keeping it updated and patched.

 � Network security is done by securing both the software and hardware 
technologies. Do you know a firewall software or hardware? Read about 
firewall from the Internet. Firewall protects networks from Internet-
based attacks. Related security types are cloud security for internet-
based services and Internet of things (IoT) security that are to be covered 
in grade 12. 

 � Cyber security: means protecting computer systems which communicate 
over the computer networks.

Note that computer security involves both technological and managerial issues 
and solutions. Do you know the 90/10 rule? This customary rule states that 10% 
of your security countermeasures are technical, and 90% of security defenses rely 
on you to follow good computer practices. The rule emphasis on the importance 
of security awareness and necessity for students, teachers, employees, merchants 
and all the citizens adhere to good computing practices. These good computer 
practices are covered later in this unit. 
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Activity 5.1

1. Small group task: With the increase access to smart phones and use of 
social media, such as Facebook, TikTok and the like, students of your age 
upload and share their personal information such as photos and videos 
online. Develop a small list of questions (not more than five) and ask 
students outside of your class. Prepare a slide presentation on the benefits 
that students gain from their sharing of personal information online and 
potential security risks that students raise in your survey. 

2.  Individual work: if you or your parents have a phone or a computer, 
consider how many other persons know the password, code or security 
patters of those devises. Do not worry if you do not have no a phone or a 
computer. Just, consider that you are the last person to lock your house and 
you want to put the key somewhere for your brother, sister or parents to 
fetch it and enter to the house. In both cases, what risks do you anticipate 

KEY CONCEPTS

 , Being connected is beneficial, but it could also make you victim of security 
treats. 

 - Security means protection and measures taken to guard against espionage or 
sabotage, crime, attack or escape. 

 . Computer security is the protection of computer systems and information 
from harm, theft and unauthorized use.

 / Good security standards follow the “90 / 10” rule. That is 90% of security 
safeguards rely on an individual (“you”) to adhere to good computing 
practices. Ten percent (10%) of security safeguards are technical.

5.2 Principles of Computer Security

 
 Brainstorming 
What do you wish to see or get from your school computer laboratory or 
Internet connectivity in terms of quality, reach and your usage desires?
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You learned the definition of computer security in section 5.1. Here, you will 
learn about basic attributes that a computer security system should possess. The 
concept you learn here helps you, for example, to compare two computer security 
systems or specify the requirements to establish a particular computer security 
system. 

Computer security is mainly concerned with three main areas. These are 
confidentiality, integrity and availability, which are abbreviated as CIA. Sometimes 
CIA is also called as the security requirements triad. Let us see the three 
components of CIA in detail. 

 � Confidentiality is ensuring that information is available only to the 
intended audience. This often means that only authorized users and 
processes should be able to access or modify data. In other words, 
this involves protecting the information from a third party having 
unauthorized access. A concept related to this is privacy, which focuses 
on protecting personal data.

 � Integrity means that data can be trusted. It should be maintained in a 
correct state, kept so that it may not be wrongly changed and should be 
correct, authentic and reliable.

 � Availability is ensuring that the information is available to authorized 
users whenever they require it. This means keeping systems, networks 
and devices up and running.

Figure 5.2 shows the confidentiality, integrity and availability as a computer 
security triangle. Even though the source is unclear, the CIA model in Figure 5.2 
shows the three principles as triple constraints of computer security. 

Figure 5.2 CIA model
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Such a triangular representation is used to show that computer security (data 
and services) can be constrained by the three features represented in the three 
sides of the triangle. Usually, achieving the three of them (CIA) at the same time 
can be costly and organizations often decide their focuses based on their priorities. 
For example, schools usually focus on making trustworthy knowledge resources 
available to wider student community by focusing on integrity and availability. 
On the other hand, military institutions might focus on confidentiality and 
integrity.  

Activity 5.2

Small group task: In your group activity in question 1 of Activity 5.1, you made 
a presentation on students’ opinion of your school focusing the benefits and risks 
associated with uploading and sharing personal information such as photos and 
videos online. You are also introduced to the 90/10 rule of computer security. 
Improve your slide presentation by discussing first on: 

1.  Confidential issues related to your examination results - Who can see them, 
modify them and should not see it?

2. Integrity issue: Can you, as a student, change your result? Ask one of your 
teachers about whether your school director can make changes on your 
results? Ask also what your homeroom teacher can do with your marks.

3. Availability: In terms of your school ICT services, ask the IT coordinator 
to teach students with disability about supports or benefits they could get 
from the Internet and electronic services of the school.  

KEY CONCEPTS

 0 Confidentiality, integrity and availability, also known as the CIA triad, 
is a model designed to guide policies for information security within an 
organization.
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5.3 Computer Security Threats 
 

 Brainstorming 
Ethiopia has become a more connected country. With your mobile phone and 
mobile data connectivity, you are, of course, part of this interconnected world. 
What specific threats can affect you through this interconnection? 

You learned about the principles of computer security in section 3.2 above, 
together with the three principles form the cornerstone of any organization’s 
security infrastructure. In fact, they should function as goals and objectives for 
every security program. The focus of this section shifts on describing the different 
types of computer security threats. You are living in an interconnected world 
and it is essential that you develop a clear understanding about the risks of the 
interconnection and their protection mechanisms. 

There are both natural and manmade (artificial) threats to our computers 
and computer systems. As shown in Figure 5.3, computer security threats can 
come both from internal and external sources. Internal threats are those threats 
emerging within an institution, company or business while external threats are 
from outside. Both internal and external factors can be caused by environmental 
(i.e. natural) as well as human and technical (i.e. manmade/artificial) factors. 

Figure 5.3 Types of computer security threats
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Computer security attacks can also be malicious, which are harmful or non-
malicious or have no damaging effect. The attack can also be accidental that is 
committed due to mistake or an unintended action or intentional, which means 
the attacker commits the attack with a deliberate intention.  The following two 
sections (5.2.1 and 5.2.2) present natural and artificial threats for computer 
security. 

5.3.1 Natural Threats in Computer Security

There are many computer security threats happening due to natural causes. 
Natural hazards such as earthquakes, flooding or lightning storms can lead to 
fires, extreme temperatures and even electric shocks to your computer, causing 
potential physical damage and loss of data. These are discussed one by one below.             

Fire 

Fire can be devastating to your computer. Beyond direct damage from flames, the 
heat generated can melt sensitive components within the computer. Smoke can 
damage the CPU fan which can also cause over-heating. In case of a fire, always 
get yourself to a safe place before trying to rescue your computer. 

Extreme temperature 

Generally, computers are designed to function within a moderate temperature 
range. Excessive heat or cold can cause important components to malfunction or 
break. In cases of drastic temperature changes, it is best to allow the computer to 
return to room temperature before using it.

Lightning strikes 

Lightning strikes are a huge threat to your computer, even if they never actually 
touche your hardware. Sometimes, a lightning strike will create an electric surge 
(or spike) that amplifies the voltage to your computer through the power supply. 
This sudden surge of electricity can destroy crucial components of your comput-
er including your motherboard. 

Activity 5.3

1. Discuss with your classmate about the fire burn and property damages of 
any one of the classed encountered the burning, and what could be done 
with fire-related emergencies in computer laboratories and data centres.   
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2. List three components of a computer hardware that a power surge can 
destroy.   

5.3.2 Artificial threats to computer security

The vast majority of computer security threats are manmade and happening 
through the devices and networks that we are using.  Computer security 
threats change their nature and methods with a change in the technology. With 
the recent development on Internet-based services, the majority of manmade 
security threats come through the Internet as a platform, i.e. they come through 
network connectivity. Hence, the term cyber security is used interchangeably 
with computer security. The attack on computer security is also widely referred 
as cyber-attack. The prefix cyber, both in cyber-security and cyber-attack and as 
well cyberspace refers to computers and computer networks.  Cyber-attacks are 
classified in different ways. You can consider the following as the main types of 
cyber-attacks.

1. Denial of service (DoS)

2. Malware attack

3. Man in the middle

4. Phishing

5. Eavesdropping

6. SQL injection

7. Password attack

8. Social engineering

Table 5.1 below describes different types of computer security attacks. Malware 
attacks such as Trojan horses, worms and virus were in existence since the era 
of file sharing through portable file sharing. Denial of services (DoS), phishing, 
SQL injections and password attacks are popularized with the dominance of the 
Internet as a service platform. Malware stands for malicious software. Cyber-
attacks can also combine psychological and technological attacks particularly in 
the case of man-in-the-middle, eavesdropping and social engineering attacks. 
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Table 5.1 Types of cyber-attacks

    Type            Variety and description

Denial of service 
(DoS) 

DoS attacks hurt computer systems by flooding targets 
with requests – stopping regular users from connecting to 
the service. This means the regular network- based services 
cannot be provided on timely manner. DoS attacks on bank 
IT infrastructure, for example, could stop the bank services 
such as ATM and CBE Birr services. Such attacks disappoint 
customers and the service providers, such as the banks, may 
encounter reputation damage as a result.

Malware Attack

Trojan horse: A code that takes over the system to steal and 
damage everything on the system. Trojan horse is the type of 
malware that downloads onto a computer being disguised or 
masked as a legitimate program.

Virus: A malicious code that gets into the computer program by 
replicating to change its functioning. Melisa virus is a common 
one that spreads itself in the system without acknowledging 
the user. Some people also refer to it as rootkit.

Key logger: They work by recording the movement on the 
keyboards and mostly steal passwords and accounts’ details.

Worms: An independent program that infects the computer 
system through network devices

Adware: Advertising software to spread malware. Adware 
(or advertising software) are various pop-up advertisements 
that show up on your computer or mobile device. Adware 
has the potential to become malicious and harm your device 
by slowing it down, hijacking your browser and installing 
viruses and/or spyware.

Botnets:  The word botnet is formed from the words robot 
and network. Cyber criminals use special Trojan viruses to 
breach the security of several users’ computers, take control 
of each computer and organize all the infected machines into 
a network of bots that the criminal can remotely manage.
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Spyware: A secret program that tracks all the movements of 
the user secretly and then uses that information against them.

Ransomware: This malware locks the files and data on the 
system and threatens to delete them if not paid the ransom.

Man in the 
middle

This type of attack includes intercepting communication 
between the people and then stealing data from their 
conversation. Open Wi-Fi networks are the most common 
place where this kind of attack takes place.

Phishing

Phishing attacks are the practice of sending fraudulent 
communications that appear to come from a reputable source. 
It is usually performed through email. The goal is to steal 
sensitive data like credit card and login information or to install 
malware on the victim’s machine. Phishing is a common type 
of cyber-attack that everyone should learn about in order to 
protect him/herself.

Eavesdropping

An eavesdropping attack occurs when a hacker intercepts, 
deletes or modifies data that is transmitted between two 
devices. Eavesdropping is also known as sniffing or snooping. 
It relies on unsecured network communications to access data 
in transit. It typically occurs when a user connects to a network 
in which traffic is not secured or encrypted and sends sensitive 
business data to a colleague. The data is transmitted across 
an open network, which gives an attacker the opportunity 
to exploit vulnerability and intercept it via various methods. 
Eavesdropping attacks can often be difficult to spot. Unlike 
other forms of cyber-attacks, the presence of a bug or listening 
device may not adversely affect the performance of devices 
and networks.

SQL injection

This is when an attacker injects an unauthorized input into 
the SQL statement. However, this is only possible on websites 
where hackers can access the database using your ID and 
password.
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Password attack

Many hackers try to get your password by using different 
methods such as  dictionary attack where they try different 
possible passwords from the dictionary; brute force where 
they do trial and error to decode the password, but it is 
time-consuming; Key-logger or tracking movements on the 
keyboard to get passwords; shoulder surfing, which is a 
physical observation that people do by looking over the user’s 
shoulders; the rainbow table, which  has pre-computed hash 
values to find passwords.

Social               
engineering

Social engineering refers to creating a social situation to get 
information from the user like getting a call from the mobile 
company saying, “Your device is in danger”. You blindly trust 
and give out all the information without any verification.

The Internet has also brought peculiar challenges for kids and youth of your 
ages. Religious fundamentalists, radical political or tribal extremists, terrorist 
and sex traffickers and abusers have found the Internet as safe zone for their 
illegal attraction towards kids and youth to their extreme views and activities. 
The following are such dangerous Internet-based cyber security attacks which 
obstacle your safe use of the Internet.  

1. Cyber bullying - This is ridiculing or humiliating young kids in such places 
as social media and online game platforms. Cyber bullying is bullying that 
takes place over digital devices like cell phones, computers and tablets. 
Cyber bullying can occur through SMS, text and apps, or online in social 
media, forums, or gaming where people can view, participate in, or share 
content. Cyber bullying includes sending, posting or sharing negative, 
harmful, false or mean content about someone else. It can include sharing 
personal or private information about someone else causing embarrassment 
or humiliation. Some cyber bullying crosses the line into unlawful or criminal 
behavior.

2.  Cyber predators: Cyber predators are people who use the Internet to exploit 
usually younger people for sexual and other purposes. Many cyber predators 
pretend to be someone else or lie about details about themselves to gain trust 
of their victims.
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3.  Posting private information: You may not yet understand social boundaries. 
Thus, you may post personally identifiable information online, for example 
in your social media profiles that should not be out in public.

5.3.3 Who is behind cyber attacks?  

The following parties play roles behind cyber-attacks.

1. Online criminals: These people are good at identifying what can be 
appropriated, for example stealing and selling sensitive data or holding 
systems and information to ransom.

2. Hackers: Individuals with varying degrees of expertise, often acting in an 
untargeted way, perhaps to test their own skills or cause disruption for the 
sake of it.

3. Malicious insiders: use their access to an organization’s data or networks to 
conduct malicious activity such as stealing sensitive information to share 
with competitors.

4. Honest mistakes: Sometimes persons like you or staff with the best intentions 
just make a mistake, for example by emailing something sensitive to the 
wrong email address. 

5. School pupils or students: Some students simply enjoy the challenge of putting 
their cyber skills to the test.

Activity 5.4

1. What can do you as a student to protect yourself from the many types of 
manmade cyber- attack?   

2.  What can your parents and school can do to assist you to have secure and 
safe use of Internet and online services? 

KEY CONCEPTS

 1 You have a lot to gain from the Internet and Internet-based services. However, 
Internet could also be a backdoor to allow hackers and other cyber attackers 
to enter into and abuse your privacy and your school’s system. You need to 
develop safe internet use practices.    
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3. Ask your school’s IT coordinator about availability of acceptable use policy 
that governs how the Internet and computers should be used in the school 
compound. Read this use policy and discuss its role in protecting you from 

5.4 Potential Losses Due to Security Attacks

Whether the security threat originates within or outside of your home, your school 
or somewhere else or happened due to natural or manmade causes, it will have 
psychological, financial, legal or political impacts of varying levels of severity. 
The popular impacts of computer security threats are the following. 

1. Destruction or loss of information:  such as destruction of system components 
or loss of data due to failure of a hard disk. 

2. Corruption of information: like unauthorized alteration of files stored such 
as adding or reducing student marks stored in a school database or in a 
computer used by your homeroom teacher. Posting documents that the 
school considers as illegal or unacceptable onto your or the school’s social 
media channels (e.g. Telegram or Facebook) is example of corruption of 
information.  

3. Theft of services: is an unauthorized use of computer or network services. 
Consider, for example, that you have access privilege to the school Internet 
service for educational purposes. If you use this privilege for unrelated 
purposes such as for online marketing (for promoting goods), then, it 
becomes a theft of services.   

4. Illegal usage: uses the normal function of the system to achieve the attacker’s 
behavior for other purpose. For example, dispatching texts of videos that 
promote inter-conflict or inter-religious conflict by using school internet 
services is an illegal usage, which can be a criminal act.   

 
 Brainstorming 
What personal, social, economic and political impacts do we incur computer 
due to computer security threats?
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5. Disclosure of information: This is dissemination of information to anyone who 
is not authorized. For example, schools put warning or letter of appreciation 
on noticeboard inside the school to make the case known to the school 
community. Taking a picture of such information and posting it on social 
media is an unethical disclosure of private information. Figure 5.3 shows an 
increase of cyber-disclosure in American secondary schools. Even though it 
does not show the cases in Ethiopia, it shows the severity of the situation in 
the developed world and suggestive to the emerging situation in our country 
and the rest of the developing world. 

Figure 5.3 cyber-attacks against public schools in the United States

6. Denial of use: This is covered above as DOS, in section 5.3.2. DoS is an 
intentional degradation or blocking of computer or network resources, 
making it inaccessible to its intended users.

7. Elevation of privilege: uses the weakness of the system to access the target 
system.  An elevation-of-privilege occurs when an application gains rights 
or privileges that should not be available to them. Let as assume both a 
teacher and a student have privileges to access to academic record systems 
where students marks are registered. The access privilege for the teacher is 
higher because he or she registers marks and works on some administrative 
tasks. Elevation of privilege occurs when a student manages to enter with the 
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account of the teacher. Such a risk occurs, among others, for example when 
we use easily guessable passwords, heft or hijacking and due to keystroke 
logging. Keystroke logging (or capturing) happens due to the action of 
recording (logging) the keys struck on a keyboard.

Activity 5.4

1. List threat types that could cause each of the seven categories of threat 
impacts.   

2.  Try to understand the following case and answer the questions that follow 
it based on it.

Student Halima, who loves shopping online, is an Ethiopian. She surfs the 
internet every week and purchases something new. One day, she realized that 
there were purchases made that she did not make herself and a price twice the 
cost of the purchase is paid from her mobile banking.

a. Explain how student Halima is benefited from ICT in this context. 

b. List two negative impacts she encountered from ICT usage in this 
context. 

c. Briefly explain why Halima could possibly be the victim.  

d. Suggest what she can do to protect herself from such situations in the 
future. Ask an IT  expert for further information.

5.5 How to Secure yourself and your Computer Systems

The threats that you learn in section 5.3 can cause unprecedented danger. 
Consider, for example, what would happen if the computer that keeps the entire 
result of students from grade 9 to 12 was stolen or failed beyond repair. From 
where can you get your transcripts? Banks, insurance companies, hospitals and 
many other institutions store their valuable information in computer systems in 
spite the fact that the risks of computer security (both natural and manmade) are 
eminent. Thus, precaution is extremely important. 

Here, it is important to employ the customary 90/10 rule of computer security 
– 90% of good computer and 10% of technical practices. The good computer 
practices start with having sufficient level of security awareness. A book on 
Internet safety for schools put forwards the following for students to know.
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 � The Internet is a powerful tool that should be used wisely. 

 � It allows students to access to a vast library of previously 
unavailable resources. 

 � It also enables students to communicate with people around the 
world. 

 � It also provides creative outlet for students skilled in writing, art, 
music, science, mathematics and other topics.

 � Know also that not all Internet information is valid or appropriate.

 � Sexually explicit materials or violent images can affect students 
negatively.

 � Sexual predators will try to convince students to trust them.

 � Internet information may promote negative attitudes such as 
hatred or intolerance and dangerous or illegal activities, such as 
self-injuring behavior, gambling and illegal drug use.

 � Internet messages and the people who send them are not always what 
or who they seem.

 � People in chat rooms, instant message “buddies” or those who 
visit a blog may not be who they appear to be.

 � E-mail can cause malicious code infection problems for a computer 
or network.

 � Students need to know which information is safe to share with 
others online, which should never be shared and why sharing it 
could put them at risk.

 � Students should never reveal online any information about where 
they live or attend school.

 � Students need to be aware of their electronic messages, even those 
with known friends, can leave electronic footprints that can be 
misused by others.

 � Predators and cyber bullies hide themselves and use the Internet to 
manipulate students and kids. Students must learn how to avoid 
dangerous situations and get adult help.
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 � Sexual predators deceive students by pretending to be students 
themselves. They sometimes lure young people into a false sense of 
security or blind trust and try to alienate them from their families.

 � Bullies use Internet tools such as instant messaging and the Web to 
harass or spread false rumors about students.

 � Students need to know that posting personal information and 
pictures can allow predators to contact and begin grooming them 
for illegal meetings and actions. Personal photos can be easily 
misused or altered when posted on the Internet.

 � Internet activities such as playing games and downloading music or 
video files can be enjoyable. Students need to know which activities are 
safe and legal.

 � Gaming sites can attract sexual predators and/or cyber bullies.

 � Some games may contain pornographic and/or violent images. 
Students need to talk to their parents about what is acceptable.

 � Students need to know how to detect whether a specific file 
download is legal and/or free of malicious code.

Besides having essential security awareness, it is important that you take 
preventive steps for having secure computer system and safe internet use. These 
include:

 � Secure your computer physically by:

 � Installing reliable, reputable security and anti-virus software.

 � Activating your firewall, because a firewall acts as a security guard 
between the internet and your local area network. 

 � Stay up-to-date on the latest software and news surrounding your 
devices and perform software updates as soon as they become available.

 � Avoid clicking on email attachments unless you know the source. 

 � Change passwords regularly, using a unique combination of numbers 
and letters, combining the capital and small letters. It is good for you 
to have at least 15 characters. If you have more than one account (for 
example, for e-mail, e-learning or Facebook), try to have different 
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passwords for different accounts.

 � Use the Internet with caution and ignore pop-ups, drive-by downloads 
while surfing.

 � Perform daily full system scans and create a periodic system backup 
schedule to ensure your data is retrievable when something happens to 
your computer.

5.6 Unit Summary 

 � Although network allows us to share resource easily, one of the 
disadvantages of being connected is vulnerability to different security 
threats. 

 � Computer security is the protection of computer systems (including 
hardware, software, firmware and information being processed, stored 
and communicated) and information from harm, theft and unauthorized 
use.

 � Information security is the protection of information and information 

KEY CONCEPTS

 2 Computer security is the protection of computer systems (including 
hardware, software, firmware and information being processed, stored and 
communicated) and information from harm, theft and unauthorized use. 

 3 Computer security treats can be internal to an information system or external. 
The cause could be environmental (or natural) in which natural hazards 
such as earthquakes, flooding or lightning storms lead to fires, extreme 
temperatures and even electric shocks to your computer, causing potential 
physical damage and loss of data.

 4 Computer security can also be artificial (or human errors or technological) 
and could happen accidentally in which attackers affect the information and 
computer system. 

 5 Broadly, there are seven categories of malicious impact that information and 
computer security threats can course.    
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systems from unauthorized access, use, disclosure, disruption, 
modification or destruction in order to provide confidentiality, integrity 
and availability.

 � Confidentiality ensures that information is available only to the intended 
audience.

 � Integrity protects information from being modified by unauthorized 
parties.

 � Availability ensures that information should be consistently and readily 
accessible for authorized parties timely.

 � Computer security threats can be caused by natural in which natural 
hazards such as earthquakes, flooding or lightning storms leads to fires, 
extreme temperatures and even electric shocks to your computer, caus-
ing potential physical damage and loss of data.

 � Computer security can be artificial or manmade in which hackers and 
crackers will affect the information and computer system. 

 � The broad majority of computer security threats come from the manner 
that computer users practice (90%) and, thus safe use of computer 
systems and the Internet helps us to avoid the major security risks 
associated. 

 � Threats on the Internet can come from hackers, cyber bullies and 
predators using the Internet and computer networks. Internal malicious 
actors (like students and teachers) and your trusted persons can make 
cyber-attacks by mistake. 

 � The major types of cyber-attacks are denial of services (DoDs), malware 
attacks, man-in-the-middle, phishing, eavesdropping, SQL injection, 
password attack and social engineering.

 � You can minimize the risks of cyber security risks by building your 
awareness level and applying good Internet and computer use practices 
as well as by implementing technical protective measures.  
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5.7 Unit Review Exercise

Part I: Write whether the following statements are true or false.

1. Bing connected does not introduce security vulnerabilities or threats.

2. Ensuring availability means making service accessible at the time of need. 

3. There is little or no danger coming from the Internet.

4. Identity theft is natural security treat.

5. Confidentiality, integrity and availability are principles of a computer security. 

Part II: Choose the correct answer among the alternatives provided.

1. _________ ensures that information is available only to the intended audience.

A. Confidentiality

B. Availability

C. Integrity 

D. All of the above.

2. Identify the term which denotes that only authorized users are capable of 
accessing a given information.

A. Confidentiality

B. Integrity

C. Availability

D. Authenticity

3. Which one is different from the others?

A. Fire

B. Identity theft

C. Computer crime 

D. Information theft 

4. The security of a system can be improved by _______________.

A. Audit log

B. Threat monitoring

C. Both A and B above

D. None of the above.
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5. Which one of the following replicates and spreads itself?

A. Encryption

B. Worm

C. VoIP

D. Spyware

6. Sahlu used his social skills in tricking Jundi into revealing access code. This 
would be called ______________.

A. Social engineering

B. Social media

C. Social viruses

D. Social processes

7. Which one can be a good password for you online account?

A. A text that combines your name and telephone number

B. A text that combines your date of birth with your father’s name.

C. A randomly generated long combination of capital and small letters and 
digits.

D. All of the above. 

8. Which one of the following can be a potential source of a cyber-attack?

A. Your father

B. Online criminal 

C. School boys and girls 

D. All of the above. 

9. Use the normal function of a given networked computer system to achieve 
some unrelated other purpose is ___________.

A. disclosure of information 

B. denial of service 

C. phishing 

D. illegal Usage
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10. Which one of the following is a good practice of computer security? 

A. Keeping critical personal information private

B. Playing games freely available on the Internet

C. Opening all email attachment instantly out of curiosity to see their 
contents

D. Sharing passwords for close friends and family members 

11. What is an Internet monitoring technique that captures keystrokes on their 
journey from the keyboard to the motherboard called?

A. Spyware

B. Web log

C. Adware

D. Key logger

12. Imagine that you purchase a book from an online company. Three months 
later, you might receive an email asking you to log in to the system to update 
your Telebirr information. Of course, this email is not actually from Ethio-
telecom, which runs Telebirr, and as soon as you log in, your information will 
be stolen. What type of information security breach would you consider this 
to be?

A. Insider attack

B. Phishing

C. DoDs

D. Eavesdropping

13. Malware stands for?

A. Multipurpose software

B. Malfunctioned software

C. Malicious software

D. Malfunctioning of security
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14. Which of the following usually observes each activity on the Internet of the 
victim, gather all information in the background and send it to someone else?

A. Malware

B. Spyware

C. Adware

D. All of the above.

15. When a person is harassed repeatedly by being followed, called or written is 
a target of ___________.

A. bullying

B. stalking

C. identity theft

D. phishing

16. Unsolicited commercial email is known as _______.

A. Spam

B. Malware

C. Virus

D. Spyware

17. Among the following, identify the element which is not considered in the 
triad, according to the CIA.

A. Confidentiality

B. Integrity

C. Availability

D. Authenticity

18. Why should you be careful about what you open and download on the 
Internet?

A. Because it could be something inappropriate. 

B. Because it could steal information from your computer.

C. Because it could have a virus that harms your computer.

D. All of the above.
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19. What should you do to create a positive digital footprint?

A. Create a username that does not reveal your identity.

B. Post photos and comments about every funny thing you do. 

C. Share your full name and private information like your birthdate.

D.  Lie in your profile to make yourself sound more impressive.

20. Hanna is playing an online role play game when another player starts 
following her around in the game and asking for her personal information. 
What should Hanna do?

A. Turn it into a game and run away from the other player for as long as 
possible.

B. Tell an adult about what is happening, then report and block the other 
player.

C. Message some of her friends and start spamming the other player with 
messages in return

D. None of the above.
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UNIT OVERVIEW

Have you ever encountered a problem? For sure you faced many challenges 
almost every day! All living organisms encounter numerous kinds of problems 
and attempt to solve them instinctively. We, humankinds, go many steps ahead 
and try to solve problems applying tools and methods. Do you remember the 
recent problem that you run into and how did you solve it? You might have 
done it by asking someone else or by applying a technique that you had known 
beforehand. You might also use tools such as a calculator for mathematical 
problems or machineries of some sorts.  This can be what a problem solving is. 

This unit focuses on enabling you develop problem solving skills with a focus on 
computational problems. You can consider a computational problem as a problem 
that is solvable applying computers. You will learn the common steps of problem 
solving and the top-down and bottom-up approaches of solving computational 
problems. This will enable you to develop your skills in computational thinking.  
Computational thinking involves skills in formulating and solving problems by 
breaking them down into simple steps as well as synthesizing simple steps into 
bigger solutions. You will also be familiar with representation of a solution or 
steps in solving a given problem using graphic tool called flowchart, and visualize 
how a computer follows them to perform the task associated.  

At the end of this unit, learners will be able to:

 � Describe problem solving techniques.

 � Compare and contrast steps of problem solving techniques.

 � Use top-down and bottom-up problem solving techniques.

 � Evaluate simple algorithms represented in flowcharts and pseudocodes.  

UNIT 

FUNDAMENTALS OF PROGRAMMING

UNIT OUTCOMES

6 
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 Brainstorming 

1. What types of problems have you solved using computer software 
(applications) you learned in the previous units? 

2. Which types of card games are you familiar with? What are the steps and 
the rules of the games that you played?  What would happen if you miss 
one of the steps or interchange two of the steps in finding solution for a 
mathematical problem, e.g. polynomial equations?

6.1 Defining a Problem and Computational Problem  

You have used application software in units 3 and 4 to handle tasks that we usually 
do in our everyday business and personal activities. Imagine how challenging 
those activities would be in the absence of these software! We call challenges that 
we encounter in our day-to-day life a problem.  In non-technical terms, a problem 
is a difficulty to understand something, or a matter that is difficult to solve/settle, 
a doubtful case or a complex task involving doubt and uncertainty.  

Activity 6.1

Form a small group of three to five students and discuss on one of the following 
questions. 

1.  Is climate change causing a problem to your town or village? If yes, how does 
it affect your community? What should be done to address the challenges 
and minimize adverse impacts?

2. Do you know that traffic accident is a major challenge in Ethiopia? What 
are the common problems in your community with regard to safe road use? 
Discuss the steps you need to take to cross a street in urban centers.  

3.  What are the positive and negative impacts of social media on students? 
Discuss on what actions you can take to strengthen the positive impacts 
and controlling the negative impacts.  
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Do you consider that the questions in Activity 6.1 are easily solvable by 
using computers or other kinds of electronic device? Of course, they cannot be 
easily and directly resolved using a computer system. The issues raised need the 
engagement of individual persons in the community and the leadership roles of 
local government bodies, religious and community leaders. 

There are other classes of problems that are called computational problems. 
What is a computational problem?  A computational problem is a problem that 
can be solved systematically (step-by-step) with a computer. These problems 
usually have a well-defined inputs, constraints and conditions that the output 
must satisfy. You will learn about these requirements for a computational problem 
later in sections 6.2 and 6.3. Here are some types of computational problems:

 � A decision problem is one where the answer is Yes or No. For instance, 
“given an Integer n, is n even?” is a decision problem. 

 � A search problem is the one where the solution consists of one or more 
values that satisfy a given condition. For instance, we may want to 
compute a path from one geographical location to another on a map. 
Another instance, we may want to get a name from a list of names in a 
spreadsheet column.

 � A counting problem is the one where the answer is a number of solutions to 
a search problem. For instance, counting the number of female students 
from Grade 9 students’ list. 

 � An optimization problem is the one where the solution is the “best” possible 
solution, where the “best” can be defined in a different way. For instance, 
we may want to compute the fastest route from one location to another. 
Note that you learned about router in unit 2, which is an intermediary 
device to find the best route to send message or packet.  This device, 
thus, handles optimization problem in network traffic management.  

 A computational problem is the problem that can be solved step-by-
step with a computer. This problem usually has a well-defined inputs, 
constraints and conditions that the output must satisfy. 
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6.2 Steps in Problem Solving 
 

 Brainstorming 
Have you ever heard about the 21st century skills? Is problem solving one of 
the skills required in the 21st century?  

Life in the 21st century demands you to be a good problem solver, which requires 
related skills in critical thinking, communication, collaboration, creativity and 
innovation. A closely related concept is a computational thinking. Computational 
thinking is the thought process that involves formulating a problem and 
expressing its solution(s) in such a way that a computer, human or a machine 
can effectively carry out. You will develop your computational thinking skills 
through practicing problem solving strategies.

Practical Exercise 6.1

Form a group of two to three students and work on the following activities.

1. Search the Internet for “21st century skills” and discuss the skills related 
to problem solving in your group using the description in the paragraph 
above as a guide.

2.  Search the Internet for George Polya’s Problem Solving Method published 
in his book, “How to Solve It” and discuss the four basic principles of 
problem solving.

 
George Polya, a mathematician, designed a four-step method to solve all kinds 

of problems. Because the method is simple and generalizes well, it has become 
a classic method for solving computational problems. The four steps of problem 
solving that Polya suggested are: 

1. Understand the problem.

2. Make a plan.

3. Execute the plan. 

4. Review and extend. 

Although the method appears to be a straightforward method where you start 
at step 1, go through steps 2, 3 and 4; the reality is that you will often need to go 
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back and forth through the four steps until you have solved and reflected on a 
problem. The four steps are elaborated in Table 6.1 below. 

Table 6.1 Polya’s four steps of problem solving methods

Step Number Description of Step

1. Understand 
the problem.

Figure out what is being asked. What is known? What is not 
known? What type of answer is required? Is the problem 
similar to other problems you have seen? Are there any 
important terms for which you should look up definitions?

2. Make a plan. Come up with some strategies for solving the problem. 
Common strategies include making a list, drawing a picture, 
eliminating possibilities, using a formula, guessing and 
checking, and solving a simpler, related problem.

3. Execute the 
plan.

Use the strategy chosen in step 2 to solve the problem. If 
you encounter difficulties using the strategy, you may want 
to use resources such as the textbook to help. If the strategy 
itself appears not to be working, return to 2tep 2 and select a 
different strategy.

4. Review and 
Extend.

Part of step 4 is to find a way to check your answer, preferably 
using a different method than what you used to solve the 
problem. Another part of step 4 is to evaluate the method you 
used to solve the problem. Was it effective? Are there ways 
you could have made it more effective? Are there other types 
of problems with which you might be able to use this type of 
solution method?

Polya’s four stage of problem solving is adjusted into the following in computer 
science and information technology: 

1. Understand the problem.

2. Develop an algorithm.

3. Write the program.

4. Test the program.

As you can see, steps 2 to 4 are replaced with the concepts that are used in 
information technology. The “make a plan” in step 2 is represented as develop an 
algorithm. An algorithm is the plan for a solution for a computational problem. 
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Technically, an algorithm is a sequence of clearly defined steps that describe 
a process to follow a finite set of unambiguous instructions with a clear start 
and end points. In short, an algorithm is a precise sequence of instructions for 
solving a problem. Algorithms are a way of specifying a multistep task, and are 
especially useful when we wish to explain to another person or machine how to 
carry out steps. For example, what steps do you follow to calculate the average of 
10 numbers? The following sequence of activities should be performed to get the 
average in the order they are presented. 

Step 1. If you do not know the numbers, get the 10 numbers.
Step 2. Get SUM by adding the 10 numbers. 
Step 3. Get AVERAGE by dividing SUM by 10.
Step 4. Tell or report AVERAGE as a result.  

Algorithm:  is a precise sequence of instructions for solving a problem 
represented in human-understandable format.  

An algorithm written needs to be transformed into a computer program to 
be executed by a computer or any other digital devices. This transformation is 
required because computers do not understand instructions written in English, 
Amharic, Afan Oromo or other languages that we humans speak. Instead, 
computers have their own special language known as a programming language. 
A computer program or program in short is a sequence of instructions written 
using a programming language. The program is executed by a computer to solve 
problem or perform a specified task. 

A program: is a sequence of instructions written using programming 
language and can be executed by a computer to solve a given problem 
or perform a specified task.

You will learn about steps 3 and 4 of problem solving in grade 10 through grade 
12. The next section (section 6.3) will focus on development and representation 
of algorithms and their steps of execution. Since algorithms for computational 
problems are developed for execution by computer systems, it is important to 
understand information-processing model by computers. A typical and simplified 
single-CPU information-processing model is shown in Figure 6.1 below. 
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Figure 6.1 A simplified single CPU information processing model

Problems are solved using a computer by obtaining some kind of user input 
(e.g. keyboard/mouse information or game control movements), then processing 
the input and producing some kind of output (e.g. images, text and sound). 
Sometimes the incoming and outgoing data may be in the form of secondary 
memories or network devices. With regard to problem solving, we will apply 
the above model in that we will assume that we are given some kind of input 
information that we need to work with in order to produce some desired output 
solution.

In the example about finding the average of 10 numbers above, step 1 (get the 
10 numbers) is an input, which you might get it from a keyboard entry. Steps 2 
and 3 that calculate the sum and average of the ten numbers is a process. Reporting 
the result is an output, which can be a display on the screen. 
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6.3 Working with Pseudocode, Flowcharts and Block Programming

 
 Brainstorming 
You learned about different symbols (or notations) that you use to represent 
different networking devices in unit 2.  What would happen if different 
symbols are used to represent a particular device type? 

Flowcharts and pseudocodes are two such standard mechanisms used for 
development of algorithms. Flowcharts use special shapes to represent different 
types of actions or steps in a process. Lines and arrows show the sequence of the 
steps, and the relationships among them. A pseudocode is a simple and concise 
sequence of English-like instructions to solve a problem. 

Flowchart: represents an algorithm graphically using boxes of various 
kinds, ellipses and arrows as connectors. 

Pseudocode: represents algorithm with a simple and concise sequence 
of English-like instructions.

Whereas flowcharts are visually appealing and can be easier to understand, 
pseudocodes are closer to instructions used in a program. With usage of 
standardized symbols and pseudocode structures, it is also possible to convert 
algorithm represented in flowchart into pseudocode and vice versa. You can also 
draw your own flowchart on paper using the standardized graphical symbols 
shown in Table 6.2. Table 6.2 does not include all flowchart symbols available. It 
includes only those which are most frequently used to draw simple flowcharts. 
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Table 6.2 Basic flowcharting shapes and symbols

Symbol Representation
Start/End 
The terminator symbol marks the starting or ending point of the 
system. It usually contains the word Start or End. 
Action or Process 
A box can represent a single step (add two cups of flour), or an 
entire sub-process (make bread) within a larger process. 
Decision 
A decision or branching point. Lines representing different 
decisions emerge from different points of the diamond. 
Input/Output 
Represents material or information entering or leaving the 
system such as customer order (input) or a product (output). 
Connector 
Indicates that the flow continues where a matching symbol    
(containing the same letter) has been placed. 
Flow Line 
Lines indicate the sequence of steps and the direction of flow. 
Subroutine (or module) 
Indicates a sequence of actions that perform a specific task 
embedded within a larger process. This sequence of actions could 
be described on a separate flowchart in more detail. 

Terminal or start/end is always used at the beginning and end of an algorithm.   
A parallelogram (or input/output) indicates that information is required at this 
point in the flow. The information can be accepted into (i.e. input) or released 
from (i.e. output) the computer system. Information processing such as arithmetic 
operations like adding two numbers or getting average of the two numbers added 
is represented with a rectangle (process). Process designates specific action or 
work within the flow. Decision (or diamond shape) indicates a choice that must 
be made or a question that needs to be answered. The result determines the next 
step in the flow. Flow lines (arrows) show the direction and order of the flow. 
Small circle (connector) is used to connect a flowchart placed in a different place 
or page. Larger flowcharts usually have subroutines to handle a specific task. It is 
also called predefined process and shows that additional information for predefined 
processes is provided elsewhere. 
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6.3.1 Developing Flowcharts 

Flowcharts can be used to represent both computational and non-computational 
activities. Let us start with non-computational activities (i.e. a process to be 
handled by a human or a manual machine). For example, one of the peace 
building activities in school is maintaining a peaceful school environment. This 
can be done through reducing students’ absenteeism and late coming,   avoiding 
sexual abuse and harassment inside and outside of school compound, and 
strengthening collaborative atmosphere in student-to-student and teacher-to-
students engagement.  

Assume that your Woreda Education Department has the following 
Environmental Protection Policy on school gardens. In school where there is a 
school garden, students and teachers cultivate the garden as part of their Nature 
study work.  However, a new school garden is prepared with the participation 
of parents.  The following flowchart in Figure 6.2 is the algorithm for this policy. 
Figure 6.2 presents a flowchart for this school policy. The diagram uses two 
terminals for the start and end. A decision (diamond symbol) for the rule which 
have a “Yes” and a “No” arrows show the flow direction based on the condition 
in the diamond.

Practical Exercise 6.2

Draw flowcharts for the following two diagrams.

1. Write an algorithm that accepts a driving speed in kilometer and displays 
“reasonable speed” if the speed is not exceeding 40 km per hour. The 
display is “Excessive speed, you are at high risk for traffic accident” if it 
exceeds 60 km per hour. If the speed is between 40 and 60 km per hour, 
display “You are in medium speed limit. Be careful!”.

2.  Draw a flowchart for an algorithm that accepts two numbers and displays 
the sum and product of the two numbers. 
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START

HAS THE  SCHOOL  A 
BOTANICAL GARDEN?

MAINTAIN GARDEN 
BY STUDENT AND 

TEACHERS

BUILD GARDEN 
WITH PARENT 

PARTICIPATION

END

YES NO

Figure 6.2 Flowchart of environmental protection policy in a school garden

6.3.2 Working with Decisions and Repetitions 

In this section, you will develop a simple flowchart for certain activities that will 
be done repetitively or selectively. In general, there are three types of flow of in-
struction processing in a computer system. 

 
 Brainstorming 

1. Are there some activities that you do repetitively before completing 
the work? For example, how do you add a long list of numbers, say for 
exampling adding 100 different numbers?

2. Are there some other activities that you can perform only when a certain 
condition(s) is met? For example, when do you open your umbrella – is it 
when you are inside a house or when you are outside? Or, can you become 
grade 10 student if your average mark of grade 9 is a failure (<50%)? 



Grade 9 Information Technology Student’s Textbook 

   227

These are:

 � Sequence: execute instruction top down in the order they are placed in 
the algorithm. 

 � Selection or condition: execute or jump instruction(s) depending on the 
outcome of the decision. 

 � Repetition: repeatedly execute instruction(s) for a fixed number of times 
or until some condition occurs.

Flowchart and block programming tool 

There are recent development in learning to programing graphically to make pro-
gramming accessible and faster to do. These two trends are: 

1. Flowchart-based programming environment:  using software tool to develop 
algorithm automatically as flowchart. These tools can help learners to learn 
the step of execution visually. Additional capacity is auto-creation of program 
codes from the flowchart. The following are freely available software in this 
category include

a. Flowgorithm (http://www.flowgorithm.org)

b.  Raptor (https:// raptor.martincarlisle.com/)

c.  SFC - A Structured Flow Chart Editor (http://watts.cs.sonoma.edu/SFC/)

2. Block-based Programming Environment: The block-based approach of 
visual programming allows learners to reuse pre-developed graphic object 
for development of a program through a drag and drop manipulations. The 
following are two popular free block-based programming environments:

a. Scratch (https://scratch.mit.edu/)

b.  Blockly  (https://developers.google.com/blockly) 
We use Flowgorithm for flowchart-based programming and Scratch for block-

based programming. Flogorithm is a free beginner’s programming language that 
is based on simple graphical flowcharts. Figure 6.3 shows the flowchart symbols. 
Flowgorithm combines classic flowchart symbols you have known from Section 
6.3.1 above and a few more to represent common repetition flows of in- struction. 
You can also run your programs directly in Flowgorithm. You can learn more 
about how to learn programming with Flowgorithm from YouTube videos and 
notes available at https://en.wikiversity.org/wiki/Flowgorithm and www.flow-
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gorithm.org/resources/index.html. You can learn programming through creating 
stories, games and animations in Scratch. 

Figure 6.3 Flowgorithm flowchart symbols

You can draw flowcharts in Flowgorithm. Figure 6.4 shows how you can do 
this. You see a window as shown in Figure 6.4 (A) when you open Flowgorithm. 
You get a start (or main) and end symbols created automatically with an arrow 
connection. Figure 6.4 (B) is a pop-up window that you get when you right-click 
the arrow connector. To draw a flowchart with a “Welcome!” message output, 
you select the Output symbol from the pop-up window with which the symbol is 
added into your flowchart between the start and end. Double click on the output 
symbol on your flowchart and add the text “Welcome!” in the textbox with 
instruction Enter an Expression Below. Figure 6.5 shows the flowchart produced. 
To see the output, simply click the RUN icon on the toolbar (See Figure 6.4 (A)). 
a)        b)

Figure 6.4 Flowgorithm environment (A) and symbol window (B)
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Figure 6.5  Displaying “Welcome”

Practical Exercise 6.3

Draw flowcharts for the following two diagrams.

1. Draw a flowgorithm flowchart with your name and the name of your school 
in a single line. Hint: Put your name in a double quotation, like “Challa” 
and your school’s name again inside double quotation and connect them 
together with the & operator, which is a string connector in flowgorithm.  
Run the flowchart. Are your name and the name of your school combined 
together without space? Put a space at the beginning of your school’s name 
after opening the quotation and run it. How is it displayed now? 

2.  Draw a flowchart for an algorithm that displays the name of three 
neighbouring countries to Ethiopia in three different lines. Hint: Use three 
output symbols. Note that, instruction presented with one flowchart symbol 
can be referred to as a statement. 

3. Draw a flowchart that adds two numbers, num1 and num2, accepted from a 
keyboard. Note, now you need to use a variable declaration symbol and the 
input symbols. Declaration is used to name a variable where a data accepted 
from a keyboard is going to be placed. Declaration always comes before 
input. You can also declare more than one variable with one declaration 
symbol by separating them with comma (,).  Hint: You will have important 
lesson from this activity. One of them is about computer-human interaction. 
To accept some data from a keyboard, an alerting message must be given 
with output symbol.   
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For example, you have to display, “Please enter two numbers” as a prompt 
for the person to enter them. Then you can accept the numbers the person 
is supposed to enter with two input symbols declared as num1 and num2.  
After drawing the complete flowchart, do the following to learn more 
about how the computer executes long flowcharts. (1) Click the Layout 
Windows… from the toolbar and select Variables & Consoles from the pop-
up windows.  Now, you see two more flowgorithm windows.  Now, use the 
Step icon from the toolbar to see how the flowchart performs at each level. 
Observe the changes in the variable and consoles (or output) windows and 
responding to prompts given to you.    

4. See the pseudocode equivalent of your flowchart. To see the pseudocode 
version of your flowchart in question number 5, select Source code viewer 
from Tools menu. Make sure that auto Pseudocode is selected for the source 
code. If it is not selected, select it by choosing it from the Language combo 
box in the toolbar of the code viewer. 

5. Draw two flowcharts that calculate (1) area of a circle (2) area of a triangle. 
Note that 62 is written as 6^2 in flowgorithm. Thus, area of a circle with a 
radius of 6 cm can be calculated in llowgorithm as 3.142 * 6 ^2. 

6. Simple wage calculation. Draw a flowchart that accepts hours worked 
and hourly rate and displays net pays.  If total pay exceeds 5,000, tax is 
calculated for 50% of the total pay. The tax rate is 5%. Net pay is calculated 
by deducting tax from the total pay. Hint: Use decision or IF symbol. 

 Working with Scratch

Scratch is a high-level block-based visual programming language designed as 
an educational tool for programming. Scratch helps you to code simple stories, 
animations and games. It is freely downloadable from https://scratch.mit.
edu/. In this unit, you will use it to build your skills in the use of selection and 
repetitions with visual coding. Note that it is not a flowcharting tool, instead it is 
a programming language specifically designed for children. 

Figure 6.6 shows the Scratch’s first window. At the top right, you get a stage 
with a sprite, a cat by default. The sprites are the actors or main characters of the 
project. Sprites are programmed to do something in scratch. The window has four 
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main elements. The stage and the sprite are the first two. The other two are the 
programming pallet and the script. The scrip tells the actors what to say or do. In 
version 3 of scratch, the programming pallet is at the left side of the windows and 
labeled as code. A script is developed by taking graphic objects from the pallet. 
The pallet has categories named as Motion, Looks, Sounds, Events, Control, Sensing, 
Operators, and variables. The script is the area for your block programming of the 
sprite. 

Figure 6.6 Scratch visual programming tool

For example, do the following to move the sprite 10 steps each time Go flag 
(Green) at the top of the window get clicked.  

1. From Events, drag the Move  Clicked block to the script area.

2. Drag Move  Steps from Move and attach it with the Move  Clicked 
block in the script area.

The script that you developed looks like the following (Figure 6.7). 
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Figure 6.7 A scratch script that moves a sprite 10 steps

After this, click the  on the window or the script, what happens? The cat 
sprite moves 10 steps to the right. That is, with a clip event of the flag, the sprite 
goes 10 steps horizontally. Try it with several clicks. Now, lets the sprite say hello 
in addition to a 10 steps move. How can you do that? Look the right block from 
the Looks palette and drag it to the script.  

 

Practical Exercise 6.4
Draw Scratch script for the following questions.

1. Modify your script by changing the Motion, Looks, or adding Sound that 
you choose. Each time you add any action/look to the Script, (1) discuss 
with your friends on what you have added and what changes the new 
script element brought to the sprite.  

2.  Change the Move 10 Steps in the script into Move 100 steps. What happens 
after 5 or 6 clicks? Is the sprint inside the stage? Actually, if the sprite goes 
outside of the stage, it stops near the edge. In this case, it most likely stops 
in the right edge of the x-axis. 

3.  Use the if block from the control category with the Touching ‘mouse pointing’ 
from the Sensing control. Use the following to control the movement of 
the sprite within the stage. See the if …. else block. By running the script 
several times. At what point does the sprite go back to the left? The if script 
reads: if the script touches the rightmost edge, the x position is adjusted to 
-100 positions. Otherwise, the sprite moves 10 steps to the right. Note that 
the stage has a coordinate system with X in the range of -240 and 240 and Y 
in the range of -180 and 180.  
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4. Is there any difference between the scripts in question 3 with the one shown 
below? Which one is better?

5. Write a script to move 10 steps to the left, right, up or down depending on 
which arrow key on the keyboard is pressed. Hint: Use the key ….. pressed 
from the Sensing pallets. Also, think how to use the When  Clicked 
together with the forever loop, change x by …, and change y by …. Pallets.  

6. Use the repeat N loop, example repeat 10 to force the cat sprite to repeat 
meows 10 times. Hint:  Select the appropriate block from Sound and Use 
wait … seconds to listen to each meow with clarity.   

7. Use the repeat until to repeat the meow sounds until a condition is met. 
Example, if a counter variable is set to 0 at the beginning, this is to repeat 
the meow until counter reaches 12 by adding 1 to the counter after each 
meow. Hint: Add a variable count, set count to 0 before the repeat until 
… block, add operator as a condition for repeat until block and increment 
count by 1 inside the repeat until… block. 

8. Discuss in group how the if …, if… else, forever, repeat …., repeat until…. 
Control pallets work.
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You have done a good job with scratch! It is time now to draw flowcharts for 
selection and looping controls. For example, how do you determine whether a 
given number is even or odd? You divide the number by two and if the remained is 
not 0, then you say the number is odd. Which flowchart symbol is more appropriate 
– decision (or if) or looping such as while? The answer is the if structure. See the 
flowgorithm flowchart shown in Figure 6.8 (A). As you can see in the flowchart, 
a variable number is declared and an integer is accepted into it with an input 
symbol. There is a prompt “Enter an integer: “ as output before the input to alert 
the person to key in the number. The next symbol is the diamond/decision with a 
condition number % 2 = 0. Flowgorithm uses % as a special operator called modulo-
divide, which gives the remainder of an integer division. For example, 14%3 is 2, 
which is the remainder. This operator (%) is the same as mode in Excel. Check 
=Mode(14, 3) in an Excel cell. Then the condition checks whether the remainder is 
equal to 0 or not. The flow to output ” number is even”  goes only if the remainder 
equals to 0; otherwise, the flow moves towards the “number is odd” direction. 

Figure 6.8 (B) represents a flowgorithm flowchart that displays all positive 
integers less than 10. The numbers are 2, 4, 6 and 8. To display these step-by-step, 
the flowchart begins with declaring num as a variable to help the computer to 
store different even integers. Then 2 is assigned to num. Assign means making a 
variable to hold a value, which is 2 at the beginning. There is a while loop next to 
the output. The while loop checks whether num is less than 10, and if this is true, 
it goes inside the loop. The loop outputs or prints the num value and adds 2 to 
the existing value of num. It goes back to the condition checking and the cycle 
continues until the condition  num < 10 becomes FALSE, in which cases the flow 
goes out of the while loop to finish the task. 
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Figure 6.8 If and while loop control flowcharts

Practical Exercise 6.5

Draw flowcharts for the following.

1.  Draw a flowgorithm flowchart that calculates wages of 10 labourers by 
improving the flowchart that you developed for question number 6 of 
Practical Exercise 6.2. 

2.  Draw a flowgorithm flowchart that adds all the positive multiples of 3 less 
than 100. 

3.  Draw a flowgorithm flowchart that counts the number of failed and passed 
marks out of 100 for 60 students in the classroom.  Mark less than 50% is a 
failure. 
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6.4 Problem Solving Approaches 

 
 Brainstorming 
What problem-solving strategies have you used in solving mathematical 
problems? 

You developed some basic algorithms in section 6.3 above. It is important that we 
develop and test algorithm before developing program for a given problem. With 
an increasing complexity of a problem to solve, there is a need to be systematic 
and apply appropriate problem solving strategy. Top-down and bottom-up 
programming refer to two different strategies for developing a computer program 
for complex problems.  

6.4.1 Top-Down Approaches 

Top-down approach starts by implementing the most general modules and works 
toward implementing those that provide specific functionality. The idea behind 
top-down approach is that a bigger problem is difficult to manage in its entirety. 
Thus, the problem is decomposed or divided into smaller and manageable sub-
problems. These sub-problems are then solved individually and then, later, 
integrated together to get the complete solution for the bigger problem. The 
solution developed for a smaller problem is called a module. This process of 
dividing the problem into smaller problem is known as modularization. 

Refer back to question 1 of Practical Exercise 6.4 above. You were asked to 
draw a flowchart to calculate wages of 10 laborers by improving the flowchart 
that calculates net-pay for a single laborer for Practical Exercise 6.2.  In question 
1 of Practical Exercise 6.4, you were expected to integrate a repetition (loop) to 
calculate 10 wages by repeating a set of instructions to complete a single wage 
for 10 times. This can be divided into two modules. The first module calculates a 
wage for one laborer. The second module uses the service of the first module to 
compute 10 wages. See the flowchart symbol for subroutine in section 6.3 above 
and the CALL symbol of flowgorithm. 

Figure 6.9 shows the flowchart for wage calculation of 10 laborers. As you 
can see in Figure 6.9, there are two modules. The first is CalculateWage, which 
calculate net pays with specification given in question 6 of Practical Exercise 6.2. 
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The second is the main module, which calls the calculateWage subroutine inside 
a loop structure to calculate wages repeatedly. Likewise, a program for a large 
problem can be developed by dividing the problem into smaller problems and 
building modules for the smaller problems. 

Figure 6.9 A flowchart developed with top-down approach

Practical Exercise 6.6

Draw flowcharts for the following.

1.  Draw a flowgorithm flowchart that calculates area and circumference of a 
circle applying a top-down approach. 

2.  Draw a flowgorithm flowchart that (1) calculates the hypotenuse of a right-
angle triangle using Pythagorean Theorem, and, (2) computes the perimeter 
of the triangle. 
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6.4.2 Bottom-up Problem-Solving Approach

 
 Brainstorming 
Let us consider a scenario in which you have many modules that are already 
developed. What will you do if you are given a duty to write a program to 
which the existing modules are relevant? 

This method of solving a problem works exactly opposite of how the top-down 
approach works. Top-down programming starts by implementing the most 
general modules and works toward implementing those that provide specific 
functionality. In bottom-up approach, the most fundamental units, modules and 
sub-modules are designed and solved individually; these units are then integrated 
together to get a more concrete base to problem solving.

For example, how can you do if you want to write a program to calculate 
area and perimeter of different polygons (circle, triangle, rectangle, cube, 
parallelogram, etc.) applying bottom-up approach. If you have already modules 
with required functionalities (that is area and perimeter calculation) for each types 
of polygon, you can bring together those individual components and integrate 
them. Otherwise, you develop each module first and then incrementally build 
them up (or synthesize) as a bigger program.      

Overall, most programs are developed using a combination of top-down and 
bottom-up strategies. Both strategies are based on incremental development – the 
process of building your program piece by piece. Both strategies employ unit 
testing – testing each individual piece before moving on to the next.

KEY CONCEPTS

 6  To develop algorithm, we may use bottom-up approach or top-down 
approach.

 7 Top-down approach divides the large problem into small chunks called 
modules and concurs each module individually whereas bottom-up 
approache starts from individual chunk or module to build up the entire 
problem solution.  
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Practical Exercise 6.7

Design Scratch Games. There are many online games that you can play online. 
You can also design your own games with scratch. Do you know kids’ video 
games such as catch game, Pong, Flappy Bird, PacMan and Mario Bros.  You 
can also develop your own!

1. What is needed? Games have actors – sprites for example apple and a bowl 
for Catch game. You also need a script, which are actions that a sprite takes 
during the play. For example, the bowl makes horizontal move to collect 
the falling apples. You also need stages that change as needed in the game. 
Read about one of the games and develop a scratch script for the game. 
Note that you need to apply a careful planning and implementation and 
teamwork activities. 

2. Telling story in scratch. Ethiopia is a historical country with rich cultural 
diversity and many attractions. What touristic attractions and cultural 
stories your community has to tell to the world? We have also many issues 
to tell to your young brothers and sisters, and kids to correct bad habits 
and unhealthy practices in the country. For example, drug addiction, 
improper walkway usage in cities and towns, abuses towards child and 
female students are all common problems in Ethiopia. Scratch helps you 
build stories and put them online to share your stories for kids or global 
audiences. Oh, what a golden opportunity! Watch online videos on how 
to make a story in scratch and build your own story. What you need is 
determining you characters, scenes and writing dialogues.  Using the wait 
and broadcast makes your story interactive. Remember, this also needs a 
problem solving strategy that involves proper planning, task division and 

6.5 Unit Summary 

 � Computers and computer applications are meant for solving human 
problems. Most of our problems are solved using software. 

 � Software is created through a software development process. The term 
software and computer program, or simply program, can be used 
interchangeably.  
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 � A program is a sequence of instructions that can be executed by a 
computer to solve some problem or perform a specified task.

 � A program development passes through a stage or steps to decrease the 
complexity of the problem.

 � The first step in developing a program is to try to understand the problem 
at hand that needs to be solved using a computer program. 

 � After clearly identifying the problem, the second step is to develop 
an algorithm that can be done using flowchart. Another option is a 
pseudocode.

 � An algorithm is a prescribed set of well-defined rules or instructions 
for the solution of a problem. Algorithms need to be checked for their 
accuracy. Checking algorithms with paper and pencil is called desk 
checking. 

 � Pseudocode resembles instructions written using a programming 
language. We use flowchart for shorter algorithms. 

 � Problem developers use top-down and bottom-up problem-solving 
approaches. In top-down, bigger problems and solutions are 
continually broken down into sub-problems and sub-specifications to 
get a program’s solution by integrating solutions from smaller chunk of 
problem. Bottom-up starts with solutions from smaller one and builds 
larger system through integration of pre-developed solutions. 

6.6 Unit Review Exercise

Part I: Write whether the following statements are true or false.

1. Program or software is used to solve a problem.     .

2. Modularization is a process of decomposing a bigger problem and solving 
smaller ones.

3. Decision/If is used to control repetitions.

4. A computational problem covers all kinds of problems that human beings 
may encounter.

5. A computer can solve a problem on its own.
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Part II: Choose the correct answer among the alternatives provided.

1. A set of instructions that is developed to solve a given problem using a 
computer is ___________.     

A. hard disk

B. software

C. program

D. B and C are answers.

E. All of the above 

2. An Algorithm can be represented using _______and ___________.

A. software and programs

B. pseudocodes and flowcharts

C. A and B are answers. 

D. None of the above .

3. Understanding a problem may include ___________. 

A. identifying what is not known

B. identifying alternative solutions

C. writing and testing a program

D. All of the above.      

4. Which of the following can be a part of flowcharts?

A. Input/output

B. Decision

C. Loops

D. All of the above.

5. ______________ is a type of diagram that represents algorithm graphically 
using boxes of various kinds, in an order connected by arrows.

A. Pseudocode 

B. Algorithm 

C. Flowchart 

D. Top-down and bottom-up approaches 
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6. Which one is different from others?

A. if … else

B. forever

C. repeat 

D. repeat until

7. ___________ is an approach used to build a program by integrating small 
modules and building them up into a bigger solution.

A. Bottom-up

B. Decomposition

C. Top-down

D. All of the above.

Part III: Provide clear and precise responses to the following questions. 

1. Why is bottom-up better than top-down?

2. What do we mean by top-down problem-solving approaches?

3. What is the advantage of a top-down approach?

4. Write the difference between flowchart and pseudocode. Discuss also how 
flowgorithm can help you in learning the two? 

5. What is a computational thinking? 

Annex A: Acronyms 

ATM Automated Teller Machine

CBE Commercial Bank of Ethiopia

CIA confidentiality, integrity and availability

CPU Central Processing Units

DVD Digital Video Disc or Digital Versatile Disc

HTTP Hypertext Transfer Protocol 

ICT Information Communication Technology

INSA Information Network Security Agency 
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LAN Local Area Network

MAN Metropolitan Area Network

NAS Network-attached storage

NIC Network Interface Card

PAN Personal Area Network

PPI Pixel Per Inch

SQL Structured Query Language

USB Universal Serial Bus

UTP Unshielded Twisted Pair

WAN Wide Area Network 






